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Form No. 008-42104-00

WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive     z    Norcross, GA 30093-1877   z Fax (770) 662-3696

Domestic Sales - (770) 662-3633                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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ASAP 2050 Operator’s Manual Organization of the Manual
1.  GENERAL INFORMATION

This manual describes how to install and operate the ASAP 2050 Xtended Pressure 
Adsorption Analyzer. 

Organization of the Manual

The manual is divided into the following chapters:

Chapter 1 GENERAL INFORMATION
Provides a general description of the ASAP 2050 system as well as its 
specifications.

Chapter  2 USER INTERFACE
Provides basic instrument and software interface.

Chapter 3 OPERATIONAL PROCEDURES
Provides step-by-step instructions for operating the ASAP 2050.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS
Provides instructions for using the 2050 Setup program.

Chapter 5 FILE MENU
Provides a description of the commands on the File menu.

Chapter 6 UNIT MENU
Provides a description of the commands on the Unit menu.

Chapter 7 REPORTS MENU
Provides a description of the commands on the Reports menu and 
samples of reports.

Chapter 8 OPTIONS MENU
Provides a description of the commands on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE
Provides instructions for troubleshooting hardware problems and for 
performing routine maintenance procedures.
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Chapter 10 ORDERING INFORMATION
Provides part numbers and descriptions of the ASAP 2050 System 
components and accessories.

Appendix A A. ASAP SERIES SAMPLE DATA WORKSHEET
Contains a form to assist you in determining the sample mass.

Appendix B ERROR MESSAGES
Lists the error messages that may be displayed in the analysis 
program; includes a cause and action for each.

Appendix C C. CALCULATIONS
Contains the calculations used by the system to produce reports.

Appendix D TESTING FOR LEAKS
Describes the procedure for testing each valve for leaks.

Appendix E CALCULATING FREE-SPACE VALUES
Provides instructions for obtaining free-space values to use in 
analyses.

Appendix F DFT MODELS
Provides information on DFT models.

Index INDEX
Provides quick access to a subject matter.
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Conventions

This manual uses the symbols shown below to identify notes of importance, cautions, and 
warnings.

Notes contain a tip or important information pertinent to the subject matter.

Cautions contain information to help you prevent actions which could damage the 
instrument.

Warnings contain information to help you prevent actions which could cause personal 
injury.
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Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual 
by selecting Help, then Operator’s Manual from the analysis program main menu. The 
manual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual. 
Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for 
more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

You can use the  +  and  −  buttons next to topics as they are used in Windows Explorer to 
expand or collapse the topic list.

Navigation Pane Topic Pane

Bookmarks

Topics
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To display a topic, click the topic name in the Bookmarks section. The related information 
appears in the topic pane of the window as shown in the following example.

 

 

Click bookmark
to display topic.
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Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are 
contained in:

• the table of contents
• index entries
• cross-references within the manual 

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the 
table of contents is displayed, you can click an entry to display its associated page. For 
example, clicking Using the Software in the table of contents, displays the page containing 
information about the software.

 

Click topic name in 
table of contents to 
display topic.
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Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the 
last topic in Bookmarks), then click the + button to expand the index. The letters A through Z 
are displayed. Click a letter to display its corresponding index entries as shown in the 
following example.

After you display the entries, locate the item of interest and click on the page reference to 
access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-
reference, FILE MENU (shown on the screen in blue type) will display the first page of the 
chapter describing the commands found on the File menu.

FILE MENU

Provides a description of the commands available on the File menu.

Click a letter to display 
its index entries.
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Using the Find Command

The Adobe Acrobat Find command provides another method of easily accessing specific 
information. For example, suppose you want to know how the Save as command works. You 
could select Edit > Find from the Adobe Acrobat menu, then enter Save as in the Find dialog. 
The following example shows the results.
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Printing

You can print the entire manual, a selected page, or range of pages. There are several options 
for printing. You can:

• Select the printer icon ( ) on the Adobe Acrobat toolbar.

A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using 
this option (or the next one), be sure to enter the page number(s) displayed in Adobe 
Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

• Select File > Print. 

A standard Print dialog is displayed. Select the page(s) to print, then click OK.

• Click the Thumbnails tab.

Thumbnails of manual pages are displayed.

a. Click the pages you want to print.

b. Right-click to display a shortcut menu, then select Print Pages.

c. A standard Print dialog is displayed; click OK.

Enter 
this 
number.

Do not use 
number in 
footer of the 
manual.

Thumbnails 
tab
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Internet Access

Visit www.micromeritics.com to learn more about Micromeritics, our products, and applica-
tions. Our site is user-friendly, easy to navigate, and informative. Its content is summarized 
below.

Be sure to browse our site to see the many ways in which we can assist you.

About Micromeritics A brief history of Micromeritics, office locations, awards/cer-
tifications, career opportunities, and a virtual tour of its 
headquarters

Products Product information and printable brochures

Applications Application Notes, Product Bulletins, Tech Tips, Technical 
Articles/papers, and important application links

Online Catalog  Catalog of instruments and accessories, allowing you to place 
your order online

News and Press Press releases, Events calendar, microReports, and latest 
Micromeritics news updates

Lab Service Provides laboratory tips and access to the Micromeritics Ana-
lytical Services web site

Customer Support Customer support contacts, product registration, instrument 
training information, Material Safety Data Sheets, and account 
registration

Grant Program Details of the Grant Program established for non-profit orga-
nizations and universities

Contact Us Contact information, office locations, maps and driving direc-
tions to the Micromeritics facility, and registration for the 
microReport newsletter
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Equipment Description

The ASAP 2050 analyzer is equipped with two independent vacuum systems — one for 
sample preparation and one for sample analysis. Having two separate systems, as well as 
separate preparation ports, allows sample preparation and sample analysis to occur 
concurrently without interruption. Inline cold traps are located between the vacuum pump and 
the manifold in both the analysis and the degas systems. The sample saturation pressure (Psat) 
tube is located next to the sample analysis port. Gas inlet ports and cable connections are 
located conveniently on the side panel of the analyzer for easy access. 

The ASAP 2050 is equipped with an elevator that raises and lowers the analysis bath fluid 
Dewar automatically. A removable shield to enclose the Dewar is also included for safety 
purposes.

The ASAP 2050 system includes Micromeritics’ patented Isothermal Jackets for the sample 
tube. The Isothermal Jacket maintains a stable thermal profile along the full length of the 
sample and Psat tubes.

The ASAP 2050 can operate in a pressure range from 0 to 10 atm; therefore, ensure 
that the sample tube is not under pressure when removing it from the instrument. Use 
caution appropriate for these types of devices.
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Gas Requirements

Compressed gases are required for analyses performed by the ASAP 2050 analyzer. Gas 
bottles or an outlet from a central source should be located near the analyzer. 

Appropriate two-stage regulators which have been leak-checked and specially cleaned are 
required. Gas regulators are available from Micromeritics; refer to Ordering Information, 
page 10-1.

Gases that be used with the ASAP 2050 include argon, carbon dioxide, nitrogen, hydrogen, 
oxygen (with oxygen-compatible vacuum system), and other suitable gases 

Analysis Program

The ASAP 2050 analysis program is designed to operate in a Windows 2000 or Windows XP 
Professional environment. The Windows environment provides a user-friendly interface for 
performing analyses and generating reports.

The ASAP 2050 System software monitors and controls the analyzer. It enables you to 
perform automatic analyses with just a few key strokes, and collects and reports analysis data. 
You can choose from a variety of reports, which can be printed automatically after an analysis 
and/or stored and printed later.

Report System

The ASAP 2050 software includes a report system which allows you to manipulate and 
customize reports. You can zoom in on portions of the graphs or shift the axes to examine fine 
details. Scalable graphs can be copied to the clipboard and pasted into other applications. 
Reports can be customized with your choice of fonts and a company logo added to the report 
header for an impressive presentation. Refer to “REPORTS MENU” on page 7-1 for the 
options available for reports.

 

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with 
an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent) 
pump oil. Failure to use the proper vacuum system could result in hazardous 
conditions including fire and personal injury.
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Specifications

The ASAP 2050 system has been designed and tested to meet the specifications provided 
below.

Characteristic Specification

—————— UTILITY REQUIREMENTS ——————

Electrical: 100/115/230 VAC; 50 or 60 Hz, 800 VA, 
exclusive of vacuum pumps, which are 
powered separately

—————— Operating Environment ——————

Temperature: 10 to 35 oC operating
- 10 to 55 oC storage or shipping

Humidity: Up to 90% (non-condensing) for instrument
20% to 80% for computer system

—————— PRESSURE MEASUREMENT ——————

Range: 0 to 10 atm

Resolution:

Analysis transducer 0.00015 psi

Accuracy (Analysis system only): 0.1% BFSL (Best Fit Straight Line)

   Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s 
   specifications. 

—————— VACUUM SYSTEM ——————

Vacuum Pump: Mechanical, two-stage, ultimate vacuum 5 x 
10-3 mmHg; 2 pumps (one analysis and one 
degas)
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Characteristic Specification

—————— MANIFOLD TEMPERATURE TRANSDUCER ——————

Type: Platinum resistance device (RTD) 

Accuracy: + 0.02 oC (by keyboard entry)

Stability: +0.1 oC per month

—————— DEGAS SYSTEM ——————

Temperature Range: Ambient to 450 oC 

   Selection: 1 oC increments

   Accuracy: Deviation less than +10 oC of set point at 
thermocouple

Backfill Gas: User-selectable, typically helium or nitrogen

—————— SYSTEM CAPACITY ——————

Sample Preparation: 2 degas ports, each with independently-
controlled heating mantle, using servo-
controlled restricted evacuation

Analysis: 1 sample port; 1 saturation pressure tube port

Total Operating Capacity: Up to two complete analysis units can be 
controlled independently by one computer

—————— CRYOGEN SYSTEM ——————

Special Features: Patented Isothermal Jackets effectively 
maintain cryogen level constant on sample 
tube and Po tube during analysis while 
evaporation of cryogen occurs

Capacity: 3-Liter Dewar, which provides at least 50 
hours of unattended analysis.

Analysis Time: Unlimited. Dewars may be refilled without 
affecting the accuracy of results.
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Characteristic Specification

—————— SAMPLE SIZE ——————
1/2-inch straight-wall 316 stainless steel sample tubes. 

—————— GASES ——————

Normal: Argon, carbon dioxide, nitrogen, hydrogen 
oxygen, and other suitable gases 

—————— PHYSICAL ——————

Height: 99 cm (39 in.)

Width: 85 cm (33.5 in.)

Depth: 61 cm (24 in.)

Weight: 115 kg (250 lbs)

—————— COMPUTER ——————

Minimum requirements: Pentium 333 MHz computer (or equivalent)
CD-ROM drive
128 megabytes of main memory
1-gigabyte hard drive
SVGA monitor (800 x 600 minimum 
resolution)
RS232 port
Windows 2000 or Windows XP Professional
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2.  USER INTERFACE

This chapter contains information to familiarize you with the hardware and software of the 
ASAP 2050 system. It is recommended that you read this chapter before attempting to operate 
the ASAP 2050 system.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on the 
front, side, and rear panels of the ASAP 2050 system.

Front Panel

Green power indicator light Illuminated when power is applied to the analyzer.

Vacuum pump panel Allows access to the vacuum pumps. Remove this panel 
when you need to service the pumps. 

It is not always necessary to remove the panel to inspect the 
condition of the fluid or the fluid level. To accomplish either 
of these tasks, remove (or fold over to the right) the protec-
tive rubber mat and lift off the metal cover; this exposes the 
vacuum pump sight window.

                     

                      

          

 
  

                   

                   

  
             

    

                                            Power indicator light

                Vacuum pump panel

                                  Elevator
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Vacuum pump sight 
window

The vacuum pump sight windows enable you to inspect the 
oil levels in the degas and analysis pumps.

Vacuum pump drain Provides a convenient method of draining fluid from the 
pump when service is required. (Pump must be removed from  
analyzer in order to drain.)

 Elevator Allows placement of the Dewar around the sample tube.

          Vacuum pump 
          sight window

   Drain
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The components listed here are located on the underside of the upper extension of the front 
panel.

Degas ports Allow you to degas up to two samples. Each degas port has 
connections for a heating mantle.

Heating mantle 
thermocouple connector

Allows connection of a heating mantle thermocouple (one for 
each degas port).

Heating mantle power 
connector

Allows connection of the heating mantle power cord (one for 
each heating mantle).

Heating mantle breaker Protects the circuitry for the heating mantle in the event of a 
failure (one for each heating mantle). If the circuit breaker 
trips (pops out), call your Micromeritics service 
representative.

Cold Traps Two cold traps are provided; one for degassing and one for 
analysis.

Analysis port For installing the sample tube containing the material you 
wish to analyze.

Po port For installing a Po (saturation pressure) tube.

                                      

              Heating mantle
             thermocouple connector

                                                                                       

                         Four hooks
                          provided for
                         safety shields

     Po port       Analysis port

     

     Not used                                         

Heating 
mantle          Cold traps
power
connector

 Degas
 ports

   Heating mantle
  breaker
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Side Panel

Upper

Gas inlet ports

Vapor gas port

Freespace Helium port

Not used

Degas backfill port

Gas inlet ports Used to connect gas supplies to the analyzer. 

Vapor gas port For attaching the water vapor option, or connecting a vapor 
gas. Refer to Ordering Information on page 10-1 for the 
part number of the water vapor option.

Degas Backfill port Allows connection of a gas to use for degassing the sample.

Freespace Helium port Allows connection of helium to use for measuring the free 
space.
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Lower

On/Off switch For turning the analyzer on and off. This switch also serves as 
the main breaker for the analyzer; it switches off automati-
cally in the event of an electrical fault.

Power connector For connecting the analyzer to the electrical supply.

RS232 port For connecting the analyzer to a computer.

Valve circuit breaker Protects the circuitry for the valves in the event of a failure. If 
the circuit breaker trips (pops out), call your Micromeritics 
service representative.

Voltage selector switch For setting the analyzer to the correct incoming AC line 
voltage.

On/Off switch

Power connector

Voltage selector Switch

Valve circuit 
breaker

RS 232 Port
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Rear Panel

Turning On the System

1. Place the ON/OFF switches for the computer and all peripheral devices in the ON 
position.

2. Place the analyzer ON/OFF switch in the ON position; verify that the green power 
indicator on the front panel is illuminated.

Turning Off the System

1. Select Close from the System Menu or Exit from the File menu.

2. If you exit the ASAP 2050 program with analyses in progress, you will be warned of the 
operation. If desired, you can continue with exiting the application and the analyses will 
proceed and continue to collect data. Reports that are queued under the Print Manager will 

Vacuum pump 
location

Vacuum pump recess Provides for placement of the vacuum pumps. Vacuum 
pumps can be serviced from the front of the instrument by 
removing the vacuum pump panel located on the lower left 
side of the front panel (see Front Panel described 
previously).

Always exit the ASAP 2050 program and/or Windows before turning off the computer. 
Failure to do so could result in loss of data.
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print. If, however, a power failure occurs and an uninterruptible power supply (UPS) is not 
attached to the computer, the data collected after exiting the ASAP 2050 System program 
are lost.

3. Place the computer, monitor, and printer ON/OFF switches in the OFF position.

4. Place the analyzer Main Power switch in the OFF position.

Using the Software

The analysis program operates in the WindowTM environment and requires familiarity with 
standard Windows operations such as using the mouse, menus, and dialogs. While this manual 
provides brief instructions for such standard operations, you may have to refer to your Win-
dows documentation or to its online help system to clarify functions which are specific to 
Windows.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are avail-
able for certain components on the instrument schematic when in manual mode, and for 
onscreen graphs and tabular reports. These menus are accessed by selecting the item for which 
you wish to display its menu and clicking the right mouse button. For example, right-click in a 
column of an onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combina-
tions (if assigned) are listed to the right of the menu item. Instead of opening the menu and 
choosing the command, simply press the key combination. For example, to open a sample 
information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined 
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letter by pressing Alt plus the underlined letter in the command. For example, to access the 
File menu, press Alt, then F.

Table 2-1 provides a list of the keys available in the ASAP 2050 analysis program.

Table 2-1.  Shortcut Keys

Key(s) Function

F1 Access online operator’s manual

F2 Open a sample information file

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file

Insert the current date (Select Dates dialog)

F4 Open an adsorptive properties file

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile open windows

F7 Cascade open windows

F8 Start report

F9 Close all open reports

F10 Generate a Heat of Adsorption report

Alt + F4 Exit the ASAP 2050 program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List adsorptive properties files

Shift + F5 List report options files

Shift + F9 Access shortcut menu of (1) selected component on instrument 
schematic, or (2) onscreen reports
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Dialog Boxes

Dialog boxes (referred to as dialogs) are displayed when a menu item followed by an ellipsis 
(...) is selected. Subdialog boxes are displayed when certain push buttons are selected. Both 
types of boxes may contain one or more of the items listed below. 

The following describes elements that are often included in dialogs. If an element is shown in 
gray instead of black, the element is currently unavailable.

Data Entry Fields A Data Entry field is used to enter text; either numeric (num-
bers only) or alphanumeric (numbers, letters, or printable 
characters). 

If an invalid entry is made, an error message is displayed, for 
example, if you attempt to enter text in a numeric field or a 
number outside of the range shown in the information bar.

Information Bar Some dialogs contain information pertinent to the selected 
field in an information bar across the bottom of the dialog. 
For example, a range is shown for fields in which numeric 
entries are required.

Radio buttons Radio buttons are provided in groups of two or more and are 
used to make a choice; only one radio button can be selected. 
Simply click the desired option with your mouse pointer. A 
black dot indicates the item is selected. 

Check boxes Check boxes allow you to choose multiple options from a 
group of options. Click the desired option(s) with your mouse 
pointer. An X in the box indicates the item is selected; 
remove the X in the same manner.

Grayed Item
(indicates unavailable)

Check Box

Radio Button

Data Entry Field

           Information Bar
Push Button
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Push Buttons A push button is used to display a subdialog box in which to 
enter additional information about the subject matter, or to 
invoke an action. 

For example, if you click Date Range on the Open Sample 
Information dialog, the Select Dates subdialog is displayed. If 
you click Cancel on the Open Sample Information dialog, 
you invoke the action of canceling and closing the dialog.

Close Closes the active dialog. If the dialog contains unsaved 
changes, you will be prompted to save them before the dialog 
closes.

Any information entered in subdialogs (refer to the next sec-
tion of this chapter), is discarded also.

Save Saves the information entered in the current session; the dia-
log remains open.

Replace Allows you to replace the contents of the current file with 
those from an existing file. For example, if you are creating 
an analysis conditions file, you can save time by clicking and 
choosing the file containing the values you wish to use. These 
values are copied into the current file automatically. And 
since the values are actually just copied into the file, you can 
edit them in any way you wish. The file from which they 
were copied remains intact and ready for the next use.

Cancel Discards everything you entered in the dialog and any subdi-
alogs, and closes the dialog. A warning message is displayed 
before closing.

Drop-down list A drop-down list contains a list of options and is indicated by 
a down arrow to the right of the field. If there are more items 
than can fit in the box, a scroll bar is provided for navigating 
through the list.
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialogs contain a 
Files list box which displays a list of files available for that particular operation. For example, 
the Open Sample Information File dialog.

A default string appears in the File name field. To select a file, simply move the mouse pointer 
to the desired file in the list and double-click.

You can limit the list of files displayed by choosing one or more of the following options:

• Use wildcard characters in the path name entered in the File name field. Standard and 
wildcard characters (such as * and ?) can be used to filter file names. For example, you 
could limit the list of files shown in the dialog above to those beginning with 13x by enter-
ing 13x*.SMP in the file name field.

• Enter a range of dates. Click Date Range; the Select Dates dialog is displayed.

Select Show Date Range to enable the From and To fields, then enter a beginning and 
ending date. Or you can double-click in each field to display a calendar to select a date. 
The range of dates remains the default until you change the dates or select Show All 
Dates. 

The Status drop-down 
list does not appear on 
the Open dialog for 
parameter files.

Displays all files of 
the type in the Status 
field.

Displays the 
current 
directory.
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For convenience, the following shortcut keys are available when the Select Dates dialog is 
displayed:

F2 Clears the date
F3 Inserts the current date
F4 Displays a calendar from which you may select a date

• Select a file status from the Status drop-down list. For example, choose Complete from 
the drop-down list and only files that have been used in an analysis are displayed. The 
table shown below describes each file status.

Table 2-2.  File Status and Description

• Navigate to a different directory. The current directory is displayed just above the Directo-
ries list box. You can change directories by double-clicking a directory in the Directories 
list box, double-clicking [..] to move up one level, or by entering the desired directory in 
the File Name field. For example, enter C:\2050files\sample\*.smp to display sample files 
in the 2050files\sample directory on your local drive.

The Status drop-down list does not appear on the File > Open dialogs for parameter 
files.

Status Description

All All sample information files in the specified directory and within the 
specified range of dates

Analyzing Sample information files that are currently being used with an analysis

Complete Sample information files that have been used with an analysis

Entered Sample information files that contain manually entered data

No analysis Sample information files that have not been used in a degassing operation or 
an analysis

Prepared Sample information files that have been used in an automatic degassing 
operation and are ready for analysis

Preparing Sample information files that are currently being used in an automatic 
degassing operation
2-12                                                    Jul 07



ASAP 2050 Operator’s Manual Using the Software
File Name Conventions

For sample information and parameter files, a wildcard character (*) and a default extension 
display. 

The following table shows the file name extensions for the ASAP 2050 program.

Table 2-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Sample Tube STB

Degas Conditions DEG

Analysis Conditions ANC

Report Options RPO

Adsorptive Properties ADP

Export to disk (ASCII) ISO

Report to disk RPT

List to disk LST

Thickness curve THK

Alpha-s curve ALS

The following types are available for reports saved from the Report window

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the ASAP 2050 are located on menus which are accessed from the Menu bar. 
Each menu contains commands, and in some cases a submenu. A submenu is indicated when 
the command is followed by an arrow. 

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses 
for a detailed description of the commands contained on that menu.

  Menu Name

Menu Bar

Submenu

Command

File Enables you to maintain system files. (Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument operations. 
(Chapter 6, UNIT MENU)

Reports Enables you to generate, customize, and close reports. (Chapter 7, 
REPORTS MENU)

Options Enables you to select data presentation formats, and enter system 
default values. (Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your screen. It 
also displays the names of all open files. (this chapter, page 2-15)

Help Displays Help information. (this chapter, page 2-15)
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Windows Menu

Help Menu

Tile Resizes all open windows and arranges them side by side so 
that the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the stack. 
Each window’s title remains visible, making it easy to select 
other windows.

Arrange Icons Arranges the symbols for all minimized windows in an 
orderly manner.

Open file names Displays all open files; the active window is preceded with a 
check mark. 

Operator’s Manual Displays the operator’s manual in PDF format. 

About ASAP 2050 Displays information about the ASAP 2050 analysis 
program.
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3.  OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

• specify sample file defaults, this page 
• create sample information files, page 3-6
• define parameter files, page 3-9 
• prepare the sample page, 3-16
• perform an analysis page, 3-37
• generate a list of information on a sample or parameter file, page 3-40
• print contents of a sample or parameter file, page 3-39
• export data in a sample information file to an ASCII file, page 3-41
• overlay graphs, page 3-42

This chapter does not contain detailed descriptions of the dialogs used to perform these 
procedures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index to assist you 
in locating the appropriate dialog. 

Sample Information Files

Sample information files contain information used to control the analysis. Therefore, an 
analysis cannot proceed until it has been assigned a sample information file. A sample 
information file consists of the following:

• sample identification
• sample tube criteria
• analysis conditions
• adsorptive properties
• report options
• collected/entered data (after an analysis has been completed) 

Portions of the sample information file can also exist as standalone parameter files. Having 
these files exist independently allows you to use them as many times as you wish. For 
example, if you typically use the same analysis conditions for many of your analyses, you can 
create an analysis conditions file containing the desired conditions. Then when you create your 
sample file, select that file for your analysis conditions; the values will be copied into the 
current sample file. After it becomes part of the new sample file, you can edit it as desired. The 
file from which the values were copied remains intact and ready for the next use.

Sample information files reside in a folder. The more files in a folder, the longer it may take to 
access a file. Therefore, it is a good practice to limit the number of files in a folder to 
approximately 200. You may create additional folders as needed. 
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Sample information files can be created and presented in the Advanced, Basic, or Restricted 
format. 

• Advanced
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its 
associated dialog, allowing you to edit conditions. You can also switch to the Basic 
format if desired.

• Basic
Presents all parts of the sample information file as a single dialog. This format allows 
you to quickly create a sample information file using predefined parameter files. You 
can also switch to the Advanced format if desired.

• Restricted
Identical to the Basic format except that you cannot switch to the Advanced format for 
editing; certain functions are also disabled.

Specifying Sample File Defaults

You can specify sample defaults in the Basic or Advanced format. The defaults you specify are 
the ones you see when you create a new sample file in the respective format. Therefore, it is 
best to specify (or enter) parameters that you plan to use most frequently. For example; specify 
defaults for your most commonly analyzed sample material. You can always edit parameters in 
the sample file when it is created. The ASAP 2050 system automatically generates sample 
information file names and uses the values you specify as the defaults. 

Basic Format

Perform the following steps to define defaults for a sample information file in the Basic 
format.

1. Select Options > Sample Defaults; the default Basic Sample Information dialog is 
displayed.

Select Option Presentation on the Options menu and ensure that Basic is selected as 
the format.
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2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File > Open > Sample 
information. You can use up to eight characters.

3. In the field on the right of the Sample line, enter a format for the sample identification. Be 
sure to include the $ symbol if you want the sample file number included as part of the 
identification. You can use up to 42 alphanumeric characters.

4. Enter a default value in the Mass field. An approximate weight is sufficient; a more 
accurate weight can be entered later.

5. The sample density is used when free space is calculated; enter a default for your sample’s 
density if you typically use a calculated free space. Otherwise, this value is ignored.

6. Select the down arrow to the right of the parameter fields to choose default parameter 
files:

• Sample tube
• Degas conditions
• Analysis conditions
• Adsorptive properties
• Report options

7. Click Save, then Close.

You also can edit the word Sample. For example, you may prefer to use Material or 
Test. You can enter up to 15 characters in this field.
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Advanced Format 

The Advanced Sample Defaults dialog resembles a set of index cards. You can move from one 
set of parameters to another by clicking the parameter tab or by using Next and Prev. The 
values you specify in the parameter portions of the sample file (Analysis Conditions, Degas 
Conditions, Adsorptive Properties, and Report Options) are saved as the defaults for newly 
created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, Yes to create the file, and the defaults you 
specify display for all parameters.

• Select File > Open > Analysis Conditions, enter a name, then Yes to create the file, 
and the defaults you specify in the Analysis Conditions portion of the Advanced Sample 
Defaults dialog display in the fields.

1. Select Options > Sample Defaults, the Advanced Sample Defaults dialog is displayed.

2. In the Sequence field, specify a default string for the sample file number; you can use up 
to eight characters. This is the number that appears in the File name field when you select 
File > Open > Sample information.

Select Option Presentation on the Options menu and ensure that Advanced is selected 
as the format.
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3. In the right-side field of the Sample line, enter a format for the sample’s identification. 
You can enter up to 42 characters. Be sure to include the $ symbol if you want the sample 
file number (Sequence) included as part of the identification.

4. Edit the Operator and Submitter lines as desired. Or have them omitted entirely by 
selecting Omit.

5. Enter a default value in the Mass field. An approximation in this field will suffice; a more 
accurate value for the sample mass can be entered at the time of analysis.

6. If you plan to use a calculated free space, enter the sample’s density in the Density field.

7. Choose whether you wish to have data collected automatically or if you plan to enter the 
data. This option can be changed (if desired) at the time of analysis.

8. Click the Sample Tube tab. Enter criteria for the sample tube you most commonly use, 
then click Save.

9. Click the Degas Conditions tab. Specify degassing criteria, then click Save.

10. Click the Analysis Conditions tab. Choose the analysis conditions appropriate for your 
most commonly analyzed material, then click Save.

11. Click the Adsorptive Properties tab. Specify gas characteristics, then click Save.

12. Click the Report Options tab. Choose desired reports, using Edit to specify details; then 
click Save. 

13. Click Close to close the dialog.

You can click Save on each dialog as you specify parameters, or you can click Save 
on any dialog after all parameters have been specified. All dialog defaults will be 
saved.
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Creating Sample Information Files

A sample information file must be assigned to every sample that is analyzed. When you create 
a sample file, you can accept the default values specified using Sample Defaults, or you can 
edit them as desired. You can create a sample information file using the Advanced, Basic, or 
Restricted format. 

Advanced Format

The Advanced format allows you to customize the parameters of a sample information file. 
Chapter 5 provides a description of the fields associated with creating sample information 
files.

1. Select File > Open > Sample information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

The defaults that appear in the fields are the ones specified in Sample Defaults. 

These fields do not
display if you selected
Omit when specifying
Sample defaults.
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4. Accept the default identification in the Sample field or change it to an appropriate one. 
The dialog above shows the sample file number because the dollar ($) symbol was used 
when specifying sample defaults.

5. Edit the Operator and/or Submitter fields as needed. If these fields are not displayed, 
they were selected to be omitted in Sample Defaults.

6. Enter the sample’s mass (if different from the default value) in the Mass field.

7. Choose whether you want data automatically collected by the system or whether you wish 
to enter the data.

8. Click Save to save the information you entered.

9. The steps for completing the remaining parameters of the sample information file are 
explained in subsequent sections:

• Specifying Sample Tube Criteria 
• Defining Degas Conditions
• Defining Analysis Conditions
• Defining Adsorptive Properties
• Defining Report Options

Simply click on the tabs to open the associated dialog.

If a sample information file already exists containing the values you want to use in 
this file, you can click Replace all to copy those values into this one. You can still 
edit the values after they are loaded. 

Use the Comments window to record specifics of the analysis or its conditions. 
Anything you enter in this window is displayed in the report header.
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Basic and Restricted Formats

Sample information files are created in the Basic and Restricted formats using predefined 
parameter files. Chapter 5 provides a description of the fields associated with creating sample 
information files.

1. Select File > Open > Sample information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed. The 
defaults that appear in the fields are the ones specified in Sample Defaults. 

4. Accept the default identification or change it to an appropriate one. 

5. Enter the sample’s mass (if different from the default value) in the Mass field.

6. Using the down arrows to the right of each parameter field, select an appropriate file (or 
accept the defaults). You can review or edit the contents of these files by switching to the 
Advanced format if desired.

7. Click Save, then Close.

Use this push button to copy parameters 

Not displayed on the 
Restricted dialog.

If you are using the Restricted format, you cannot switch to the Advanced format.
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Defining Parameter Files

The following file types can exist as part of the sample information file or as an individual 
parameter file:

• Sample tube
• Degas conditions
• Analysis conditions
• Adsorptive properties
• Report options

Having these files exist independently allows you to use them over and over again.
Several predefined parameter files (located in the params directory) are included with the 
ASAP 2050 analysis program. Although these files may come close to the needs of your 
laboratory, you may wish to define additional ones. Or you can use a predefined file as a 
starting point. This is easily accomplished by creating a new file and then selecting Replace. 
A dialog is displayed so that you can select the existing file containing the values you wish to 
use. After the values are copied into the current file, you can edit the values as desired; the 
original file remains intact and ready for the next use. 

If you wish to have parameter files display in the drop-down list on the Basic Sample 
Information dialog, be sure to save them to the directory specified as the Parameter Files 
Directory. (Refer Parameter Files Directory on page 8-12 for additional information.)

Sample Tube

1. Select File >Open > Sample Tube; the Sample tube dialog is displayed.

2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Sample Tube dialog is displayed

4. Enter a description in the Sample Tube field. Be sure to use an intuitive description so that 
you can recognize it easily.

5. Click Load from Sample File; the Open Sample Information File dialog is displayed.
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6. Select the file you used in the blank run with this sample tube, then click Open to copy the 
ambient and analysis free space into the Sample Tube dialog.

7. If a vacuum seal of some type was used, select the appropriate option or leave the default 
of None selected.

8. Click Save, then Close.

Degas Conditions

Degas Conditions files contain degassing information for preparing samples. 

Perform the following steps to define a degas conditions file:

1. Select File > Open > Degas Conditions; the Degas Conditions dialog is displayed.

2. Enter a name in the File name field, then click OK.

3. Click Yes to create the file; the Degas Conditions dialog is displayed.

4. Enter a description in the Description field. Be sure to use an intuitive description so that 
you can recognize it easily.

5. Specify values for the evacuation and heating phases for degassing the sample

6. Click Save, then Close.
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Analysis Conditions

Analysis conditions specify the data used to guide an analysis. An analysis conditions file may 
be assigned a unique name, and you can direct any sample to be analyzed according to the 
conditions in any existing analysis conditions file. Chapter 5 provides a detailed description of 
the fields on this dialog.

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description (up to 42 characters) in the Description field. Use an intuitive 
description, one that will help you identify the type of sample you plan to analyze using 
these analysis conditions.

5. Specify points for your pressure table. Use the push buttons adjacent to the table to assist 
you in creating your table. 

6. Click Preparation to specify evacuation and leak test values.

7. Click Free Space to specify how the free space is to be measured.

8. Click Po and T to specify how the saturation pressure (Po) is to be measured, and the 
analysis bath temperature. If you select Absolute pressure dosing, options 1 through 5 
are disabled. The Po will be calculated using the analysis bath temperature; enter the 
appropriate temperature in the field provided.

9. Click Dosing to specify dosing options.
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10. Click Equilibration to specify the equilibration interval and its delay time.

11. Click Backfill to specify backfill options.

12. If you wish to use absolute dosing, click the Absolute pressure dosing option.

13. Click Save, then Close.

Adsorptive Properties

Adsorptive properties specify the characteristics of the gases used in the ASAP 2050 System. 
Chapter 5 provides a detailed description of the fields on this dialog.

1. Select File > Open > Adsorptive properties; the Open Adsorptive Properties File dialog 
is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Adsorptive Properties dialog is displayed.

.

4. Enter the name of the adsorptive gas in the Adsorptive field, then enter its mnemonic.

5. Click Psat vs T to edit the Psat vs Temperature table. Edit any other field(s) on this dialog 
as required, then click OK. 

6. Select Non-condensing Adsorptive if the gas is non-condensing.

7. Enter the appropriate information (or accept the defaults) in the following fields.

Maximum manifold pressure
Density conversion factor
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Therm. tran. hard-sphere diameter
Molecular cross-sectional area

8. Click Open and select the compressibility factor table for gas to be used for analysis.

9. Choose your preferred dosing method; choose Normal for gases under pressure. 

Report Options

Report options specify the types of reports to be generated from an analysis or manually 
entered data. They also help you customize details of reports such as axis scale, axis range, 
column headings, and components of thickness curve equations.

You can tailor report options files to accommodate the requirements of your analyses. For 
example, you can generate a simple report that lets you determine the basic characteristics of 
the sample. Then use that report to make choices about the variables you want to include in 
lengthier, more sophisticated reports. You can specify for reports to be generated automatically 
after each analysis, or you can generate reports at any time during or after an analysis. 
However, a report generated during an analysis only includes data collected up to the time of 
the report. Chapter 5 provides a detailed description of the fields on this dialog.

1. Select File > Open > Report Options; the Open Report Options File dialog is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Report Options dialog is displayed.

4. Enter a description (up to 42 characters) in the Description field. Enter an identifier that 
gives a more intuitive description of the file’s contents. For example, BJH Adsorption 
Report Options.
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5. Select Show report title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you prefer not to have a report title.

6. If you wish to compare the same type of graph from multiple files, click Overlays and 
choose the files. Then be sure you edit the graph from the Selected Reports window and 
choose Samples from the Overlay drop-down list.

7. Select Thermal transpiration correction if you want correction made for thermal 
transpiration in the sample tube, then enter the inside diameter of the sample tube.

Thermal transpiration correction should be used for analyses where the sample 
temperature is more than 100 oC below the manifold temperature.

8. The reports that may be generated are listed in the Selected Reports list. Select reports by 
double-clicking on the desired report. Reports are deselected in the same manner. A report 
is selected when it is preceded by a check mark.

9. You can edit some reports by highlighting the desired report and clicking Edit. 

10. Click Save, then Close to save the information and close the dialog.

Using the Cold Trap

The cold trap helps remove oil vapors from the system. It can be used when preparing samples 
on the degas ports or when analyzing samples on the analysis port. If should not, however, be 
used with gases that could freeze in the cold trap, for example CO2 at liquid nitrogen 
temperatures. 

1. Make sure the Dewar contains enough analysis bath fluid. (Refer to “Filling the Dewar” 
on page 3-25.)

2. Hang the cold trap Dewar around the cold trap port as shown below.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header by selecting Show graphic. Click Browse to 
select the file; use the Height and Width fields to specify the size.
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3. Place the cover over the Dewar opening.

Cold trap
port

  Dewar
  cover
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Preparing Samples

Care should be taken in conditioning and filling sample tubes. The following guidelines help 
ensure accurate, reproducible results.

The weight of the isothermal jacket may vary slightly and cannot be considered as constant; 
therefore, do not weigh it with the sample tube set.
 
The sample tube should be cleaned (using an ultrasonic cleaning unit) and adequately dried 
before each analysis to prevent the cross-contamination of samples. The following materials 
are recommended for cleaning sample tubes:  

• Ultrasonic cleaning unit 
• Suitable detergent 
• Latex gloves or lint-free cloth 
• Isopropyl alcohol (IPA) is preferred for cleaning; acetone or deionized water may be 

used if IPA is unavailable
• Nitrogen or helium 
• Sample tube brush 

1. Ensure that the ultrasonic cleaning unit is clean. 

2. Using a ratio of 5 grams of detergent per 500 mL of warm water, fill the bowl of the 
ultrasonic unit with enough water to cover the entire sample tube. 

3. Ensure that the detergent is dissolved before placing the sample tube into the water. If too 
much detergent is used, it may be difficult to rinse from the sample tube. 

4. Fill the sample tube with warm water and place it in the bowl of the ultrasonic cleaning 
unit. Turn on the ultrasonic cleaning unit for approximately 15 minutes. 

5. Using latex gloves or a lint-free cloth, remove the sample tube from the bowl. 
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6. Clean the interior of the sample tube with the brush supplied in the accessories kit. 

7. Rinse the sample tube thoroughly with hot water. Then rinse it with isopropyl alcohol. 

8. Using dry, compressed nitrogen or air, dry the interior of the sample tube. Use a tubing 
extension long enough and small enough in diameter to fit inside the sample tube.

9. Wipe a stopper or seal frit with a lint-free cloth. Place the stopper or seal frit on the sample 
tube. 

If isopropyl alcohol is unavailable, acetone or deionized water may be used to rinse 
the sample tube. Do not use any corrosive cleaning agents. They may reduce the 
integrity of the stainless sample tube.
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Determining the Mass of the Sample 

1. Place the sample tube (with stopper or seal frit) onto the balance. Record the value as the 
mass of the empty sample tube.

2. Remove the sample tube from the balance.

3. Place a sample container onto the balance. Zero the balance and allow it to stabilize. 

4. Slowly add the sample to the container. This step enables you to control the size of the 
sample before it is poured into the prepared sample tube. Do not record the sample mass at 
this point.

A form to help you determine the sample’s mass is provided in Appendix A. Make 
copies of this form and use it for your convenience.
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5. Remove the stopper from the tube. Carefully pour the sample from the container into the 
sample tube. Use a pipe cleaner to clean the walls of the sample tube before weighing the 
sample.

6. Replace the stopper or seal frit on the sample tube. 

7. Place the sample tube onto the balance. Determine the mass of the sample tube (with 
stopper) and sample. Record the value as the Sample plus sample tube mass if you are 
using the Sample Mass form from Appendix A.
Jul 07                                                 3-19 



Preparing Samples ASAP 2050 Operator’s Manual
Degassing Samples on Degas Ports

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. 
The sample must be clean when an analysis is performed. The sample is heated and placed 
under vacuum to remove moisture and other contaminants. This process is referred to as 
degassing the sample. You may degas up to two samples at one time using the degas ports.

1. Insert the heating mantle thermocouple plug into the thermocouple connector above the 
degas port to be used. Insert the heating mantle power plug into power connector and twist 
to lock securely.

2. While holding the degas port plug, remove the connector nut and plug from the degas port 
by turning the connector nut counterclockwise. 

Heating mantle power plug

Heating mantle thermocouple

  Port plug

Connector nut
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3. Place the connector nut, and, if used, seal frit, onto the sample tube. Make sure the O-ring 
is in place on the sample tube as shown below.

4. Attach the sample tube to the degas port. Be sure to push the sample tube in to a full stop. 
Secure the sample tube in place by sliding the connector nut up to the degas port and 
turning the connector nut clockwise. Tighten the nut securely by hand.

Connector nut

O-ring

Seal frit
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5. Slide the heating mantle around the sample tube with the heating mantle hook toward the 
back. 

6. Attach the elastic cord to the hook on the heating mantle and to the hook on the front panel 
of the instrument; then secure the mantle with a heating mantle clip as shown below.

Heating mantle hook

    

Elastic cord

   

  

Heating mantle clip

Heating mantle hook

Front panel hook
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7. Select Start Degas from the Unit menu; the Start Degas dialog is displayed.

8. Click Browse to the right of the Sample field to choose your degas file.

Repeat this step if you are degassing two samples.

9. Click Start to begin the degassing operation. 

10. After degassing has completed, allow the heating mantle and sample tube to cool. 

11. After the heating mantle has cooled, carefully remove the heating mantle and allow the 
sample tube to cool to room temperature (approximately fifteen minutes). 

12. When the sample tube has cooled, transfer it to the analysis port (refer to “Transferring a 
Degassed Sample to the Analysis Port” on page 3-26).

Observe the status bar of the degassing operation to determine when degassing is 
complete.

Do not touch the sample tube or the heating mantle until they have reached room 
temperature. Touching the sample tube or heating mantle could result in burns.
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Filling the Analysis Dewar

Precautions 

We recommend the following be observed when handling Dewars containing liquefied gases:

• Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber 
apron, and 3) insulated gloves.

• When pouring liquefied gases from one container to another: 1) cool the receiving 
container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to 
prevent splashing, and 3) vent the receiving container to the atmosphere.

• Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases 
(or other materials of extremely low temperature). Do not use a glass or metal stirring 
rod unless it is coated with some form of protective coating.

• Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover 
over the Dewar’s opening. If an object of sufficient weight is accidentally dropped into 
the Dewar, shattering may occur.

• Always install the Dewar cover before performing an analysis. The cover reduces the 
accumulation of ice. Accumulated ice could cause the Dewar to bond to the sample 
tube.

Always handle Dewars with care. Any product incorporating a vacuum is a potential 
safety hazard and should be treated with caution.
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Filling the Dewar

1. Fill the analysis Dewar with the cryogen to about 5 cm (2 inches) from the top.

2. Check the analysis bath fluid level with the dipstick as shown below. 

Incorrect fluid levels can lead to measurement errors. Do not overfill the Dewar.

Maximum Level 
Indicator Mark

Wetness or frozen 
condensation indicates  
bath liquid level.

Analysis Dewar
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Transferring a Degassed Sample to the Analysis Port

The sample tube must be removed from the degas port, weighed and then installed onto the 
analysis port for analysis.

1. Make sure the sample tube has cooled to room temperature. 

2. While holding the sample tube, loosen the port connector nut and remove the sample tube 
from the degas port. If you are not using a seal frit, insert a stopper immediately. Remove 
the connector nut from sample tube stem.

If the sample tube is not mounted to the analysis port immediately, either leave it on 
the degas port or remove it and insert the rubber stopper (unless you are using a 
seal frit) into the sample tube opening.
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3. Weigh the sample tube set. Enter the weight on the Sample Data Worksheet as Mass of 
sample tube plus sample (After Degas). 

4. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample tube plus 
sample (After Degas) to determine the mass of the sample. Record this value as the Mass 
of sample (After Degas). 

5. Remove the connector nut, and, if installed, the port plug, from the analysis port by 
turning the connector nut counterclockwise. 

Port plug

Connector nut
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6. Remove the stopper from the sample tube and immediately attach the sample tube to the 
analysis port, pushing it fully up into the port. Secure it in place by screwing the connector 
nut onto the analysis port connector; hand-tighten the connector nut.

7. If you wish to degas the sample on the analysis port, proceed to “Degassing a Sample on 
the Analysis Port” on page 3-31.

If you wish to perform an analysis, slide the isothermal jacket up over the sample tube. 
Make sure the saturation pressure tube is close to the sample tube.

You do not have to remove the seal frit (if one is used).
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8. Place the analysis Dewar on the elevator as shown in the following illustration.
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9. Place the Dewar cover over the sample tube stem just above the isothermal jacket as 
shown below.

10. Attach the safety shield to the two hooks above the port.

11. Begin the analysis. Refer to “Performing an Analysis” on page 3-37.
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Degassing a Sample on the Analysis Port

In addition to preparing a sample on a degas port, you may further evacuate the sample on the 
analysis port prior to starting an analysis.

1. With the sample tube attached to the analysis port (refer to “Transferring a Degassed 
Sample to the Analysis Port” on page 3-26), select Unit [n] > Show Analysis 
Schematic, then select Unit [n] > Enable Manual Control. The Manual Control screen is 
displayed.

2. Open valves 7, 9 and 2.

3. Wait until the value displayed for the transducer is below 10 mmHg.

4. Open valve 1. 

5. Evacuate until the vacuum gauge reaches vacuum and no leaks are indicated on the gauge.
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6. Insert the heating mantle thermocouple plug into the thermocouple connector behind one 
of the degas ports. Insert the heating mantle power plug into the associated power 
connector and twist to lock securely.

7. Slide the heating mantle around the sample tube with the heating mantle hook toward the 
back. 

8. Attach the elastic cord to the hook on the heating mantle and to the hook on the front panel 
of the instrument, then attach a heating mantle clip as shown below.

9. Gently heat the sample:

Heating mantle power plug

Heating mantle thermocouple

Instrument hook

Elastic cord

Heating mantle clip
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a.  Select Unit [n] > Degas > Show Degas Schematic to display the Degas Schematic.

b.  If the analyzer is not in manual control mode, select Unit [n] > Degas > Enable 
Manual Control.

c.  Right-click on the degas port to which the heating mantle power plug and thermocouple 
are connected, then select Set.  

d. The Heater Settings dialog is displayed. Enter 10 oC/min. for Ramp rate.

e. Enter 150 oC for Target temperature.

f.  Click OK.

10. Allow the sample to degas for a minimum of one hour. (Additional time may be required 
to fully degas the sample.)
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11. Right-click on the degas port sample tube, then select Disable.

12. When the heating mantle is cool enough to handle, remove it from the sample tube.

13. Allow the sample to cool to room temperature.

14. Slide the isothermal jacket up over the sample tube. Make sure the saturation pressure tube 
is close to the sample tube.

Do not touch the sample tube or the heating mantle until they have cooled. 
Touching the sample tube, heating mantle, or heating mantle clip before they 
have cooled could result in burns.
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15. Place the analysis Dewar onto the elevator as shown in the following illustration.

16. Place the Dewar cover over the sample tube stem just above the isothermal jacket as 
shown below.
Jul 07                                                 3-35 



Degassing a Sample on the Analysis Port ASAP 2050 Operator’s Manual
17. Attach the safety shield to the two hooks above the port.

18. Begin the analysis. Refer to “Performing an Analysis” on page 3-37.
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Performing an Analysis

After the sample has been degassed and transferred to an analysis port, you may begin an 
analysis. 

Ensure that the analysis gas and the Psat gas specified in the sample file match the system 
configuration gases; if they do not, correct the sample information file or correct the unit 
configuration gas. 

Perform the following steps to begin an analysis:

1. Select Unit > Start Analysis; the Analysis dialog is displayed with the Start Analysis 
dialog positioned on top. 

2. Choose a file for your analysis and click OK; the Analysis dialog containing the 
parameters of the selected file is displayed. 

3. Verify parameters and make any changes you feel necessary.

Before beginning an analysis, make sure the tank pressure for the gas regulator is at 
least 200 psig (1379 kPa). Pressures less than 200 psig (1379 kPa) may cause the 
sample to be inadequately saturated, resulting in inaccurate data or termination of 
analysis.
Jul 07                                                 3-37 



Performing an Analysis ASAP 2050 Operator’s Manual
4. To generate a report automatically after the analysis, click Report after Analysis and 
choose report output options. You can generate reports to the screen (Preview) or directly 
to a printer.

5. Click Start to begin the analysis.

6. Until data collection begins, the following message is displayed on the screen.

7. As data are collected, a graph will be drawn in the window.

8. If you wish to perform another analysis after the current analysis is completed, click Next; 
the first view of the Analysis dialog is displayed.

Make sure the elevator is all the way down. If it is not all the way down, hazardous 
conditions can result.

After the elevator rises, do not place any items under the elevator platform. Objects 
under the platform will prevent the elevator from fully lowering, and could cause 
damage to the elevator mechanism.
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Printing File Contents

You can print the contents of one or more sample or parameter files.

1. Select File > Print; a drop-down list containing file types is displayed. 

2. Choose the file type; a dialog similar to this one is displayed.

3. From the Files list box, select the desired file. If you plan to print multiple files, hold down 
Ctrl while clicking on the desired files.

4. Choose whether you wish to print the contents to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to four 
copies.

5. Click OK; the file is printed to the specified destination.

The ASAP 2050 can operate in a pressure range from 0 to 10 atm; therefore, ensure 
that the sample tube is not under pressure when removing it from the instrument. Use 
caution appropriate for these types of devices.

You can use the Status drop-down list and/or the Date Range push button to limit the 
files displayed in the Files list.
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Listing File Statistics

You can generate a list of the following information on a sample file or parameter file.

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

1. Select File > List.

2. From the List drop-down menu, select the type of file on which you wish information. A 
dialog similar to the one shown below is displayed:

3. From the Files list box, choose the desired file(s). If you wish to include all files, leave all 
files deselected. 

4. Choose whether you wish to print statistics to the screen (Preview) or to a printer (Print). 
If you choose Print, the Copies field is enabled allowing you to print up to four copies.

5. Click OK, a list for the requested file(s) is sent to the specified destination.

Displays the type of file
on which you requested
information; in this
example, a sample
information file 
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Exporting Isotherm Data

The Export option on the File menu allows you to copy the isotherm data in the sample 
information file and reformat it in ASCII text. If saved to a File, the data can be imported into 
applications, such as spreadsheets. The output file consists of four columns containing the 
absolute pressure, relative pressure, specific volume adsorbed, and the elapsed time.

1. Select File > Export; the Export Sample Information dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export. You can select multiple files 
by holding down Ctrl while clicking on the desired files. 

3. Choose an output destination. When you choose File as the destination, the File name 
field is enabled so you may enter a name (or you can accept the default). If you have 
selected multiple files, each file is exported as its file name with the extension .ISO.

4. Click OK; the file(s) is exported to the specified destination.

You can use the Status drop-down list and/or the Date Range push button to limit the 
files displayed in the Files list.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or 
multiple graphs for one sample. Graphical lines are differentiated by the use of varying 
symbols and reported in a legend on the report. If color output capability is available, different 
colors are used instead of symbols.

Graph overlays can be implemented in two ways:

• Multiple Sample Overlays 
Overlay results for up to eight samples on top of a previously selected sample. 

• Multiple Graph Overlays
Overlay two different types of graphs from one sample. The multiple graph overlay 
capability exists for: 

BJH Adsorption/Desorption
DFT Pore Size/Surface Energy

You cannot overlay graphs if your sample file presentation is in the Basic format. You must 
switch to the Advanced format before proceeding.

Multiple Samples Overlay

1. Select File > Open > Sample Information to display the Open Sample Information File 
dialog. 

2. Select a sample on which to overlay graphs of other samples, then click OK; the Sample 
Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.
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4. Make your report selections (or deselect any you do not wish to generate).

5. Choose the type of report for which you wish overlays; perform the steps indicated:

If overlaying this 
type of report...

Then...

Alpha-S
Isotherm
BET/Langmuir surface area
F-ratio
Freundlich
Temkin
t-Plot

Select the report for which you want an overlay, then click 
Edit. A report options dialog for that report is displayed.

Select Overlay Samples and do any other editing you wish.

Click OK; the main Report Options dialog reappears.

Dubinin Select Dubinin, then click Edit; a Report Options dialog for 
Dubinin is displayed.

Select the desired graph, then click Edit. An options dialog 
for that graph is displayed (for example, dV/dw Pore 
Volume).

Select Overlay Samples and do any other editing you wish.

Click OK; the options dialog for Dubinin reappears.

Click OK; the main Report Options dialog reappears.

BJH Adsorption
BJH Desorption
DFT Pore Size
DFT Surface Energy

Select the report for which you want an overlay, then click 
Edit. A Report Options dialog for that report is displayed.

Select the desired report, then click Edit. An options dialog 
for that graph is displayed.

Click on the down-arrow at the Overlay field and select 
Samples; do any other editing you wish.

Click OK; do any other editing you wish. 

Click OK; the main Report Options dialog reappears.
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6. Click Overlays; the Graph Overlay Samples dialog is displayed.

7. Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection dialog 
is displayed.

8. Choose a sample file, then click OK. You may choose up to eight files in this manner.

9. After selecting the desired number of sample files, click OK; the main Report Options 
dialog reappears.

10. Click Save if you wish to save your Selected Reports list. Even if you don’t save, all of the 
options you selected regarding overlays and other items are included in the report you 
generate.  

11. Select Reports > Start Report; the Start Report dialog is displayed with the name of your 
primary file highlighted. 
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12. Click OK; the Select Reports dialog is displayed.

13. Ensure that the desired graph is selected (preceded with a check mark), then click OK.

Multiple Graphs Overlay

Multiple graph overlays can be produced only for:

• BJH Adsorption
• BJH Desorption
• DFT Pore Size
• DFT Surface Energy

1. Select File > Open > Sample Information to display the Open Sample Information File 
dialog.

2. Select a sample for which you want to overlay two graphs; then select Edit; the Sample 
Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog.

4. Make your report selections (or deselect any you do not wish to generate).
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5. From the Selected Reports list, select the report for which you want multiple graph 
overlays, then select Edit; a Report Options dialog for that report (or graph) is displayed 
(this example shows BJH Adsorption).

6. Select a report type, then click Edit; an options dialog for that specific item is displayed 
(this example shows Cumulative Pore Volume).

7. Click the down arrow at the Overlay field and select a graph type from the list. This 
selection will be overlaid on the graph selected in the Variable field.

8. Select OK to return to the BJH Adsorption Report Options dialog; do any editing you 
wish.

9. Click OK to return to the main Report Options dialog.

 These two graphs
will be overlaid
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10. Click Save if you wish to save your Selected Reports list. Even if you don’t save, all of the 
options you selected regarding overlays and other items are included in the report you 
generate.  

11. Select Reports > Start Report; the Start Report screen is displayed with the name of your 
primary file highlighted. 

12. Click OK; the Select Reports dialog is displayed. 

13. Ensure that the desired graph is selected (preceded with a check mark), then click OK.
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4.  SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

• Installing the software
• Using the Setup Program for other functions

Installing the Analysis Program

Power option features must be properly set to enable communications between the analyzer 
and the computer. Set these features as follows: 

1. From the Windows Start menu, select Settings > Control Panel > Power Options. 

2. Select Never from the drop-down lists for all Power Scheme options except the monitor. 
You may select any setting you wish for the monitor.

Initial Installation

The ASAP 2050 System program is supplied on a CD. Perform the following steps to install 
the program:

1. Turn on the analyzer.

2. Insert the CD into the CD-ROM drive.

3. Select Start from the Status bar, then Run from the Start menu.

Enter the drive designator for the CD-ROM drive, followed by setup. For example:

e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.

4. Click OK; the New Installation dialog is displayed.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.
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The Destination Folder group box displays the amount of current disk space, the amount 
of disk space required for the analysis program, and the directory into which the 
application will be installed. If you wish to install the application into a different directory, 
click Browse to choose the directory.

5. If you want to run the application from the desktop, select the check box just below the 
Destination Folder group box to add an icon.

6. The ASAP 2050 icon is added to the Micromeritics folder by default. If you prefer a 
different folder, enter or select one from the drop-down list.

You may cancel the installation at any time by selecting Exit. If you do so, you must 
start the installation program from the beginning to install the analysis program. 

 

Displays the amount of current
disk space and the amount
required for installation of the
application. Also displays the
directory into which the
application will be installed.

Select this option to add the
ASAP 2050 icon to your desktop
for quick access to the application.
4-2                                                    Jul 07



ASAP 2050 Operator’s Manual Installing the Analysis Program
7. Click Next; the Analyzer Configuration dialog is displayed.

In the Step 1 group box, click the radio button for the number of analyzers to be attached to 
this computer. If you are attaching two analyzers, make sure your computer has two serial 
ports.

8. In the Step 2 group box, enter the analyzer serial number and the communications port to 
which it will be attached for each analyzer.

9. Click Next; the Calibration File Installation dialog is displayed. Read the information in 
the dialog and proceed accordingly.

10. After the calibration files are installed, the Installation Complete dialog containing the 
Readme file is displayed.

11. Use the scroll bar if you want to read the contents of the file, then click Finish to close the 
dialog.

Choose 0 (zero) if you are installing this program for data reduction on a computer 
other than the one controlling the analyzer.

If you selected zero (0) as the number of instruments to install, the Calibration dialog 
is not displayed.
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12. Remove the Setup CD and store in a safe place. The original Setup CD contains the 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you maintain your original Setup CD in a secure location in 
the event calibration files need to be reinstalled.

Using the Setup Program for Other Functions

After initial installation of the ASAP 2050 analysis program, the application setup program 
can be used to:

• Upgrade software
• Add an analyzer
• Move an analyzer from one computer to another computer
• Remove an analyzer from the computer
• Change the analyzer setup
• Reinstall calibration files
• Uninstall the analysis program

To start the application setup program:

1. Ensure that the analysis program is not operating.

2. Insert the CD into the CD-ROM drive.

3. Select Start from the Status bar, then Run from the Start menu.

Enter the drive designator for the CD-ROM drive, followed by setup. For example:

e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.

4. Click OK; the setup Welcome screen showing the options available is displayed.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.
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Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any 
status files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable 
option will display; it will be one of the following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

2. Click Start File Installation; the application installs the software and redisplays the setup 
Welcome dialog. If no other operations are desired using this dialog, click Exit to close the 
dialog.
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Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program. Select Add an analyzer, then click Next; the Setup analyzer 
dialog is displayed.

2. Enter the serial number of the analyzer being added, then the communications port to 
which it is to be connected.

3. Click Next; the Calibration Installation dialog is displayed.

4. Select the location of the calibration source files. If the calibration files are located in a 
directory other than the one displayed, click Browse to select the directory. Click Finish; 
a media change dialog is displayed.

5. Click OK to install the calibration files. A dialog containing the Readme file is displayed 
after the calibration files are installed.

6.  Click Exit to close the dialog.

Moving an Analyzer from one PC to another PC

You can move an analyzer, along with its status and calibration files, from one computer 
(Source PC) to another computer (Destination PC).

This operation does not move sample or parameter files. To move these files, use a 
file management program such as Explorer or a backup/restore utility.
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1. Install the application program on the destination computer. Refer to Installing the 
Analysis Program on page 4-1.

If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup 
Program for Other Functions on page 4-4.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click 
Next; the Move analyzer operation dialog is displayed.

4. Select Source PC, then click Next; the following dialog is displayed.
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5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a diskette drive or a shared network drive. If this is not possible, select a 
local folder. After the files are placed there, use a folder transfer utility (for example, 
Backup and Restore) to copy this folder from the Source PC to the Destination PC.

7. Click Finish; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).

10. Select Destination PC, then click Next; the following dialog is displayed.

11. In the Step 1 group box, enter the serial number of the analyzer being moved.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

13.Click Next; the files are moved and the setup Welcome dialog is displayed.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the 
status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 4-4.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an 
analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
Jul 07                                                  4-9 



Using the Setup Program for Other Functions ASAP 2050 Operator’s Manual
Changing an Analyzer Setup

Change the analyzer setup as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions on 
page 4-4.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change 
analyzer setup dialog is displayed.

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.
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Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data as follows:

1. Start the Setup program. From the Setup dialog, select Re-install calibration files for an 
analyzer, then click Next; the Re-install calibration files dialog is displayed.

2. Select the analyzer whose calibration files you wish to reinstall from the drop-down list. If 
you have only one analyzer installed, a drop-down list is not included.

3. Insert the CD containing the calibration files; ensure that the CD drive is displayed as the 
calibration file source location. If not, click Browse and choose the CD drive.

4. Click Finish; the calibration files are reinstalled and the Welcome dialog is again 
displayed.

5. Click Exit to close the dialog.

Not shown if only 
one analyzer is 
installed.
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Uninstalling the Analysis Program

When you uninstall the ASAP 2050 analysis program, the application removes the analysis 
program, status files, analyzer setup files, and resulting empty directories. It does not remove 
data files. Perform the following steps to uninstall the program:

1. Start the Setup program. From the Setup dialog, select Uninstall, then click Next; the 
Uninstall dialog is displayed.

2. Click Uninstall; the Select Uninstall Method dialog is displayed.
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3. Choose one of the following:

Automatic: click Next; the system uninstalls the analysis program automatically and the 
setup Welcome dialog redisplays.

Custom: click Next; a series of dialogs is displayed, allowing you to choose the files you 
wish to uninstall. After all files are selected and uninstalled, the setup Welcome dialog 
redisplays.

4. Click Exit to close the Welcome dialog.
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5.  FILE MENU

The File menu contains commands which allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu commands. Detailed descriptions follow 
this section.

Open Opens an existing sample information or parameter file. Page 
5-2.

Save Saves the file in the active window. Page 5-81.

Save As Saves the file in the active window as a different name. You 
also can use this option to save a subset of the sample file as a 
parameter file. Page 5-81.

Save All Saves all open files. Page 5-83.

Close Closes the file in the active window. Page 5-83.

Close All Closes all open files. Page 5-83.

Print Prints the contents of a sample or parameter file. Page 5-84.

List Generates a list of certain information for sample or 
parameter files. Page 5-85. 
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Open

Open allows you to create a new file or edit an existing one. The following file types are 
available:

• Sample information
• Sample tube criteria
• Degas conditions
• Analysis conditions
• Adsorptive properties
• Report options

Regardless of which file type you select, a dialog similar to the one shown here is displayed: 

Export Copies the isotherm data in a sample information file and 
exports it in ASCII format. Page 5-86.

Exit Exits the analysis program. Page 5-88.

File name For sample information files, this field contains the next 
sequenced file name (as specified in sample defaults) 
generated by the system. If this is a new file, you can use the 
name displayed or enter a different one. 

For parameter files, the file name displayed includes the wild 
card (*) and a default extension as follows:
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File name
(continued)

*.DEG for degas conditions
*.STB  for sample tube
*.ANC for analysis conditions
*.ADP for adsorptive properties

     *.RPO for report options

If you are creating a new file, enter a name in the File name 
field. You can use up to 8 characters.

If you are opening an existing file, select the name from the 
Files window, then click OK

Date Range Click this push button to display files created within a 
specified range of dates; the Select Dates dialog is displayed.

Refer to Selecting Files, page 2-11 for an explanation of the 
functions on this dialog.

Status Displays for sample information files only. This drop-down 
list allows you to choose the types of sample files to display 
in the Files window. All files of the type you choose, within 
the range of dates, and in the current directory are displayed.
Refer to Table 2-2. File Status and Description, page 2-12 
for a description of the status types.

Directories Displays the current directory. You can navigate to a different 
directory by clicking in the Directories list box or by 
entering the desired directory in the File name field.
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Sample Information

Sample information files can be created and presented in the Advanced, Basic, or Restricted 
format. (Refer to “Sample Information Files” on page 3-1.) 

Advanced Format

The Advanced format displays all parts of the sample file in a tabbed dialog. This format 
allows you to customize your sample file, moving easily among the parameters simply by 
clicking on the tabs; alternatively, you can use Prev and Next. Refer to “Advanced Format” 
on page 3-6 for step-by-step instructions for creating a sample information file using the 
Advanced format.

Sample Contains the description of the current sample file. 
If this is a new file, this field contains the file description 
specified in Sample Defaults (refer to Advanced Format on 
page 8-7). The above dialog shows the sample file number 
because the dollar ($) symbol was included when sample 
defaults were specified.

You can enter a new description or edit the existing one if 
desired.

Maximum number of characters: 50

 

 

These fields can
be edited to 
display a different
label if desired.
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Operator
Submitter

Displays the operator and submitter names of the current 
sample file.

If this is a new file, these fields contain the names specified in 
Sample Defaults.
 
You can enter a different name or edit the current one if 
desired. You can use up to 40 characters.

Either (or both) of these fields can be prevented from 
displaying on this dialog by selecting Omit in Sample 
Defaults. The labels also can be edited in Sample Defaults.

Mass Enter the value recorded for Mass of Sample, After Degas 
from the Sample Data Worksheet.

The value in this field is used in report calculations; 
therefore, it should be exact. To ensure accuracy, reweigh the 
sample after analysis. Enter the post-analysis value if 
different from the After Degas value before generating 
reports.

You should always use the same gas (typically nitrogen) for degassing and analysis. 
If different gases are used, the sample mass after degas and after analysis will not be 
equal. For example; if you use helium to backfill after degassing and nitrogen after 
analysis, you can get as much as a 0.02-gram difference.

Density If you plan to use a calculated free space, enter the sample’s 
density in this field. A value in this field is ignored for 
measured or entered free spaces.

Type of Data Displays the type of data for the current sample file.

If this is a new file, choose whether you wish to have data 
collected automatically or if you plan to enter data collected 
from another source.

Comments Allows you to enter pertinent information about the sample 
or analysis. The information you enter in this window is 
displayed in the report header. You may enter up to 500 
characters in this window.
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Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format, 
you can quickly create a sample information file using predefined parameter files. You can 
also switch to the Advanced format if a specific parameter requires editing. Refer to “Basic 
and Restricted Formats” on page 3-8 for step-by-step instructions for creating a sample 
information file using the Basic format.

Add Log Entry Displays the Add Log Entry dialog, enabling you to enter 
comments to be included in the instrument log.

Replace All Use this push button to replace all parameters of the current 
file with those from an existing one. You can edit the 
parameters after they have been copied into the current file; 
editing the current file does not affect the file from which 
they were copied.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.

Basic Switches the sample editor to the Basic format.
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Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file 
description based on the format specified in Sample Defaults. 
The above dialog shows the sample file number because the 
dollar ($) symbol was included when sample defaults were 
specified.

You can enter a new description or edit the existing one if 
desired.

Maximum number of characters: 50

Mass Allows you to enter the sample mass. If you are using the 
Sample Data worksheet, this is the value recorded for Mass of 
Sample after Degas.
Jul 07                                                   5-7 



Open ASAP 2050 Operator’s Manual
Restricted Format

The Restricted format is used when analysis parameters must remain constant, for example, in 
the pharmaceutical industry where consistency and accuracy are crucial. A password is 
required to enter and exit this format. Refer to Restricted, page 8-3 for additional information 
on the Restricted format.

When you open an existing sample information file or create a new one using the Restricted 
format, all parts of the sample file are displayed in the same manner as the Basic format. Some 
menu functions, however, are disabled and you cannot switch to the Advanced format to edit 
file parameters.

Sample Tube
Degas Conditions
Analysis Conditions
Adsorptive Properties
Report Options

Each parameter field contains the description of the current 
parameter file.

If this is a new sample file, these fields contain the descrip-
tions of the files chosen as the defaults.

Click on the down arrow to the right of each field to choose a 
different file. File parameters can be viewed or edited by 
switching to the Advanced format.

Replace All Use this push button to replace all parameters of the current 
file with those copied from an existing one. A dialog is 
displayed allowing you to choose the desired file.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format, allowing 
you to view or edit parameters of the current file.
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Sample Tube

The fields on this dialog are used for storing sample tube information. Before creating a 
sample tube file, you should perform a blank analysis (no sample) using the sample tube.

Sample Tube Contains the description of the current file.

If this is a new file, this field contains the name (description) 
you specified as the default. You can enter a new description 
or add to the existing one if desired.

Maximum number of characters: 40
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Replace Use this push button to replace the values of the current file 
with those from an existing Sample Tube file. The Open 
Sample Tube dialog is displayed, allowing you to choose a 
file. After the values are copied into the current file, you can 
edit them as desired.

Ambient free space Displays the ambient free space for the current file.

Analysis free space Displays the analysis free space for the current file.

Use isothermal jacket Select this option if an isothermal jacket is to be used in the 
analysis.

Use filler rod Not used.

Vacuum seal type If the sample is to be transferred under vacuum to the analy-
sis port, select the one to be used. If not, leave None selected.

Load From Sample File Click this push button to choose the sample file that was used 
in the blank analysis. The values for the Ambient and Analy-
sis free spaces will be copied into the sample tube file.

Save Saves all parameters of the current dialog.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.
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Degas Conditions

The fields on this dialog are used for specifying degas conditions.

Description Contains the description of the current Degas Conditions file.

If this is a new file, this field contains the name (description) 
you specified as the default. You can enter a new description 
or add to the existing one if desired.

Maximum number of characters: 40

Replace Use this push button to replace the parameters of the current 
file with those from an existing Degas Conditions file. The 
Open Degas Conditions File dialog is displayed, allowing 
you to choose a file. After the values are copied into the 
current file, you can edit them as desired.

Evacuation Phase
group box

The options in this group box allow you to specify conditions 
for the evacuation phase of the degassing operation.

Temperature 
ramp rate

Allows you to specify the rate at which the temperature is to 
change while advancing to the target temperature during 
evacuation.

Target temperature Allows you to specify a temperature at which the sample will 
be held for the remainder of the evacuation.
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Evacuation rate Enables you to specify an evacuation rate for initial 
evacuation.

Unrestricted evac.
from

Enables you to specify a pressure at which unrestricted 
sample evacuation will begin.

Vacuum setpoint Enables you to specify the vacuum level to be achieved 
before evacuation begins.

Evacuation time Enables yo to specify how long the sample is to be evacuated 
prior to the second stage of heating.

Heating Phase
group box

The options in this group box allow you to specify conditions 
for the heating phase of the degassing operation.

Ramp rate Enables you to specify the rate at which the temperature will 
change after evacuation while advancing to the hold 
temperature.

Hold temp Enables you to specify a temperature at which the sample is 
to be held during degassing.

Hold time Enables you to specify how long the sample is to be held at 
the specified temperature before beginning to cool down.

Evacuation and Heating 
Phases

Enables you to specify the hold pressure.

     Hold Pressure If during the temperature ramp the pressure exceeds the value 
you enter in this field, the ramp will be suspended until the 
pressure returns to a safe level.

Backfill Sample Tube Select this option to have the sample tube backfilled. 

Save Saves all parameters of the current dialog.

Close Closes the dialog. If the file contains unsaved changes, you 
are prompted to save before the dialog closes.
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Analysis Conditions

The Analysis Conditions dialog allows you to specify the data used to guide the analysis. You 
can create an Analysis Conditions file as an independent parameter file or include it as part of 
the sample information file.

Refer to “Analysis Conditions” on page 3-11 for step-by-step instructions on creating an 
analysis conditions file.

 

Description Contains the description of the current Analysis Conditions 
file.

If this is a new file, this field contains the name you specified 
as the default. You can enter a new description or add to the 
existing one if desired.

Maximum number of characters: 40

Replace Use this push button to replace the parameters in the current 
file with those from an existing Analysis Conditions file. 
After you choose the file and the values are copied into the 
current file, you can edit them in any way desired. Editing  
the current file will not change anything in the file from 
which they were copied.
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Pressure Table A pressure table is a list of pressure points (with calculation 
assignments) at which data are to be collected. The pressures 
may span the entire range from the lowest relative value of 
0.00000001 to the maximum value of 0.995 P/Po. In 
addition, one saturation point may be entered with relative 
pressure of 1.0. 

Several analysis conditions files containing complete 
pressure tables are included with the ASAP 2050 software 
and can be found in the PARAMS subdirectory. 

The pressure table for automatically collected data includes 
the pressure points for data collection and identifies 
calculations through which the data are processed.

Edit existing values by highlighting the field and entering the 
desired values. Use Insert to add rows for additional values. 
To append to the beginning or to the end of the table, use 
Ctrl + Up Arrow and Ctrl + Down Arrow.

The pressure table must contain one sequence of strictly 
ascending relative pressures, optionally followed by one 
sequence of strictly descending relative pressures. You can 
enter a maximum of one thousand pressure points.

To specify the calculations performed at a given relative 
pressure, click in the field of the desired calculation type; an 
X in the field indicates the calculation is selected.

Click OK to accept all entries in the pressure table and return 
to the Analysis Conditions dialog.
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Insert Range Displays the Insert Pressure Range dialog.

This dialog allows you to specify the starting pressure, the 
ending pressure, the number of points to insert within the 
specified range, and whether you wish to have linear or 
geometric progression.

Linear Inserts evenly spaced points into your table.

Geometric from low 
pressure

Inserts geometrically spaced points from the low pressure 
range. For example, to insert 5 points with a 0.01 starting 
pressure and a 0.16 ending pressure, the following points are 
inserted into the table:

0.01
0.02
0.04
0.08
0.16

Geometric from 
saturation

Inserts geometrically spaced points from the saturation 
pressure. For example, to insert 5 points with a 0.99 starting 
pressure and a 0.84 ending pressure, the following points are 
inserted into the table:

0.99
0.98
0.96
0.92
0.84
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Insert predefined Displays the Insert Predefined Pressures dialog.

Choose predefined pressure points for surface area, t-Plot, 
and/or BJH adsorption/desorption.

Click on the down arrow for each field to choose the desired 
set of points. You can also specify Adsorption/ Desorption 
total pore volume and Saturation.

Insert Inserts a row into the table above the selected line.

Delete Deletes the selected row.

Clear Removes all but one required entry from the table. The rows 
do not have to be selected. A warning message appears 
requesting confirmation before the table is cleared.

Absolute pressure
dosing

Select this option to specify pressure targets in mmHg, mbar, 
or kPa instead of relative pressure. This option is typically 
selected when using adsorptives at analysis conditions above 
the critical point of the gas; for example, H2 adsorption on 
carbon at liquid nitrogen temperature.
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Use calculation 
assignments

Select this option to assign the points to be collected for each 
type of report.

If this option is not selected, each report (with the exception 
of Langmuir and BET) uses a range of pressures as selected 
in the report options. The Langmuir and BET reports 
interpolate to entered relative pressures on the report options.

The outlier points can be selected so that they will not be 
reported.

Preparation Displays the Analysis Preparation dialog.

Fast evacuation Select this option for samples (such as pellets) that do not 
fluidize or shed particles during evacuation.

Unrestricted evac.
      from

Enabled when Fast evacuation is not desired. This field 
allows you to enter the pressure at which unrestricted sample 
evacuation is to begin.

Vacuum setpoint Allows you to specify the vacuum level to be achieved before 
evacuation begins.

Evacuation time Enables you to enter the length of time for preliminary 
evacuation, which takes place prior to the free-space 
measurement. 
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Leak test Enables the system to check for leaks or sample outgassing 
before the analysis. The leak test allows sample pressure to 
rise during the test. If the pressure rises more than 0.15 
mmHg, the analysis does not proceed and you are notified. 
While leak testing slightly increases analysis time, it prevents 
the continuation of analysis and collection of erroneous data 
if a leak exists.

Leak test duration Enables you to specify how long the pressure is to be 
monitored.

Use TranSeal Not used.

Free Space Allows you to specify free-space measurement conditions; 
the Free Space dialog is displayed.
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Measure Select this option to have free space measured automatically 
by the system. 

Typically, it is best to measure the free space when analyzing 
macro- and mesoporous samples, and for routine surface area 
measurements. 

Select Lower dewar for evacuation to lower the dewar 
following free-space measurements. 

Evacuation time enables you to specify how long evacuation 
is to take place following the measured free space.

Select Outgas test to check for system leaks or sample 
outgassing. After free space is measured, the Dewar is 
lowered and the sample evacuated for 30 minutes. The leak 
test is performed after evacuation. If a leak is found, the leak 
test repeats nine times, with 30 minutes evacuation between 
tests. If the 10th leak check fails, the analysis stops and you 
are notified. While leak testing slightly increases analysis 
time, it prevents the continuation of analysis and collection of 
erroneous data if a leak occurs.

Outgas test duration indicates the number of seconds the 
leak test is performed.

Enter Select this option to enter values for the ambient and analysis 
free spaces. You may need to use this option if the sample 
retains helium and measurement of very low micron range 
pressures are required.

If you change the entered free-space value after the preliminary analysis stage is 50% 
complete, the change does not affect the analysis.

Ambient free space is the sample tube gas capacity measured 
at room temperature.

Analysis free space is the sample tube gas capacity measured 
with the Dewar raised.
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Calculate Select this option to have the free-space calculated using the 
mass, density, and sample tube parameters entered in the 
Sample Information and Sample Tube files. Calculated free 
space measurement takes less time than measured free 
space, so if you know the mass and density of the sample 
and the sample tube parameters, you may wish to use this 
choice of free space methods. If you do not know the 
parameters, you may wish to use measured free space.

Po and T Displays the Po and Temperature Options dialog, allowing 
you to enter the ambient temperature and choose saturation 
pressure and analysis bath temperature.

This dialog provides six options for obtaining the saturation 
pressure (Po) and analysis bath temperature. Clicking on each 
option prompts you for the entry of related parameters in the 
lower portion of the dialog. 

Option Prompts for...
1 a measurement interval (how often during 

analysis the Po is to be measured)

Recommended for N2, Ar
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Option Prompts for...
2 a measurement interval and the analysis 

bath temperature

3 a Po; the analysis bath temperature is 
calculated at the time of analysis

Saves time; useful for BET with N2.

4 a Po and analysis bath temperature

an analysis bath temperature only (when 
Absolute pressure dosing is selected on 
the Analysis conditions dialog)

Saves time; useful for BET with N2.

5 a psat gas other than the adsorptive; the 
temperature and pressure ranges for the 
chosen gas are displayed. Click Psat vs.T to 
edit the values if desired. Editing the values 
in the current table do not affect the ones of 
the original table.

May help save time.
6 an analysis bath temperature

May help save time.
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Dosing Displays the Dosing Options dialog.

First Pressure Fixed 
Dose

The most frequent use of this option is when you are 
performing a standard nitrogen analysis of mesoporous 
materials such as catalysts. If the first pressure table point is 
low and you expect the gas uptake of the sample to be high, 
this option can shorten the time required to reach the first 
point on the pressure table.

The sample is dosed repeatedly at low pressures with a 
specified amount of gas until the first pressure point is 
reached. This initial dosing quickly meets the adsorptive 
demand of the sample.

The first point on the pressure table is the threshold value, 
triggering the transition from the Fixed Dose Mode to 
Pressure Table Mode. When the first pressure table value is 
reached, Fixed Dose Mode is disabled, and points are 
equilibrated and recorded in accordance with the specified 
pressure table. 

In the field adjacent to this option, enter the amount of gas 
that is to be added to the sample for each dose cycle. 
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Maximum volume 
increment

Select this option to determine when additional data points 
are collected between target pressures in regions of 
adsorption. When the maximum increment has been adsorbed 
since the last collected data point, another point is 
equilibrated and collected.

During desorption, this field is treated as a maximum volume 
“decrement” value.

Absolute and Relative 
pressure tolerance

The values entered in these fields are used to determine how 
close the actual pressure must be to each target pressure from 
the pressure table. At lower pressures the relative tolerance 
value is smaller, and at higher pressures the absolute 
tolerance value is smaller. The lesser (or more stringent) of 
these two criteria are used to determine the tolerance.

For example, with relative tolerance = 5% and absolute 
tolerance = 5 mmHg, the relative tolerance at 40 mmHg 
target pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is 
smaller than the absolute tolerance of 5 mmHg, so 2 mmHg is 
used. At 200 mmHg target pressure, the relative tolerance is 
5% of 200 mmHg, or 10 mmHg; in this case, the absolute 
tolerance of 5 mmHg is smaller and is used.

In the above example, a minimum pressure of 40 - 2 = 38 
mmHg must be attained to collect data for a target pressure of 
40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 mmHg 
must be attained.

Normally, surface area measurement points are widely 
spaced, and the resulting measurement is not very sensitive to 
the precise location of points so wider tolerances may be 
used. Unnecessarily tight tolerances lengthen the analysis.
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Equilibration Displays the Equilibration dialog.

Equilibration 
interval

The number of seconds between successive pressure readings 
during equilibration. Long equilibration intervals tend to 
lengthen analyses, however, they do improve data integrity. 
Short equilibration intervals produce a faster analysis but 
may reduce the accuracy of data.

Minimum 
equilibration delay 
at P/Po> = 0.995

The value entered in this field determines the minimum 
number of seconds required before equilibration can occur 
for a relative pressure greater than or equal to 0.995.

This field does not display if you select Absolute pressure 
dosing on the analysis conditions dialog.

Backfill Displays the Sample Backfill Options dialog, allowing you to 
select options for backfilling the sample tube at the start and 
end of an analysis.

The options on this dialog are not available if the file status 
displayed in the Open Sample Information File dialog is 
Entered, Complete, or Analyzing.

Does not 
display when 
Absolute 
dosing is 
selected.
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Adsorptive Properties

This dialog allows you to specify the characteristics of the gases used in the ASAP 2050 
system. An Adsorptive Properties file can be created as an independent parameter file or 
included as part of the sample information file.

Refer to “Adsorptive Properties” on page 3-12 for step-by-step instructions on creating 
adsorptive properties files.

     Backfill sample at 
     start of analysis

Backfills the sample tube at the beginning of the analysis 
with the specified backfill gas.

Backfill sample at 
end of analysis

Backfills the sample tube at the end of the analysis with the 
specified backfill gas. If the sample mass is determined after 
the analysis, it is best to use nitrogen as the backfill gas.

It is recommended that you backfill the sample tube at the start and at the end of 
the analysis. If you deselect either backfill option, proceed with caution as damage 
to the analyzer or sample tube may occur.

Backfill Gas Lists the available backfill gases. The gases in this list are 
the ones for which Adsorptive Properties files have been 
created; helium is also included.
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Adsorptive If this is a new file, this field contains either the name of the 
default adsorptive gas or is blank. Enter the name of the 
desired adsorptive gas.

Maximum number of characters:   40 alphanumeric

Replace Click this push button to choose an Adsorptive Properties file 
containing parameters you wish to copy and use in the 
current file. After the values have been copied into the file, 
you can edit them as desired. It does not affect the values of 
the file from which they were copied.

Mnemonic The mnemonic for the adsorptive gas. 

Maximum number of characters: 3 alphanumeric

Non-condensity 
Adsorptive

Select this option if this file is for a non-condensing gas 
(adsorptive). When you select this option, the Density 
conversion factor field and the Psat vs. T push button 
become disabled.

Maximum manifold 
pressure

The maximum gas pressure allowed in the manifold.

Density conversion 
factor

This value is used to convert the gas volume at STP to liquid 
volume for the adsorptive. It is the ratio of gas density at STP 
to liquid density.

Therm. tran. hard-sphere 
diameter

The thermal transpiration hard-sphere diameter.

Molecular cross-sectional 
area

The molecular cross-sectional area.

Dosing Method Select the manner in which the sample tube is dosed. Normal 
applies to gases under pressure and is used for standard 2050 
analyses. 
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Compressibility Factor Table Compressibility factors compensate for the forces of attrac-
tion between molecules in a real gas. Each gas compatible 
with the ASAP 2050 analyzer has a compressibility factor 
table. To select the table, click Open. The Open Compress-
ibility Factor Table dialog is displayed. 

Click the file containing the mnemonic for the type of gas to 
be used for analysis. For example, select zar.dat for Argon.

Then click OK to close the dialog.

If you would like to save the compressibility factor table con-
tained in a sample file, click the Save button located next to 
the Open button.

Enter a name in the File name field (make sure you use the 
.DAT extension), the click OK.
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Psat vs. T Click to view or edit the Psat vs. Temperature table for the 
adsorptive gas; this example shows Nitrogen.

This table contains saturation pressures and their correspond-
ing temperatures. As many as 10 entries may be included; at 
least two entries are required. 

You can edit the table by clicking on the desired saturation 
pressure or temperature and entering a different value. 

Use Insert to insert a new row above the selected line; the 
cursor moves to the new line. Use Delete to delete the 
selected row.
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Report Options

This dialog allows you to specify report options. A report options file can be created as an 
independent parameter file or included as part of the sample information file.

Refer to “Report Options” on page 3-13 for instructions on creating report options files.

Description Displays a description of the current Report Options file. 

If this is a new file, this field contains the description you 
specified as the default. You can enter a new description or 
add to the existing one if desired.

Maximum number of characters:    40

Replace Click this push button to choose an existing Report Options 
file containing parameters you wish to copy and use in the 
current file. After the values have been copied into the file, 
you can edit them as desired. It does not affect the values of 
the file from which they were copied.
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Show report title This option allows you to enter a title for your report.

If this is a new file, the title you specified as the default is 
displayed. Accept the default title or enter a different one.

Deselect this option to omit the report title. 

Range: 40 characters

Show graphic Select this option to have a graphic display above the report 
title. 

The graphic can be in a bitmap (bmp) or an enhanced 
metafile (emf) format. For example, you may wish to display 
your company logo. 

Click Browse to choose the graphic, then use the height and 
width fields to specify the size. The image can also be edited 
from the report window.

Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files containing the data you wish to 
overlay onto a selected plot.

Click Browse to the right of the sample number field to 
choose the desired file. Use Clear to clear a field of its entry. 
You can select up to eight files. 

After choosing the desired files, select the Overlay samples 
option for each report type you plan to overlay.
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Edit Allows you to edit parameters of the selected report. This 
push button is disabled for the Options report.

Apply thermal transpiration 
correction

Select this option to correct for the temperature-induced 
pressure difference between the manifold and the chilled 
sample tube. This option is most significant for pressures less 
than approximately 1.0 mmHg. 

Use this option when a cryogen liquid nitrogen or liquid 
Argon is used to control the bath temperature.

Inside diameter of 
sample tube

Enabled when you select Apply Thermal transpiration 
correction, so that you may enter the inside diameter of the 
sample tube.

Selected Reports Contains a list of available reports. Choose reports by double-
clicking on the desired report(s). Alternatively, you can 
highlight the desired report and press the Spacebar. A report 
is selected when it is preceded with a check mark. You may 
deselect reports in the same manner. 

The following reports are available:

• Isotherm
• BET Surface Area
• Langmuir Surface Area
• Freundlich
• Temkin 
• t-Plot
• Alpha-S Method
• f-Ratio Method
• BJH Adsorption 
• BJH Desorption
• DFT Pore Size
• DFT Surface Energy
• Dubinin
• Options
• Summary
• Sample Log
Jul 07                                                   5-31 



Open ASAP 2050 Operator’s Manual
Isotherm Report Options

The isotherm report indicates adsorption (up to saturation pressure) and desorption (down 
from saturation pressure) of a gas by a solid held at constant temperature. 

Select Reports Lists the types of reports offered. 

Choices: Tabular Report, Linear plot, Logarithmic plot,
 Linear Absolute plot, Logarithmic Absolute plot

Pressure Composition plot

When you select Pressure Composition plot, the Adsorbate 
Molecular Weight field is enabled so that you can enter a 
value for the adsorbate. This plot is useful for plotting 
pressure as a function of Weight % adsorbed; for example, H2 
adsorbed on carbon.
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Options Displays the related Plot Options dialog; this example shows 
the dialog for the Linear plot.

All plot dialogs contain the same options.

You can plot the graphs as a curve, points, or both.

Select Overlay samples to overlay data from the current plot 
with data from other samples. The other sample files are 
selected by clicking Overlays on the Report Options dialog.

Autoscale options enable you to have the X- and/or Y-axes 
automatically scaled. 

Linear X-axes begin at zero, and logarithmic X-axes begin at 
an appropriate value. Y-axes begin at zero. The system uses 
the highest values collected during analysis as the ending 
points for axes ranges. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to specify a range. Data collected 
outside these ranges are not included in the plot.

The value entered in the To field must be greater than the 
value entered in the From field.

The X-axis fields show the relative pressure. The Y-axis 
fields show the quantity of gas adsorbed

Tabular Options Enables you to have Run Time and/or Time Between Points 
reported. Run time reports the time elapsed from the 
beginning of the analysis to the finish. Time between points 
reports the time relapsed between each point.

Also enables you to report Weight % when plotting pressure 
composition.
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Plot Options Enables you to choose the type of isotherm you wish to plot.
You can plot the adsorption and/or the desorption isotherm.

Volume Adsorbed Enables you to choose the manner in which the volume 
adsorbed is reported. These data are reported by default as 
Per Gram (cm3/g). However, you can choose to report data 
Per BET Surface Area (cm3/m2) or Per Other Surface 
Area (m2/g). If the latter field is selected, a field is enabled 
allowing you to enter a value.

Weight The Adsorbate Molecular Weight field is enabled when you 
choose Pressure Composition plot, allowing you to enter the 
molecular weight of the adsorbate.

This weight appears on tabular reports.
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BET/Langmuir Surface Area Report Options

• The BET calculation obtains the sample surface area value by determining the monolayer 
volume of adsorbed gas from the isotherm data.

• The Langmuir calculation determines the surface area of a sample by relating the surface 
area to the volume of gas adsorbed as a monolayer. 

Displays as Langmuir
Surface Area Report Options
if the Langmuir report is being 
edited.

The Langmuir and BET Surface Area dialogs include the same fields; the operating 
instructions for both are the same.

Tabular report Select this option to have a tabular report of the plotted data.

BET transform plot Generates a traditional BET (Langmuir) surface area plot that 
is used to determine monolayer volume and BET C constant.

BET Isotherm plot Uses the BET (Langmuir) monolayer volume and constant to 
calculate an isotherm.

Overlay samples Allows you to overlay data of the selected type from the 
current plot with data from other samples. The other samples 
are selected by clicking Overlays on the main Report Options 
screen.
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Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. If you 
choose not to autoscale data, the From and To fields are 
enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. The values entered 
in the To field must be greater than the value entered in the 
From field. 

The X-Axis Range fields show the relative pressure. 

The Y-Axis Range fields show the quantity of gas adsorbed.

Pressures Displays the Report Pressure Table dialog so that you may 
edit or enter relative pressure points.

If Use calculation assignments is not selected on the 
Collected/Entered dialog, the isotherm is interpolated to these 
pressure points, and those interpolated values are used in the 
BET calculations.

If Use calculation assignments is selected, the collected data 
are used.
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Freundlich Isotherm

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure 
adsorption data. 

Insert predefined Displays the Surface Area Report Pressure Selection dialog, 
allowing you to select predefined points. 

Choices:  1 Point, 3 Point, 5 Point, 5 Point Low Pressure

Insert Inserts a row into the table above the selected line.

Delete Deletes the selected row.

Clear Removes all but one entry from the table; one entry is 
required. The rows do not have to be selected. 

A warning message requesting confirmation is displayed 
before the table is cleared.

Specify monolayer 
capacity

In this field, enter the monolayer capacity of the sample.
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Absolute pressure range Allows you to enter a pressure range when calculation 
assignments are not requested.   

Tabular report Select this option to have a tabular report of the pressure 
points generated.

Transform plot Plots the log(p) vs log(Q) in a straight line.

Isotherm plot Plots the absolute pressure vs quantity adsorbed. Shows best 
fit line.

Overlay samples Choose this option to overlay Freundlich isotherm data from 
the current file with the same type of data from other samples 
(files). The desired files are chosen by clicking Overlays on 
the Report Options dialog.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axis scaled 
automatically. 

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points.
If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

The X-axis shows the log of absolute pressure and the Y-axis 
shows the quantity of gas adsorbed.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 
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Temkin Isotherm

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops 
linearly with increasing coverage.

Specify monolayer 
capacity

In this field, enter the monolayer capacity of the sample.

Specify differential 
heat of adsorption at
zero surface coverage

Enter the differential heat of adsorption at zero surface 
coverage. This allows inclusion of all of Temkin constants.

Absolute pressure 
range

Allows you to enter a pressure range when calculation 
assignments are not requested. 

Tabular report Select this option to have a tabular report of the pressure 
points generated

Transform plot Plots a linear form of the Temkin isotherm.
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Temkin Isotherm plot Overlays the Temkin isotherm with the analysis data. 

Overlay samples Choose this option to overlay Temkin isotherm data from the 
current file with the same type of data from other samples 
(files). The desired files are chosen by selecting Overlays on 
the Report Options dialog.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axis scaled 
automatically. 

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

The X-axis shows the natural log of absolute pressure and the 
Y-axis shows the quantity of gas adsorbed.

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 
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t-Plot Report Options

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to 
micropores. Matrix area, the area external to micropores, is directly determined and often 
proves to be a valuable way of characterizing complex mixed materials.

Thickness Curve Presents the type of thickness curves available. 

• Reference
• Kruk-Jaroniec-Sayari
• Halsey
• Harkins and Jura
• Broekhoff-de Boer
• Carbon Black STSA

You can also apply the Frenkel-Halsey-Hill thickness curve 
using the Halsey option, and entering the appropriate values 
in the equation. Use Edit to edit the values in the equation. 

Edit Displays the equation for the type of thickness curve selected 
so that you may view or edit the values.
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Reference Displays the Entered t-Curve dialog allowing you to define a 
t-curve by entering the relative pressure and thickness values. 

This table can also be created in another application if desired 
and imported into this dialog using Open. When creating the 
table in another application, the file must be saved as ASCII 
text with a .THK extension. Use a two-column format with 
the relative pressures in the first column and the thickness 
values in the second column. Columns must be separated by a 
space (or a tab).

Insert
Inserts a row above the selected row. A row cannot be 
inserted if the value in the selected row is at its lowest value; 
values must be strictly increasing. For example, in the table 
shown above the default value is 0.000000001. Therefore, 
you must use Ctrl + Down Arrow to insert rows.

Delete
Deletes the selected row.

Clear
Clears the table of all but one entry; one entry is required.

Open
Enables you to import the values from an existing t-curve.

Save As
Enables you to save the current table of values under a 
different name.
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Kruk-Jaroniec-Sayari Displays the Kruk-Jaroniec-Sayari Thickness Equation 
dialog.

You can edit the values for the numerator, the first element of 
the denominator, and the exponent. The range for a selected 
field is shown in the information bar at the bottom of the 
dialog.

Refer to Appendix C, Calculations, for more information.

Halsey Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and 
exponent. The range for a selected field is shown in the 
information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Harkins and Jura Displays the Harkins and Jura Thickness Equation dialog.

You can edit the values for the numerator, first element of the 
denominator, and exponent. The range for a selected field is 
shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.
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Broekhoff-de Boer Displays the Broekhoff-de Boer Thickness Equation dialog. 

You can edit the values for the multiplier, numerator, and 
exponent. The range for a selected field is shown in the 
information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Carbon Black STSA Displays the STSA Thickness Equation dialog.

All coefficients can be edited. The range for a selected field is 
shown in the information bar at the bottom of the dialog.

Refer to Appendix C for more information.

Surface Area group box Allows you to choose the surface area value used for 
thickness calculations. You can use BET (most commonly 
used), Langmuir, or enter one of preference.
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Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report. 

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

Surface area correction 
factor

This value corrects for surface areas that are not smooth and 
brings the values for BET surface area into accordance. For 
most samples, the default value of 1.000 is adequate

Fitted Thickness Range Provides two fields, allowing you to enter the minimum and 
maximum thicknesses you wish to include in the thickness 
curve.

Tabular report Select this option to generate a table of collected data.

t-Plot Select this option to generate a graphical representation of the 
collected data.

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen. 
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Alpha-S Plot

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm 
using the quantity adsorbed at a relative pressure of 0.4.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the 
plot. 

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.
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Table Provides two columns for entering the relative pressure (first 
column) and the alpha-s values (second column). 

This table can also be created in another application if desired 
and imported into this dialog using Open. When creating the 
table in another application, the file must be saved as ASCII 
text with an ALS extension. Use a two-column format with 
the relative pressures in the first column and the alpha-s 
values in the second column. Columns must be separated by a 
space (or a tab). 

Insert Inserts a row above the selected row. A row cannot be 
inserted if the value in the selected row is at its lowest value; 
values must be strictly increasing. For example, in the table 
shown above, the default value is 0.000000001. Therefore 
you must use Ctrl + Down Arrow to insert rows.

Delete Deletes the selected row.

Clear Clears the table of all but one entry; one entry is required.

Open Allows you to import the values from an existing alpha-s 
curve (ALS) into the table. One predefined curve is shipped 
with the analysis program. After the values are copied into 
the table, you may edit them if desired. Editing these values 
will not affect the file from which they were copied.

Save As Enables you to save the current table of values under a file 
name.

Fitted Alpha-S range Provides two fields for entering the minimum and maximum 
relative pressures from which the fit will be determined.

Relative pressure range Provides two fields for entering a pressure range when 
calculation assignments are not used.

Tabular report Select this option to generate collected data in a tabular 
manner.
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Alpha-S plot Select this option to generate collected data graphically.

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis.

Data collected outside these ranges are not included in the 
plot. 

The X-Axis Range fields show the relative pressure.

The Y-Axis Range fields show the quantity of gas adsorbed.
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f-Ratio Plot

The f-Ratio report allows you to take the measured isotherm and normalize it using a reference 
isotherm.

Reference Isotherm Displays the sample file you choose as a reference. You 
should always choose a file containing an isotherm measured 
from a non-porous sample of the same material as the current 
sample.

Browse Click to choose the sample file you wish to use as a reference 
for the isotherm. 

Relative pressure range Allows you to enter a pressure range when calculations 
assignments are not used. 

Tabular report Choose this option to have a tabular report generated The 
tabular report contains four columns: relative pressure, 
quantity adsorbed for the isotherm of interest, quantity 
adsorbed for the reference isotherm, and the ratio of the 
quantities adsorbed.

f-Plot Choose this option to have the data plotted as a graph.
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BJH Adsorption/Desorption Report Options

Overlay samples Allows you to overlay data from the current sample file with 
data from other sample file(s). The other sample file(s) are 
chosen by clicking Overlays on the main Report Options 
screen.

Autoscale x-axis 
Autoscale y-axis

Select these options to have the X- and/or Y-axes scaled 
automatically.

Both X- and Y-axes begin at zero; the system uses the highest 
values collected during analysis as the ending points. 

If you choose not to autoscale data, the From and To fields 
are enabled, allowing you to enter the ranges.

From/To fields Enabled when you choose not to autoscale data (deselect the 
Autoscale option), allowing you to specify the beginning and 
ending ranges of the X- and/or Y-axis. Data collected outside 
these ranges are not included in the plot. 

This field does not display on the 
BJH Desorption dialog

   

The BJH Adsorption and Desorption dialogs include the same fields; the operating 
instructions for both are the same.
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The BJH calculation determines the mesopore volume/area distribution which accounts for 
both the change in adsorbate layer thickness and the liquid condensed in pore cores. You can 
generate BJH reports from adsorption and desorption data.

Thickness Curve Type Presents the type of thickness curves available. 

• Reference
• Kruk-Jaroniec-Sayari
• Halsey
• Harkins-Jura
• Broekhoff-de Boer
• Carbon Black STSA (ASTM D-6556-0lA)

You can also apply the Frenkel-Halsey-Hill thickness curve 
using the Halsey option, and entering the appropriate values 
in the equation. Use Edit to edit the values in the equation. 
Halsey is the default thickness curve and typically is used for 
BJH calculations.

If you select a thickness curve which is not a good match for the sample being 
analyzed, an incomplete pore distribution may be generated.

Edit Displays the equation for the type of thickness curve 
selected.

Refer to t-Plot Report Options, page 5-41 for information 
on the equations for thickness curves.

Minimum/Maximum BJH Provides fields for entering the minimum and maximum 
size pore to be included in BJH reports. 

The size can be reported in width (default), radius, or 
diameter. Select Options > Units to specify the desired unit.

Fraction of pores open 
at both ends

(not displayed on desorption 
dialog)

During calculations, the software assumes that all pores are 
closed at one end. Sometimes a percentage of pores may be 
open at both ends, causing disagreement in the adsorption 
and desorption data or in the values for total volume and 
total BJH pore volume. Enter a value in this field to 
compensate for this error.

This field does not display on the BJH Desorption Report 
Options dialog.
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Due to normal hysteresis, data may disagree even after applying this corrective factor.

Adsorptive Displays the BJH Adsorptive Options dialog, allowing you 
to specify up to ten adsorptive/adsorbate property factor 
combinations.

The recommended adsorptives and their values are shown. 
You may specify up to six additional adsorptive/adsorbate 
property factor combinations.

The adsorbate property factor is the combination of con-
stants in the numerator of the BJH equation which is 
specific to the type of gas used. Adsorbate property factors 
may be specified in angstroms or nanometers. Select 
Options > Data Presentation > Units to specify desired 
units.

Smooth differentials Smooths all of the differential calculations, eliminating 
variations in the differential computation caused by noise in 
the input data.
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Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

BJH Correction Enables you to choose the type of correction to apply to 
calculations. The type you choose will be displayed in the 
report header.

Standard Uses original BJH models.

Kruk-Jaroniec-Sayari Good for reference thickness curves.

Faas Good for statistical thickness curves.

Selected Reports Lists the available BJH reports.

• Tabular Report 
• Cumulative Pore Volume
• dV/d* Pore Volume
• dV/dlog(*) Pore Volume
• Cumulative Pore Area
• dA/d* Pore Area
• dA/dlog(*) Pore Area

* = width, radius, or diameter

Choose a report by double-clicking on the report name or 
click the report name and press Spacebar. A report is 
selected when it is preceded with a check mark.

Edit Displays an associated dialog for the selected report. 
Editing options for available reports are shown in 
subsequent sections. 
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Tabular Report

The BJH Adsorption/Desorption tabular report allows you to specify the method of data 
reduction.

You can measure pore width (W), pore radius (R), or pore diameter (D) for BJH reports. 
Select Options > Units to specify desired measurement.

You can measure pore width, diameter, or radius; pore size can be expressed in 
angstroms or nanometers. Select Options > Units to specify desired units.

Fixed pore size table Select this option to specify exact pore sizes for which 
volume or area data are reported. Only the pore sizes within 
the specified range appear on the report. Click Table to enter 
(or edit) a fixed pore size table.

Collected points Select this option to include the values collected by the 
system in the report calculations. 
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Columns Displays the BJH Adsorption (or Desorption) Tabular Report 
column Options dialog, allowing you to select up to six 
columns of data for the tabular report.

The default column title appears next to the column number. 
Each column includes a pull-down list of the data types to 
include in the report; the pore width, radius, or diameter can 
be measured (select Options > Units to choose the desired 
unit).

Table Enabled when Fixed pore size table is selected for tabular 
data. Displays the BJH Adsorption (or Desorption) Fixed 
Pore Size Table dialog, allowing you to enter or edit a fixed 
pore size table.

The table must contain a minimum of two points and may 
include as many as one thousand. Points must be strictly 
decreasing.
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Plot Options

Selecting a BJH plot option from the BJH Adsorption or Desorption Report Options dialog 
enables you to specify the plotting method used for your report and to customize the plot. 

When you edit a BJH Adsorption or Desorption plot, a dialog similar to the following is 
displayed. 

Insert
Inserts a row into the pressure table. The row is inserted 
above the selected row and the cursor moves to the new row.

Delete
Deletes the selected row from the pressure table.

Clear
Removes all entries (except the two required ones) from the 
table. A warning message requests confirmation before the 
table is cleared.

You can measure pore width, diameter, or radius; pore size can be expressed in 
angstroms or nanometers. Select Options > Units to specify desired units.

Plot Options Allows you to have data plotted as a curve, points, or both.

X-Axis Lists the scale options for the x-axis
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Linear/Logarithmic Choose whether you wish to have the X-axis on a logarithmic 
or linear scale. Unless you are performing micropore analy-
ses, use the logarithmic option.

Autoscale Choose this option to have the x-axis scaled automatically. 
Linear X-axes begin at zero, and logarithmic X-axes begin at 
an appropriate value. The system uses the highest values col-
lected during analysis as the ending points. 

If you deselect this option, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside the specified ranges are not included in 
the plot.

X-axis range fields show pore radius or diameter in ang-
stroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

Y-axis Lists the options for the Y-axis.

Variable Click on the down-arrow to choose a variable for the Y-axis.

Overlay Displays a list of overlay choices. You can choose a different 
type of plot to overlay with the current plot. Or, you can 
choose Samples to overlay the current type of plot with the 
same type from other sample files. If you choose Samples, 
you select the other files using Overlays on the Report 
Options dialog. 

Autoscale Choose this option to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest values 
collected during analysis as the ending points. 

If you deselect this option, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside the specified ranges are not included in 
the plot.

Y-axis range fields show the quantity of gas adsorbed.
Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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Horvath-Kawazoe Report Options

Pore Geometry Select the option in this group box which best represents the 
physical geometry of the micropores in the sample material. 
Refer to Appendix C for additional information on 
calculations used for these parameters.

Apply Cheng/Yang 
correction

Allows you to apply the Cheng/Yang correction to the pore 
size analysis. This correction substitutes the Langmuir 
equation of state for Henry’s Law in the Horvath-Kawazoe 
derivation (see Appendix C).

Smooth differentials Smooths the differential calculations, eliminating variations 
in the differential computation caused by noise in the input 
data.

Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.
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Interaction Parameter Select one of the options in this group box to determine 
which interaction parameter is used during report generation.

Computed The interaction parameter is calculated using the parameters 
on the Horvath-Kawazoe Physical Properties dialog. You can 
click Properties to view or edit these parameters. Each time 
you change one of the parameters, the interaction parameter 
is recalculated. The formula for computing the interaction 
parameter is given in 
Appendix C. 

Entered The value you enter in the adjacent field will be used.

Properties Use this push button to view or edit the constants (used 
during report generation) describing the physical properties 
of the adsorbent and adsorptive; the Horvath-Kawazoe 
Physical Properties dialog is displayed.
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Adsorbent Group Box Contains the parameters for the sample. If you select 
Computed for the interaction parameter, all fields are 
enabled and can be edited if desired. If you select Entered, 
only the values in the Diameter and Diameter at zero 
energy fields may be edited.

Description
The name of the adsorbent used in the analysis. 

Click on the down arrow to make a new selection. Each time 
you change the selection, the values for that adsorbent are 
displayed in the appropriate fields.

Diameter
The diameter of the sample atom.

Diameter at zero energy
The diameter of an atom at zero interaction energy,
(2/5)1/6 x diameter.

Polarizability
The polarizability of the adsorbent.

Magnetic susceptibility
The magnetic susceptibility of the adsorbent.

Density
The density per unit area of the adsorbent.

Adsorptive Group Box Contains the parameters for the adsorptives (provided with 
the software and/or user-defined). If you select Computed 
for the interaction parameter, all fields are enabled and can be 
edited if desired. If you select Entered, only the values in the 
Diameter and Diameter at zero energy fields may be 
edited.

Mnemonic
The mnemonic name of the adsorptive gas in use. 

Click on the down arrow to make a new selection. Each time 
you change the selection, the values for that adsorptive 
display in the appropriate fields. If no parameters have been 
defined, the default values are displayed.

Diameter
The diameter of the adsorptive atom.
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Tabular Report Options

Displays the Horvath-Kawazoe Tabular Report Column Options dialog so that you can select 
the type of data to display in each column.

The default column title displays next to the column number. Each column includes a drop-
down list of the types of data to include in the report.

Adsorptive Group Box
(continued)

Diameter at zero energy
The diameter of an atom at zero interaction energy,
(2/5)1/6 x diameter.

Polarizability
The polarizability of the adsorptive.

Magnetic susceptibility
The magnetic susceptibility of the adsorptive.

Density
The density per unit area of the adsorptive.

Selected Reports Lists the available Horvath-Kawazoe reports. Choose a report 
by double-clicking on the report name or highlight the report 
name and press the Spacebar. A report is selected when it is 
preceded with a check mark.
The following reports are available:

• Tabular Report
• Cumulative Pore Volume
• dV/dw Pore Volume

Edit Allows you to edit the selected report.
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Plot Options

Selecting a Horvath-Kawazoe plot option from the Horvath-Kawazoe Report Options dialog 
enables you to specify the plotting method used for your report and to customize the plot. Plots 
for Cumulative Pore Volume and dV/dw Pore Volume are available.

When you select either of these plots from the Horvath-Kawazoe Report Options dialog, a 
dialog like the following is displayed. 

Plot Options Lists the data presentation styles available; you must choose 
to plot a curve, points, or both.

X-axis options Choose Autoscale to have the x-axis scaled automatically. 
The X-axis begins at zero and the system uses the highest 
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in 
angstroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
5-62                                                    Jul 07



ASAP 2050 Operator’s Manual Open
Y-axis options Click on the down-arrow at the Variable field to choose a 
variable for the Y-axis.

Click on the down-arrow at the Overlay field to overlay the 
plot with data from other samples.
 
Choose Autoscale to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest value 
collected during analysis as the ending point.

If you deselect Autoscale, the corresponding fields are 
enabled so that you may enter a beginning and ending value. 
Data collected outside these ranges are not included in the 
plot.

Y-axis range fields show the quantity of gas adsorbed
Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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DFT Pore Size

Type Drop-down list containing the types of models available; 
DFT or Classical.

DFT models are based on the density functional theory. 
Classical models are based on the Kelvin equation and 
thickness for determining the pore size distribution. Refer to 
Appendix F for a discussion on models.

Geometry Drop-down list containing pore shapes available; Slit or 
Cylinder.

Models Lists the models that meet the criteria specified and which 
match the adsorbate and temperature of the sample data.

The models display in alphabetical order with the first one 
automatically selected; you may select any one desired.

If the list is empty, there were no models that meet the 
selected criteria.
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Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report. 

• If Use calculation assignments is not selected on the Col-
lected/Entered dialog, all of the nonoutlier points of the 
collected data within the specified range are used for calcu-
lating the data for this report.

• If Use calculation assignments is selected, collected data 
points which are assigned to this report type are used.

Regularization These choices enable you to choose the extent of smoothing 
you wish to have applied to your data, or your can choose 
None.

If you choose Entered, its field is enabled allowing you to 
enter a number giving a relative weight for the smoothing 
during deconvolution. Larger values produce more 
smoothing.

Reports to Generate Displays the types of reports available.

• Pore Size table
• Isotherm table
• Cumulative area graph
• Incremental area graph
• Differential area graph
• Log goodness of fit graph
• Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
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Edit Use this push button to edit details of a selected graph; a 
dialog like the following is displayed.

This push button is disabled for tables and Goodness of Fit 
graphs.

Plot Type Enables you to choose the manner in which you wish to 
display plotted data.

Autoscale Options Select these options to have the axes scaled automatically.

If you deselect one or both of these options, you must enter a 
range in the related Axis Range fields which become enabled 
automatically.

Overlay This drop-down list contains the type of overlays available 
for the current graph.

Choose Samples to overlay the same type of graph as the 
current one from other data reductions. Then select Overlays 
on the Report Options dialog to choose your files (explained 
on page 5-29).

Axis Range The fields in this group box become enabled when you dese-
lect Autoscale, allowing you to specify beginning and ending 
values for the X- and/or Y-axis. Data collected outside these 
ranges are not included in the plot. 

Valid ranges for a selected field are displayed in the informa-
tion bar across the lower portion of the dialog. 

The X-axis displays the energy and the Y-axis displays the 
area.

Displays the type of 
graph you are 
editing.
5-66                                                    Jul 07



ASAP 2050 Operator’s Manual Open
Surface Energy

The fields on the Surface Energy dialog are identical to those on the DFT Pore Size dialog 
with the following exceptions:

Refer to the previous section for the DFT Pore Size report beginning on page 5-64 for 
information on the fields contained on this dialog. 

Geometry drop-down list Is not applicable to the Surface Energy report and, therefore, 
does not display on its dialog.

Reports to Generate Displays the types of reports available.

• Surface energy table
• Isotherm table
• Cumulative area graph
• Incremental area graph
• Differential area graph
• Log goodness of fit graph
• Goodness of fit graph

Graph details can be edited by selecting the Edit push button.
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Dubinin Report Options

Report Type Allows you to specify the type of report you want. At least 
one type of report must be selected.

Select Radushkevich to generate the Radushkevich report. 

Select Astakhov to generate the Astakhov report. With this 
choice, you may select Optimize Astakhov exponent. If you 
do not select this option, the Exponent value field is enabled 
so that you can enter a value.

Refer to Appendix C for more information.

Fitted relative 
pressure range

Allows you to specify minimum and maximum limits on 
relative pressures included in the line fit. Data collected 
outside these limits are not included.
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Adsorptive Displays the Dubinin Adsorptive Options dialog allowing 
you to specify up to 8 Adsorptive/Affinity Coefficient (beta) 
combinations. 

Pressure Range Displays the Report Relative Pressure Range dialog so that 
you may specify minimum and maximum relative pressures 
to use with this report.

• If Use calculation assignments is not selected on the 
Collected/Entered dialog, all of the nonoutlier points of 
the collected data within the specified range are used for 
calculating the data for this report.

• If Use calculation assignments is selected, collected 
data points which are assigned to this report type are 
used.

Selected Reports Lists the available Dubinin reports. Choose a report by 
double-clicking on the report name or highlight the report 
name and press the Spacebar. A report is selected when it is 
preceded with a check mark.

The following reports are available:

• Tabular Report
• Transformed Isotherm
• dV/dw Pore Volume (Astakhov only)
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Tabular Report 

The Tabular report enables you to customize your report with one to six columns of data for 
Astakhov reports and one to five columns of data for Radushkevich reports. The Dubinin 
Tabular Report Column Options dialog is displayed.

The default column title appears next to the column number. Each column includes a drop-
down list of the data types to include in the report. 

Transformed Isotherm

The Transformed Isotherm report allows you to restrict the line fit to a portion of the isotherm. 
The Dubinin Transformed Isotherm Plot Options dialog is displayed.

Overlay Samples Select this option to overlay the current plot with data from 
other samples. Then click Overlays on the Report Options 
dialog to choose the sample files.

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes 
automatically scaled. Both X- and Y-axes begin at zero, and 
the system uses the highest values collected during analysis 
as the ending points for axes ranges. 
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Pore Volume

When you select the dV/dw Pore Volume plot from the Dubinin Report Options dialog, the 
Dubinin dV/dw Pore Volume Options dialog is displayed.

Autoscale x-axis
Autoscale y-axis
(continued)

If you choose not to autoscale data for either (or both) axis, 
the adjacent fields are enabled so that you may enter a 
beginning and ending value. Data collected outside these 
ranges are not included in the plot. 

The X-Axis Range fields show the quantity of gas adsorbed 
at standard temperature and pressure.

The Y-Axis Range fields show the log of relative pressure.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

The Pore Volume report is unavailable if you choose Radushkevich as the type of 
report.

Plot options You can plot data with a curve, points, or both.

Overlay Samples Select this option to overlay data from other samples. Then 
click Overlays on the Report Options dialog to choose the 
files.
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MP-Method Report Options

Autoscale x-axis
Autoscale y-axis

Select these options to have the X- and/or Y-axes 
automatically scaled. Both X- and Y-axes begin at zero, and 
the system uses the highest values collected during analysis 
as the ending points for axes ranges.
 
If you choose not to autoscale data for either (or both) axis, 
the adjacent fields are enabled so that you may enter a 
beginning and ending value. Data collected outside these 
ranges are not included in the plot. 

The X-axis Range fields show pore width, radius, or 
diameter in angstroms or nanometers.

The Y-axis Range fields show the quantity of gas adsorbed.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

Thickness Curve group box Select the type of thickness curve from this group box. 
You must choose either the Halsey equation or the 
Harkins and Jura equation. Use Equation to edit the 
values in the equation. 

Equation Displays the equation for the type of thickness curve 
selected
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Harkins and Jura Displays the Harkins and Jura Thickness Equation 
dialog.

You can edit the values for the numerator, first element of 
the denominator, and exponent. The range for a selected 
field is shown in the information bar at the bottom of the 
dialog.

Refer to Appendix C for more information.

Halsey Displays the Halsey Thickness Equation dialog.

You can edit the values for the multiplier, numerator, and 
exponent. The range for a selected field is shown in the 
information bar at the bottom of the dialog.

Refer to Appendix C for more information.
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Pressure Range Displays the Report Relative Pressure Range dialog so 
that you may specify minimum and maximum relative 
pressures to use with this report.

• If Use calculation assignments is not selected on 
the Collected/Entered dialog, all of the nonoutlier 
points of the collected data within the specified range 
are used for calculating the data for this report.

• If Use calculation assignments is selected, col-
lected data points which are assigned to this report 
type are used.

Selected Reports Lists the available MP-Method reports. Choose a report 
by double-clicking on the report name or highlight the 
report name and press the Spacebar. A report is selected 
when it is preceded with a check mark.

The following reports are available:

• Tabular Report 
• Cumulative Pore Volume
• dV/dw Pore Volume 
• Cumulative Pore Area
• dA/dw Pore Area
5-74                                                    Jul 07



ASAP 2050 Operator’s Manual Open
Tabular Report 

The Tabular report enables you to customize your report with one to six columns of data. (The 
data types in the first and second columns cannot be changed.) The MP-Method Tabular 
Report Column Options dialog is displayed.

The default column title appears next to the column number for columns three through six. 
Each of these columns includes a drop-down list of the data types to include in the report. 
Columns 1 and 2 are fixed and cannot be edited.

Pore Volume/Pore Area Plot

MP-Method plot options enable you to specify the plotting method used for your report and to 
customize the plot. A dialog like the following is displayed. The fields on all dialogs are the 
same.

The MP-Method reports hydraulic radius only. If you select Pore size in diameter from 
the Units dialog, the MP-Method still reports pore size in radius.
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Plot options You can plot data with a curve, points, or both.

X-axis options Choose Autoscale to have the x-axis scaled automatically. 
The X-axis begins at zero and the system uses the highest 
value collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

X-axis range fields show pore radius or diameter in 
angstroms or nanometers.

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.

Y-axis options Allows you to choose Y-axis options.

Variable Click on the down-arrow to choose a variable for the Y-axis.

Overlay You can use the choices in this drop-down list to overlay 
plots. You can choose a different type of plot for the current 
sample to overlay with the listed Variable, or you can choose 
Samples to overlay the Variable plot with the same type of 
plot from other samples.

Autoscale Choose this option to have the y-axis scaled automatically. Y-
axes begin at zero. The system uses the highest value 
collected during analysis as the ending point.

If you deselect Autoscale, the adjacent fields are enabled so 
that you may enter a beginning and ending value. Data 
collected outside these ranges are not included in the plot.

Y-axis range fields show the quantity of gas adsorbed

Data ranges are displayed in the information bar across the 
bottom of the dialog when the cursor is in a numerical data 
entry field.
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Options Report

The Options report is a subset of the contents report; it provides pertinent information for the 
following:

• Degas conditions
• Adsorptive properties
• Analysis conditions
• Sample tube criteria
• Free space
• Po and temperature
• Equilibration
• Isotherm collection

Summary Report

The Summary report provides a condensed listing of analysis statistics and data results. The 
Summary Report Options dialog allows you to choose the type of information to include in the 
report.
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Sample Log Report

The Sample Log report displays the following:

• Manual control operations performed during analysis
• Information entered using Add Log Entry on the sample file editor
• Warnings and/or errors which occurred during analysis

Collected/Entered Data

If you choose Manually entered as the type of data in the Sample Information dialog, an 
Entered tab is added allowing you to enter the data.

If you choose Automatically collected as the type of data in the Sample Information dialog, a 
Collected Data tab is added when analysis is complete. The Collected Data dialog will 
contain the data points collected during analysis and the specified calculation assignments.

This example shows the Collected Data dialog from a completed sample information file; the 
Entered dialog is identical except the data is entered and the tab displays as Entered Data.
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Pressure table For collected data, columns for the following are displayed:

• absolute pressure

• relative pressure

• quantity adsorbed

• outliers (if Use calculation assignments is not selected)

• calculation assignments for each requested report option 
(if Use calculation assignments is selected)

For entered data, columns for the following are displayed:

• absolute or relative pressure (depending on the selection 
in the Pressures group box)

• quantity adsorbed

Insert Enabled for entered data; inserts a row into the pressure 
table.

Delete Enabled for entered data; deletes the selected row.

Clear Enabled for entered data; clears the entire table of all entries 
except one (one is required).

Use calculation
assignments

If selected, allows you to assign the points to be collected for 
each report type.

If deselected, each report (with the exception of Langmuir 
and BET) uses a range of pressures as selected in Report 
Options. The Langmuir and BET reports interpolate to 
entered relative pressures on Report Options.

The outlier points can be selected so that they will not be 
reported.
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Po and T Displays the Po and T dialog, allowing you to edit the 
saturation pressure and temperature. Only the applicable 
options are enabled. 

Free Space Displays the Free Space dialog, allowing you to edit the 
ambient and analysis free spaces. This dialog also includes 
the plotted isotherm. The isotherm is redrawn each time you 
edit the values in either field. 

Also available for the isotherm is a shortcut menu containing 
options allowing you to edit the curve and axes. You also can 
zoom in for finer detail. Refer to Onscreen Reports, page 7-
16 for the options available.
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Save

Save enables you to save any changes you have made to the file in the active window. The file 
is saved under its current name.

Save As

Save As enables you to:

• save a sample or parameter file in the active window under a different name. This option is 
useful for making a duplicate copy of a file that you can modify as desired without chang-
ing the original one. The original file remains open when you use this function, so be sure 
to open the new file before making any changes.

• save a subset (parameter) of the sample file in the active window as a standalone parame-
ter file. For example, select Analysis Conditions from the Save As menu to create a stan-
dalone parameter file of the analysis conditions portion of the active sample file.

• save as an ASCII file the relative pressures and corresponding thicknesses (t-Curve) from 
the collected data. These data are derived by dividing the condensed volume of adsorptive 
by the selected surface area. The density conversion factor in the adsorptive properties file 
is used to convert quantity adsorbed to volume of condensed adsorptive.

• save as an ASCII file the relative pressures and resulting quantities adsorbed (Alpha-S) 
from the collected data. These data are derived by taking the isotherm and dividing it by 
the quantity adsorbed at 0.4 relative pressure.
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Sample and Parameter Files

A dialog similar to the one shown below is displayed when you select Sample Information, 
Sample Tube, Degas Conditions, Analysis Conditions, Adsorptive Properties, or Report 
Options. 

Enter a file name (up to eight characters) in the File name field; the appropriate extension is 
appended automatically when you click OK. The new file is saved as specified, but does not 
remain in the active window. Be sure to open the new file before making any changes to the 
file.

t-Curve and Alpha-S Files

The same type of dialog shown above is also displayed when you select t-Curve or Alpha-S. 
However, before you receive this dialog for t-Curve, the Save As t-Curve dialog is displayed. 
This dialog allows you to choose the surface area for the sample.

Indicates the type of 
file being saved
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Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

A dialog prompting for a reason for the current change version of each file is displayed.

Close

Close enables you to close the file in the active window. If the file contains changes that have 
not been saved, the following message is displayed:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.

Close All

Close All enables you to close all open files under their current names. The following message 
displays for every file containing changes that have not been saved:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file closes.
Click No to close the file without saving the changes.
Click Cancel to return to the active file.
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Print

Print enables you to print the contents of one or more files to the screen, a printer, or a file. For 
example, if you choose Analysis Conditions, you will receive the parameters used for all 
analysis conditions associated with the file(s). The print dialog is common to all file types. 

Select the desired file type from the drop-down menu; a dialog similar to the following is 
displayed:

File name The name of the file you choose to print is copied to this 
field. If you choose multiple files, the name of the last one 
selected is displayed. 

Copies Enabled when Printer is selected as the print destination. 
You may print up to four copies

Destination Select the destination. You may print to a printer, the screen, 
or a file. 

Indicates the type 
 
printing
of report you are
5-84                                                    Jul 07



ASAP 2050 Operator’s Manual List
Refer to “Selecting Files” on page 2-11 for a description of the other fields on this dialog and 
the Date Range push button. 

List

List enables you to generate a listing of the following information on a selected sample or 
parameter file.

• File name
• Date the file was created or last edited
• Time the file was created or last edited
• File identification
• File status

Regardless of the type of file you choose, the dialogs are similar; the options presented in the 
header vary slightly. The types of dialogs displayed are identical to the ones displayed for the 
Print function; you simply obtain different types of information. This example shows a dialog 
for sample files.

Refer to Print, page 5-84 for an explanation of the fields on this dialog.

You may request a list of multiple files by holding down Ctrl while selecting files. If no files 
are selected, a list is generated for all files.

File name Enabled when you select File as the destination. A default 
file name (the same name as the sample file) appears if you 
choose only one file; you can use the default name or enter 
another one.

If you select multiple files, the default displays as *.RPT; 
each file will be exported as its original file name with the 
RPT extension.

Indicates the type
of file on which you
have requested a
list of statistics
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Export

Export copies the isotherm data in the sample information file and reformats it in a text format 
acceptable to other programs, such as spreadsheets. The output file consists of 4 columns 
containing the absolute pressure, relative pressure, specific quantity adsorbed, and the elapsed 
time.

 
File name The name of the file you choose to export is copied to this 

field. If you choose multiple files, the name of the last one 
selected is displayed.

Settings This group box enables you choose print options.

Destination Select Destination to export files to a printer, the screen, or 
to a file. The Copies field is enabled if you choose printer, 
allowing you to print up to four copies.

The File name field is enabled if you select File for export 
destination. For the name, you can:

• Accept the default value where all selected files you 
choose to export will have the same name as those in the 
sample information file with an .ISO extension.

For example, if you select the following files to export, 
names will be assigned as indicated:
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Selected Files Export Names

C:\DATA1\SAMP1.SMP C:\DATA1\SAMP1.ISO
C:\DATA1\SAMP2.SMP C:\DATA1\SAMP2.ISO
C:\DATA1\SAMP3.SMP C:\DATA1\SAMP3.ISO

• Enter a name for the file (full path name). The extension 
does not have to be .ISO. If exporting more than one file, 
a wildcard character should be entered. 

For example, if you use a .TXT extension, enter 
C:\DATA2\*.TXT in the File name field. 

Selected Files Export Names

C:\DATA1\SAMP1.SMP C:\DATA2\SAMP1.TXT
C:\DATA1\SAMP2.SMP C:\DATA2\SAMP2.TXT
C:\DATA1\SAMP3.SMP C:\DATA2\SAMP3.TXT
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Exit

Exit enables you to exit (close) the ASAP 2050 program. 

• If an analysis is in progress, the following message is displayed:

CAUTION: Sample analysis is in progress. If you exit 
the program analysis will continue to completion, but 
the data are not saved to disk until the program is 
restarted. Do you want to exit the program?

Yes No

Click Yes to close the ASAP 2050 program. The analysis continues and data are collected.
Click No to allow the program to remain active.

• If a report is in progress, you are cautioned that reports are being generated, and given the 
opportunity to either cancel the print job or allow the reports to print before exiting.

Although data are stored in the analyzer when you exit the program during analysis, 
they are not saved in the file until the program is restarted. At that time the data are 
saved automatically. If a power failure occurs in the interim and you do not have an 
Uninterruptible Power Supply (UPS) attached, loss of data will result.

 

Observe the Status area of the instrument schematic; it indicates when an analysis is 
complete.
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6.  UNIT MENU

The Unit menu contains the options for the operations that can be performed with the ASAP 
2050 analyzer. The main menu will contain a Unit menu for each attached analyzer. For 
example, if you have two attached analyzers, the main menu contains two Unit menus. The 
appropriate unit number and serial number display in the title bar of the operational windows. 
The status windows also display in different colors. This feature is especially useful when you 
have more than one analyzer attached to the same computer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 
in subsequent sections.

The Unit menu does not display on the menu bar if the analysis program is being 
used for offline data manipulation on a computer other than the one controlling the 
analyzer.

Sample Analysis Starts an analysis. This option is disabled if analyses are in 
progress. Page 6-3.

Start Degas Allows you to start the degassing operation on one or two 
samples. Page 6-7.

Enable Manual Control Allows you to control the system manually. Page 6-8.

Show Instrument 
Schematic

Displays a schematic of the analyzer components. Page 6-11.
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Show Status Shows the status window of the operation in progress.
 Page 6-12.

Show Instrument Log Displays a log of recent analyses, calibrations, and error mes-
sages. Page 6-13.

Unit Configuration Displays the configuration of the analyzer. Page 6-15.

Calibration Enables you to calibrate certain components of the analyzer. 
Page 6-17.

Degas Allows you to perform sample degassing operations. 
Page 6-22.

Service Test Enables you to perform certain troubleshooting procedures. 
This option is enabled only with the direction of a Micromer-
itics service representative. Page 6-27.
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Sample Analysis

When you select this option from the Unit menu, the Sample Analysis dialog is displayed 
with all fields disabled (grayed) and the Start Analysis dialog positioned on top. This allows 
you to select a sample file for your analysis or to create a new one. 

After a sample file has been designated, the Analysis dialog is displayed. The fields now con-
tain the values for the selected file or, if creating a new file, the specified defaults. 

   
View Allows you to view one of the following in the current win-

dow:

• the current operation
• the instrument schematic
• the instrument log 

Refer to Show Instrument Schematic on page 6-11 and 
Show Instrument Log on page 6-13.

Browse Displays the Start Analysis dialog allowing you to choose a 
different sample file for the current analysis.

Sample Displays an identification of the sample file.

Mass Enables you to enter the sample’s mass.

Density Enables you to enter the density of the sample.
Jul 07                                                6-3 



ASAP 2050  Operator’s Manual Sample Analysis
Sample Tube Displays the name of the Sample Tube file for the current 
sample file.

If this is a new file, this field contains the file you specified as 
the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory (refer to 
Parameter Files Directory on page 8-11), as well as those 
included with the analysis program. You may choose a dif-
ferent file from this list if desired.

Analysis Conditions Displays the name of the Analysis Conditions file for the cur-
rent sample file.

If this is a new file, this field contains the file you specified as 
the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory (refer to 
Parameter Files Directory on page 8-11), as well as those 
included with the analysis program. You may choose a dif-
ferent file from this list if desired.

Adsorptive Properties Displays the name of the Adsorptive Properties file for the 
current sample file.

If this is a new file, this field contains the file you specified as 
the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory (refer to 
Parameter Files Directory on page 8-11), as well as those 
shipped with the analysis program. You may choose a differ-
ent file from this list if desired.
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Report Options Displays the name of the Report Options file for the current 
sample file.

If this is a new file, this field contains the file you specified as 
the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory (refer to 
Parameter Files Directory on page 8-11), as well as those 
shipped with the analysis program. You may choose a differ-
ent file from this list if desired.

Po Enabled if you have chosen to enter the Po measurement. 
Enter (or confirm) the saturation pressure of the adsorptive, 
or edit the current one if desired.

Bath temperature Enabled if you have chosen to enter the bath temperature (Po 
and T option on the Analysis Conditions dialog). Enter (or 
confirm) the temperature for the analysis bath.

Ambient Temperature Enter the ambient temperature.

Ambient and Analysis Free 
space

Enabled if you have chosen to enter the free space values 
(Free Space option on the Analysis Conditions dialog). Enter 
(or confirm) the appropriate values.

Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. If you choose Screen, reports have 
many options for being customized and manipulated. (Refer 
to Onscreen Reports on page 7-16 for details about 
onscreen reports.)

Start Begins the analysis; after data start to collect, an analyzing 
view of the Analysis dialog is displayed.
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Suspend Suspends the analysis.

Skip Skips the current step of the analysis.

Use the Skip command with caution; the ASAP performs multiple steps for a given 
task. Skipping certain steps may cause corruption of data, instrument damage, or 
personal injury.

Resume Resumes a suspended analysis.

Cancel Cancels the analysis.

Start On this view of the analysis dialog, this push button changes 
to Next when the analysis is finished.

Next Enabled at the completion of the analysis. Returns you to the 
first view of the Analysis dialog so that you may schedule 
another analysis.

Close Enabled at the completion of analysis. Closes the dialog.
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Start Degas

This option allows you to choose the file and start degas operations on one or two samples; 
the Automatic Degas dialog is displayed.

Sample Click Browse to the right of this field to select a sample file 
that will be used with the current sample. 

Degas Conditions Displays the Degas Conditions file designated as the default. 
After you choose a sample file, this field displays the file 
associated with the sample file.

You can choose a different Degas Conditions file from the 
drop-down list if desired. If you choose a different file, the 
values in the current file will be overwritten with the values 
of the new one.

Clear Clears the sample file from the port assignment. Click 
Browse to choose a different file.

Start Starts the degassing operation

Cancel Closes the dialog, cancelling the degassing operation.
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Enable Manual Control

Select this option to control certain components of your system manually. If the instrument 
schematic is not displayed, select Instrument Schematic from the View drop-down list or 
from the Unit menu.

When manual control is enabled, the valve symbols change color on the monitor screen to 
indicate their status. 

Green = open
Yellow = closed

Use the mouse pointer to select a component. A component is selected when it is surrounded 
by a thin line. Each component has a shortcut menu displaying the operations available for 
that particular component. These menus may be accessed by right-clicking on the desired 
component, or by using the shortcut keys Shift + F9.

You can open and close valves, and raise or lower the elevator by using one of the following 
methods:

• right-click on the valve or elevator symbol to access the shortcut menu and select the 
appropriate action

• double-click on the valve or elevator symbol

• select the valve or elevator symbol and press the Spacebar
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Table 6-1. System Valves

Valves System valves and their functions are listed in Table 6-1.

Actions:  Open, Close, Pulse

Pulse briefly opens and closes (or vice versa) the valve.

Valve Description
1 Unrestricted vacuum
2 Restricted vacuum
3 Free-space measurement gas (helium)
4 Restricted analysis gas
5 Unrestricted analysis gas
7 Lower manifold isolation
8 Vapor
9 Sample port

10 Restricted Psat tube port
11 Unrestricted Psat tube port

P1 through P6 Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases

Dewar positions The Dewar can be raised, lowered, or stopped.

Indicates the Dewar is being raised; note the position of the 
arrow in the center of the Dewar symbol.

Indicates the Dewar is being lowered; note the position of the 
arrow in the center of the Dewar symbol.

Indicates the Dewar is stopped in the raised position.

Open Closed
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The remainder of the components are displayed for informational purposes only; they cannot 
be controlled manually.

Indicates the Dewar is stopped in the lowered position.

Represents the sample tube.

Represents the Psat tube.

 

This group of rectangles on the left side of the schematic dis-
plays the temperature, the transducer, and the vacuum gauge 
pressure. Transducer

Vacuum Gauge

Temperature
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Show Instrument Schematic

Select this option to display a schematic of the ASAP 2050 analyzer. The schematic is a 
graphical representation of the plumbing system including system valves, the analysis station, 
and the Dewar position. The valves and Dewar can be controlled from the schematic when 
Manual control is enabled. Refer to Enable Manual control on page 6-8 for an explanation 
of the components displayed on the instrument schematic.

The state of the valves can be determined quickly by color representation even when manual 
control is not enabled:

• Green = open
• White = closed

If you wish to change the state of a valve, you must enable manual control.
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Show Status

A status window is shown across the bottom of all operational dialogs as well as the instru-
ment schematic. The Show Status option enables you to show only the status window. This 
frees up your computer screen allowing you to perform other tasks (such as creating or edit-
ing sample files), while still monitoring the progress of your analysis.

If you have multiple instruments attached to your computer, the status bar for each instrument 
is displayed in a different color. 

Analysis status bar Shows the progression of the analysis. This bar contains three 
stages:

• Preliminary: ambient and analysis free spaces are deter-
mined; displays green during progression

• Analysis: data are collected; displays blue during progres-
sion

• Termination: the Dewar lowers, and the sample tube is 
warmed and backfilled; displays gray during progression

All stages are displayed in red if the analysis has been 
suspended.

Analysis details The following analysis details are displayed:

Sample: Sample file number
Stage:       Stage of the analysis (as in status bar)
Last Point: Last point and number of points requested
P: Absolute pressure of last point
P/Po: Relative pressure of last point
V(cm3/g): Volume adsorbed
Po: Absolute pressure of last measured or 

calculated saturation pressure (Po)
Run Time: Elapsed time since the start of analysis

Step details Provides details of the current step of the analysis.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. 

By default, this information is logged for a 60-day period for analyses and messages, and a 
90-day period for calibrations. You may change the time for which this information is 
retained in the Unit section of the WIN2050.INI file. Simply replace the default value with 
the desired number.

    
Analysis 
Calibration 
Messages

These options allow you to choose which entries are dis-
played in the window. For example, select the Calibration 
check box to display only calibration information.

Add Log Entry Enables you to make an entry in the instrument log that can-
not be recorded automatically through the application 
software. For example, you may change the port filter. The 
field adjacent to the push button allows you to enter the 
operation; the push button is enabled when you make an 
entry in the field, allowing you to add the entry.
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Report Displays the Log Report Settings dialog allowing you to 
generate the log contents to a specified destination.

Use the Start Date field to specify the date at which to start 
the printout. This date does not limit the entries that display 
in the window, it is only pertinent to the entries that will be 
printed on the report.

You can specify a date using one of the following methods:

• Highlight the field (or press F2 to clear the field) and type 
in the desired date.

• Double-click in the field (or press F4) to display a calendar 
to choose a date.

• Press F3 to insert the current date.

Enter the number of copies desired in the Copies field; you 
may print up to 4. This field is disabled if you are printing to 
a File or to the Screen.

Choose the report destination from the drop-down list in the 
Destination field. If you choose File, the File name field is 
enabled, allowing you to enter a name for the printed file (or 
you may accept the default).
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Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was 
performed, and the software and hardware configuration of your system. 

Volume Calibration Displays the system, lower, and reference volumes from the 
most recent calibration. It also displays the date and time the 
calibration was completed.

A/D Calibration Displays the following:

• The date and time the manifold temperature was last cali-
brated.

• The date and time the transducer offsets were last cali-
brated.

• The percent of nominal transducer scale in use, and the 
date and time the transducer scale was last calibrated.

• The date and time the vacuum gauge was calibrated.

Configuration Displays the following:

• The hardware code specifying the hardware components 
present in your analyzer. This code is provided so the Ser-
vice Department may quickly identify your hardware con-
figuration and provide prompt assistance.
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Configuration
(continued)

• The identification number of the port being used to control 
the analyzer.
 

• The serial number of the attached analyzer (active unit). 

Software Versions The software versions of the MIC BIOS, Controller, and 
ASAP 2050 System software.

SmartVacSoftware 
Versions

The software versions of the MIC BIOS and degas system 
software. 

Features The options currently enabled on your system. 

Gas Displays the Gas Configuration dialog.

This dialog allows you to choose the gases attached to each 
port of the analyzer.

Board ID Displays the Board ID dialog so that you can view the sta-
tistics of the board contained in the requested slot of the card 
cage in the instrument.
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Calibration

This option allows you to calibrate the vacuum gauge, pressure gauge, pressure scale, mani-
fold temperature, and system volume of the analysis system. You can also save the current 
calibrations to a file or load a different calibration file. 

Vacuum Gauge

Displays the Calibration Vacuum Gauge dialog containing the current vacuum level.

This dialog also allows you to enter a new value (if necessary) after calibration using an 
external reference gauge. 

Pressure Gauge

Displays the Calibrate Pressure Offset dialog.

This dialog allows you to evacuate the manifold and zero all pressure transducers in the 
system. 
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Pressure Scale

Use this option to adjust the scale of the transducer to match a reference standard; the Cali-
brate Pressure Scale dialog is displayed.

Temperature

Use this option to adjust the offset of the manifold temperature sensor to agree with a value 
obtained using a calibration device. The Calibrate Manifold Temperature dialog is displayed 
so that you may enter the measured value.

Reset to nominal Restores factory calibration settings for the transducer. 

Match to entered pressure Select this option to enter a value obtained using a reference 
pressure gauge to determine the actual manifold pressure.
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Volume

Use this option to enter a predetermined system volume in the event of data loss. 

The system volume typically is calibrated after servicing valves, transducers, or any part of 
the analysis plumbing. The ASAP 2050 must be idle to calibrate system volume. Before sys-
tem volume is calibrated, the manifold temperature sensor and the master pressure gauge 
must be calibrated.

Previous Retains the values currently in use.

Entered Allows you to enter values to use.

Measured This field is used by authorized service personnel when mea-
suring the system and lower manifold volumes. A special 
Service Kit is required to perform these procedures.

Done Closes the dialog (displays for the Previous and Entered 
selections).

Displays as Next if 
you choose 
Measured.
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Next Appears only when Measured was selected; displays a dia-
log that enables service personnel to enter measured volumes. 

Reference Volume Enter the number of cubic centimeters for the reference vol-
ume you are using in this calibration.

Reference Volume Temp. Enter the temperature of the reference volume. Since the ref-
erence volume should be submerged in an ice bath, this value 
should remain at 0.0oC for best accuracy.

Perform measurement Choose the number of measurements you wish to perform; 
you may choose up to 9.

Start Begins the calibration; a status view is displayed. After the 
calibration has finished, a confirmation view of the Calibrate 
System Volume dialog is displayed.

This dialog allows you to choose the volume you wish to use.
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Save to File

Use this option to save the current calibration settings to a file; the Select Calibration File dia-
log is displayed

Load from File

Displays the Select Calibration File dialog (shown above) so that you can load a previously 
saved calibration file.

Previous
The system volume and lower manifold volume in use before 
this measurement.

Entered
An entered measurement.

Measured
The last measured system and lower manifold volumes; for 
example if you choose 3 measurements, this value is that of 
the last (third) measurement.

Average
The average of the series of measurements; for example if 
you choose 3 measurements, this value is the average of the 
three measurements.

Click Done to close the dialog.

File name Defaults to the next sequence number for calibration 
files. The sequence number consists of: xxx-
yyy.CAL, where xxx = serial number of unit and 
yyy = sequence number. For example, the number 
listed in the above dialog represents the first calibra-
tion file for unit serial number 101.
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Degas

This option allows you to select options for the degas system.

Enable Manual Control

Select this option to control manually certain components of the degas operation. If the degas  
schematic is not displayed, select Show Instrument Schematic from the Degas menu.

Valves D1, D2, D5, D6, D7 Degas valves and their functions are listed in Table 6-2.

Actions: Open, Close

  Servo
  valve
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Table 6-2. Degasser Valves

Show Instrument Schematic

Displays the schematic (shown in the previous section) for the Degas system.

Valve Description
D1 and D2 Sample port valves

D5 Vacuum valve
D6 Servo isolation valve
D7 Gas inlet port valve

Servo Valve Actions: Set, Close

Set displays the Servo Value Settings dialog so that you can 
enter a target pressure for sample evacuation. This feature 
enables you to use the software to bring down the sample 
pressure slowly and incrementally.

Close closes the servo valve.

Heaters Actions: Set, Disable

Set displays the Port [n] Heater Settings dialog so that you 
can specify a ramp rate and target temperature. After you 
click and close the dialog, the settings are displayed directly 
below the heater symbol.

Disable cancels the settings.

Status window Displays the status of the current degassing operation(s). 
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Show Status

This option allows you to monitor the degassing operation.

Sample Displays the sample file being used with the degassing oper-
ation for each port.

Status Displays the current stage of the degassing operation for 
each port.

Check Allows you to check the outgassing rate of the sample on the 
related port; the following actions occur:

• current degassing step is suspended (on both ports). 
Degassing can be checked after the vacuum setpoint has 
been attained, or during a temperature ramp and hold. If 
you choose this option during any other step, a message 
indicating the degas system is not in a valid state is dis-
played.

• vacuum valves are closed and the vacuum level moni-
tored.

• the Status window will indicate that the degassing opera-
tion is being checked and will display the outgassing rate 
as it becomes available.

During the degas check, this push button changes to Con-
tinue. When Continue is clicked, the valves open, the tem-
perature ramp or hold continues, and the degassing operation 
resumes. If your outgassing rate indicated that the sample 
has been rid of contaminants (minimal pressure increases), 
you can click Skip to advance to the next state of the degas-
sing operation. For example, if you check degassing after the 
setpoint is attained, Skip advances you to the ramping stage.

Skip Skips the current stage of the degassing operation for the 
port associated with this push button.
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Calibrate Pressure Zero

Use this option to evacuate the manifold and zero the transducer

Calibrate Pressure Scale

Use this option to adjust the scale of the pressure transducer.

Cancel Cancels the degassing operation for the port associated with 
this push button.

Start Begins the calibration.

Status messages are displayed during this procedure, then 
the dialog closes automatically.

Current Pressure Enter the current pressure of the degas manifold. 
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Calibrate Vacuum Gauge

Displays the Calibrate Vacuum Gauge dialog containing the current vacuum level.

This dialog also allows you to enter a new calibration value (if necessary) obtained using an 
external reference gauge. 

Calibrate Servo

Use this option to calibrate the servo valve to the manifold pressure transducer. The servo 
valve should always be recalibrated after a pressure calibration has been performed. The Cal-
ibrate Degas Servo dialog is displayed.

Start Begins the calibration. The servo valve is used to evacuate 
and equilibrate the manifold. The pressure transducer read-
ings are used to calibrate the servo set point. Status messages 
are displayed during this procedure, then the dialog closes 
automatically.
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Service Test

Various service tests are included in the ASAP 2050 operating program. These tests can be 
enabled and performed only with the assistance of a trained Micromeritics service represen-
tative. These tests are designed to provide your service representative with instrument 
readouts, as well as to assist him in troubleshooting potential problems and, perhaps, elimi-
nating unnecessary repair services. This service strategy allows you to conduct expert tests in 
less time than it would take to be trained in servicing the instrument properly.
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7.  REPORTS MENU

This chapter describes the commands on the Reports menu.

Reports can be generated for data:

• collected on a sample that has completed analysis

• collected on a sample that is currently being analyzed (includes only the information col-
lected up to the time of the report)

• that is manually entered

Description

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis or on the data collected thus far for an analysis in 
progress. Page 7-2.

Close Reports Closes all open report windows. Page 7-4.

Open Report Enables you to open a report that was saved from the report 
window. Page 7-4.

SPC Report Options Allows you to specify the sample data to be included in SPC 
reports. Page 7-5.

Regression Report Allows you to generate a regression report. Page 7-6.
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Start Report
Select this option to generate a report on a sample analysis. Select Start report from the 
Reports menu to display the Start Report dialog.

Control Chart Allows you to generate a control chart report. Page 7-10.

Heat of Adsorption Allows you to generate a Heat of Adsorption report. 
Page 7-13.

Rate of Adsorption Not used.

File name The name you select from the Files list box is copied to this 
field. If you select multiple files, only the last one selected is 
displayed. If you have a sample file open when you select this 
option, its name is displayed.

Status This drop-down list determines what type of sample files are 
displayed in the Files list window in the specified directory 
for all dates, or within the specified range of dates (using 
push button).

Choices:All, Analyzing, Complete, Entered

Status
(continued)

Refer to “Table 2-2. File Status and Description” on 
page 2-12 for a description of the status types.
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Date Range Displays the Select Dates dialog so that you may specify a 
range of dates. Refer to “Selecting Files” on page 2-11 for a 
description of this push button.

Copies Enabled when the Printer destination is chosen. This option 
allows you to print up to four copies of the selected report(s).

Destination Displays a drop-down list of output destinations.

Choices:File, Printer, Screen

If you select Printer, requested reports are printed to the 
selected printer.

If you select Screen, many options are available for 
manipulating and customizing reports. Refer to Printed 
reports on page 7-16.

If you select File, the tabular reports of the requested file are 
converted to a text file which can be viewed with a text editor 
or other text file manipulation tool. Graphical data cannot be 
generated to a File. 

File name Enabled when you select File as the destination. Allows you 
to enter a name, or you may accept the default.

Files list box Displays a list of the available sample files for the choice 
shown in the Status field and within the range of dates 
specified in the Dates dialog.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above 
the Directories list box. 

If you choose a single sample file, the Reports to Generate 
dialog is displayed. The reports selected are the ones you 
specified in the sample file. This dialog allows you to 
deselect reports or select additional ones.
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Close Reports
This option enables you to close all open report windows at one time. This avoids having to 
select close on each report window.

Open Report
Enables you to open a report that you saved from the report window.

Double-click on the report(s) you wish to select (or deselect); 
alternatively, you can highlight the report and press Space-
bar. A check mark is placed before each selected report. 
After you make your report selection and click OK, the 
requested reports are sent to the specified destination.

If you choose more than one file, this dialog is not displayed. 
The reports specified in each sample file will be generated.
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SPC Report Options

When you select SPC Report Options, the SPC Report Options dialog is displayed.

The SPC Report Options dialog lists the variables that are most frequently used for SPC 
reporting. You can check as many as desired. All variables selected are computed for each 
sample file used in an SPC report.

Click More for additional SPC calculations for the detailed reports.
Jul 07                                                  7-5 



Regression Report ASAP 2050 Operator’s Manual
Regression Report

Select this option to generate a regression report. The regression report is used to determine 
the interdependency between two variables. Up to three dependent variables (Y-axis) may be 
plotted against a single independent variable (X-axis). The degree of correlation between the 
variables also is reported. The graphs for the regression report are scaled so that all three fit 
on a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. You can enter up to 40 
alphanumeric characters. 

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced 
metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited in the 
report window (when printed to the screen), or removed if 
desired.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. Click 
on the down arrow to display a list of variables. The variables 
in this list are the ones you specified in the SPC report 
options.

With this option, you can plot the regression of up to three Y-
axis variables against the X-axis variable. The X-axis 
specifies the independent variable for the regression, while 
the Y-axes provide the dependent variables.

Axis Range Enables you to specify the beginning and ending values for 
the X- and Y-axis ranges. Data collected outside these ranges 
are not included in the plot. These fields are disabled if you 
choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled 
automatically. When scaled automatically, both axes begin at 
zero. The analysis program uses the highest values collected 
during analysis as the ending points.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report; however, it does 
lengthen the time required to generate the report.

Tabular report Enables you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Label data Allows you to label the points on the plot to correspond with 
the values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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File name Use this field to limit the files displayed in the Available Files 
pane. For example; enter g*.smp to display only the files 
beginning with an g.

Status This drop-down list determines the type of sample files that 
display in the Available Files pane in the selected directory 
for all dates, or within the specified range of dates (using 
Date Range push button). Refer to “Table 2-2. File Status 
and Description” on page 2-12 for an explanation of the 
Status types.

Date Range Displays the Select Dates dialog so that you can specify a 
range of dates. Refer to “Selecting Files” on page 2-11 for 
an explanation of this dialog.

Use all files in
this directory

Select this option to include all files from the selected 
directory in the report.

Directories Lists the current directory. Use the directory window to 
navigate to a different directory.

Add Moves the selected file in the Available Files pane to the 
Selected Files pane. Alternatively, you can simply double-
click on the desired file(s). You can select multiple files by 
holding down Ctrl while making your selections. You can 
include up to 200 sample files.
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Remove Removes the selected file from the Selected Files pane and 
places it back into the Available Files pane.

Save As Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the 
report.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a 
statistic.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. You can enter up to 40 
alphanumeric characters.

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your report 
title. For example, you may wish to display your company 
logo. The graphic must be a bitmap (bmp) or enhanced 
metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited in the 
report window (when printed to the screen), or removed if 
desired.

X-axis Order By Enables you to choose the order in which X-axis statistics are 
placed. You can have them placed by Time, File name, Date, 
Minutes, or Days.
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Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected on 
the SPC Report Options dialog. The variable you choose will 
be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If you 
wish to specify a range, deselect this option and enter a range 
in the From and To fields.

Center Line Displays placement options for the variable’s optional value. 
Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit 
fields are enabled, allowing you to enter appropriate values.

Tabular report Allows you to generate tabular, as well as graphical, data of 
the included samples. A tabular report contains the numeric 
values contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report 
Options are included in the new report. It also lengthens the 
time required to generate the report.
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Samples Displays the Control Chart Sample Selection dialog, allowing 
you to choose the sample files on which you wish to report. 

This dialog functions in the same manner as the Regression 
Report Sample Selection Dialog explained on page 7-7.

Save as Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the 
report.

Report Generates the report.
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Heat of Adsorption
The isosteric heat of adsorption is an important parameter for characterizing the surface 
heterogeneity, providing information about the adsorbent and the adsorption capacity. Multiple 
adsorption isotherms are obtained on the same sample using the same adsorptive but at 
different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of 
Adsorption report; the Heat of Adsorption dialog is displayed.

Table Contains the files you choose; also lists the quantity 
adsorbed.

Add Samples Displays the Select Samples dialog so that you can choose 
desired files.
 

Remove Samples Removes the selected sample from the list. If no samples are 
selected, the last one is removed.

Clear Samples Removes all samples from the list.
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Edit Quantities Displays the Edit Quantities Adsorbed dialog so that you can 
specify the range of surface coverage to include in the heat of 
adsorption report.

Quantity Adsorbed 
table

Allows you to enter the points.

Insert Range Displays the Insert Quantity Range dialog.
This dialog allows you to specify the starting and ending 
quantities adsorbed, as well as the number of points to insert 
within the specified range.

Save Table Allows you to save the current table as a file (QNT 
extension).

Load Table Allows you to import a previously saved table.

Insert Inserts a row above the selected row.
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Delete Deletes the selected row.

Clear Clears the entire table of all entries except one; one is 
required.

Report Settings The options in this group box allow you to choose report 
criteria.

Show report title Choose this option to have a title display in the header of 
your report, then use the adjacent field to enter the title.

Show graphic This option allows you to have a graphic appear in your title; 
for example, you may wish to show your company logo. You 
can use a bitmap or an enhanced metafile.

Use the Height and Width fields to define a size.

Copies Enabled when you choose Printer as the destination, allowing 
you to print up to four copies of your report(s).

Destination Enabled when you choose Printer as the destination, allowing 
your to print up to four copies of your report(s).

File name Enabled when you choose File as the destination, allowing 
you to enter a name (or you can accept the default).

Report Generates the report.

Tabular report Select this option to have data generated in a tabular format.

Isostere plot Select this option to generate a graph showing quantities of 
gas adsorbed vs. the temperature.

Heat of adsorption plot Select this option to generate the Heat of Adsorption data in a 
graphical format.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as when the 
file was created and by whom, date and time of analysis, analysis conditions, and so forth. 

The headers for these reports also contain notes of any changes to the sample file that 
occur after analysis.

• Summary report headers contain the same type of information displayed in tabular and 
graphical reports with the exception of notes.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar
• shortcut menus
• zoom feature
• axis cross-hairs 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.

Displays graphical 
(or tabular) data

Options on 
Tool Bar

List of reports 
requested

                         Tabs display for each type of report
                          you wish to generate.Header
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Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed.

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog.

For convenience in selecting which reports to print, push 
buttons are provided beneath the report window. Or, you can 
make your selection by clicking on the desired reports. 

Current selects the report displayed in the report window.

Shown selects only the shown reports; any non-highlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All selects all reports, including those that may have been 
hidden.

Clear clears all selections. 
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Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific 
reports to save, use the Save As push button.

Save As Saves all or specified reports from the currently open file. 
The push buttons displayed on this dialog perform in the 
same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you to 
reopen the file using the push button on the Report window 
tool bar.

Spreadsheet (*.xls): Saved in a format which can be imported 
into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be imported 
into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can specify 
default parameters for report fonts and curve properties.

Fonts Contains a list of report elements for which the font can be 
edited. Simply highlight the desired element and click Edit; a 
font dialog is displayed so that you can specify the desired 
font and attributes.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.
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Graph border line
thickness

Enables you to specify a thickness for the border of the graph.

Load Loads the last saved defaults.

Save Saves the changes as the defaults. If you do not click Save, 
the changes will apply to the current report set only. The next 
reports will revert to the defaults.

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not click 
Save, the changes apply to the current report only.

Close Closes the report window.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

Tabular Reports

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of the columns that have not been hidden, 
enabling you to select the one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attributes 
for the tabular data in the current report. 
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Graphs

Header font Displays a Font dialog, allowing you to change font attributes 
for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after having zoomed in.

Redraw Sets axis boundaries to its original view. You can also use this 
function to remove cross-hairs.

Show curve Shows any curve(s) that has been hidden. This option is 
disabled (grayed) if no curves have been hidden.

Hide curve Hides (removes from view) any unwanted curve(s).
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Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.

Title Displays the title of the curve you are editing. You can edit 
the title if desired.

Style This drop-down list contains the styles in which collected 
data can be displayed.

Choices:Curve, Histogram, Points, Curve and Points

Curve group box Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. You can also select to use the default curve 
thickness or specify a different thickness.

The options in this group box are disabled if Histogram is 
chosen in the Style drop-down list.

Histogram group box The options in this group box are enabled when you choose 
Histogram as the style for collected data. The choices in the 
drop-down list allow you to choose the type of fill for the 
Histogram, then you can click Color to select the fill color.
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Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend. You can also edit the font if 
desired.

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing you 
to paste it into other applications accepting Windows 
metafiles.

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
details. To use this feature, simply hold down the left mouse button and drag the mouse cursor 
(drawing a box) across the area you wish to view; then release the button. The enlarged area 
immediately fills the graph area. Right-click in the graph area and choose Autoscale from the 
shortcut menu to return to the normal view

Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

Right-click in the graph area and choose Autoscale or Redraw from the shortcut menu to 
remove cross-hair lines and return to the normal view. Alternatively, you can click outside of 
the graph area.

Point of Coordination
  Y-axis position

X-axis
position
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Sample Reports

The remainder of this chapter contains samples of some of the reports that can be generated by 
the ASAP 2050 program. Most of the reports can be varied through entries on the report 
options screens.
7-26                                                    Jul 07



ASAP 2050 Operator’s Manual Summary Report
Summary Report

V X.XX
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BJH Adsorption Cumulative Pore Volume

V X.XX
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Isotherm Pressure Composition

V X.XX
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Isotherm Linear Absolute Plot

V X.XX
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Isotherm Linear Absolute Plot
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8.  OPTIONS MENU

The commands on the Options menu enable you to configure the system to your laboratory’s 
requirements and establish sample defaults.

Description

Option Presentation Allows you to display the sample file dialog in Advanced, 
Basic, or Restricted mode. Page 8-2.

Sample Defaults Enables you to specify default values for sample and 
parameter files. Page 8-4.

Units Enables you to choose the way in which data are presented 
on the screen and in printed reports. Page 8-10.

Graph Grid Lines Enables you to choose the type(s) of grid lines to show on 
your report. Page 8-10. 

Live Graph Enables you to choose the variable for the X-axis during 
data collection. Page 8-11.

Parameter Files Directory Allows you to specify a location for the parameter files used 
in the Basic sample file editor. Page 8-11.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 8-12.
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Option Presentation

The sample editing dialogs for the ASAP 2050 analysis program may be presented in three 
modes: Restricted, Basic, and Advanced. Each format displays sample information dialogs 
differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog as in an 
index card file. You just click on the tab of the desired parameter. This format also allows 
you to switch to the Basic mode.

• Basic: displays all parts of the sample file as a single dialog. in which you select from pre-
defined parameter files. This format also allows you to switch to the Advanced mode if 
editing of parameters is desired.

• Restricted: displays in the same manner as the Basic format. Certain menu options, how-
ever, become disabled and you cannot switch to the Advanced mode. You also must enter 
a password to access and exit this format.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens its associated dialog. For example, if you are using the Advanced format and you 
open or create a sample information file, the following dialog is displayed. 
. 

The Advanced format can be used to edit sample parameters and customize files.
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Basic

The Basic format presents the sample information file and its parameter files as a single 
dialog. You also have access to all menu options. For example, if you are using the Basic 
format and open or create a sample information file, the dialog is displayed in this manner.

The Basic format is used to quickly create sample information files using previously defined 
parameter files. You also can switch easily to the Advanced format to view or edit details of 
parameter files.

Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled. 
You also cannot switch to the Advanced format. This format is password-protected and 
typically is used in laboratories where analysis conditions must remain constant, for example, 
in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed.

You can enter any password (up to 31 characters) to enable the Restricted mode. You must 
enter the same password to exit the Restricted mode. For example, if you enter “password” to 

                Predefined parameter
                files are selected from
                drop-down lists
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enable the Restricted format, then you must enter “password” to exit. If you forget the 
password, open the application INI file and navigate to the Private section. The current 
password is shown immediately following “OptionPresentationPassword.” Make a note of the 
password, exit the INI file, and enter the password where requested. Deleting the password 
from the INI file will not disable the Restricted mode; you must enter the password using the 
Password dialog to exit the Restricted format.

Sample Defaults

Sample defaults are the values you see in the sample information editors when you create a 
new sample file. This option allows you to specify the default values. This feature makes it 
easy for you to apply the same conditions to many samples. 

For efficiency, it is best to specify defaults for materials you most commonly analyze. You can 
always edit the values in the sample file when it is created. Sample defaults can be specified 
using the Basic or Advanced format. 

The analysis program contains one complete default sample information file. When you select 
Open, Sample information from the Main Menu, a new file with these default values is 
generated. Default files for degas conditions, analysis conditions, adsorptive properties, and 
report options also are included. Appendix F, Default Files and System Files lists details on 
system default files.

Sample defaults can be specified using the Advanced or Basic format. The Advanced or Basic 
format is chosen by selecting Options > Option presentation from the main menu.

Basic Format

When you select Sample Defaults using the Basic format, the Basic Sample Defaults dialog is 
displayed.
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Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open 
> Sample information.

Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Use up to eight characters.
• Do not use characters such as * or ?. 

Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

The field on the left allows you to specify a name for the 
identification label. For example, you may prefer to use Test 
or Material.

The field on the right allows you to specify a format for the 
sample identification. 

Use numbers, letters, or other printable characters, such as 
dashes.

• Use up to 20 characters for the prompt.

• Use up to 43 characters (including the $ symbol).

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

   Lab #25 - 000-002, and so on.
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Mass Enter a value that represents the approximate mass of your 
most commonly analyzed material. You can enter a more 
accurate value in the sample file when the analysis is 
completed.

Density The sample density is used when using a calculated free 
space. The default value is appropriate unless you typically 
use a calculated free space. This field can always be edited 
in the sample file.

Sample Tube
Degas Conditions
Analysis Conditions
Adsorptive Properties
Report Options

Each parameter has a drop-down list containing files 
included with the software, as well as any you may have 
created and saved to the Parameter Files Directory. 

Choose from the list provided for each parameter the file you 
wish to use as the default.

Replace All Use this push button to replace the current default values 
with those from an existing sample file.

Save Saves the current definition as the defaults

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format.
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Advanced Format

When you select Sample Defaults while using the Advanced format, the Advanced Sample 
Defaults dialog is displayed.

The defaults you specify for the parameters in the Advanced format display as the 
defaults for newly created standalone parameter files

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open 
> Sample information.

• Use numbers, letters, or other printable characters, such 
as dashes. At least three numbers must be included.

• Use up to eight characters.

• Do not use characters such as * or ?. 
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Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

The field on the left allows you to specify a name for the 
identification label. For example, you may prefer to use Test 
or Material.

The field on the right allows you to specify a format for the 
sample identification. 

• Use numbers, letters, or other printable characters, such 
as dashes.

• Use up to 20 characters for the prompt.

• Use up to 43 characters (including the $ symbol).

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

       Lab #25 - 000-002, and so on.
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Operator
Submitter

These fields contain the name (or other identification) of the 
operator and submitter. 

The fields on the left can be edited to display a different label 
if desired.

The fields on the right allow you to specify default names or 
titles.

• Include the automatically generated file number as part 
of the identification by using the symbol $ where you 
want the sequence number to appear. Refer to the exam-
ple in the previous section.

• Use up to 20 characters for the prompt.

• Use up to 43 characters (including the $ symbol).

• Omit either (or both) item entirely from the sample infor-
mation file by selecting Omit.

Mass Enter a value that represents the approximate mass of your 
most commonly analyzed material. You can enter a more 
accurate value in the sample file when the analysis is 
completed.

Type of Data Choose whether you wish to enter data or have it collected 
automatically by the system.

Comments Use this window to enter sample characteristics, analysis 
conditions, etc. Anything you type in this window is printed 
in the report header.

Replace All Use this push button to replace the current default values with 
those from an existing sample file.

Save Saves the current definition as the defaults

Close Closes the dialog.

Basic Switches the sample editor to the Basic format.
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Units

This menu command displays the Unit Selections dialog which allows you to choose the 
manner in which to display data on the dialogs and reports. 

Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the 
Graph Grid Lines dialog is displayed.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
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Live Graph

This option enables you to choose the variable for the x-axis during data collection. You can 
also choose to correct for thermal transpiration (refer to page 5-31 for additional information 
on thermal transpiration).

Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions, Degas 
conditions, Adsorptive properties, and Report options files displayed in the drop-down lists on 
the Basic Sample Information dialog. The current directory is displayed above the drives/
directory window.

The default directory is params and includes several parameter files supplied with the analysis 
program. If you specify a different directory, these files will not be included in the drop-down 
lists unless you copy (or move) them to the new directory.

If you wish to continue using the params directory for parameter files, be sure to save any files 
you create to this directory(s).
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Service Test Mode

Various service tests are included in the ASAP 2050 operating program. These tests can be 
performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog prompting you to enter a 
password is displayed. This password is coded to change on a regular basis and is known only 
by your service representative. You will not be able to perform these tests without his 
guidance. 
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9.  TROUBLESHOOTING AND MAINTENANCE

The ASAP 2050 system has been designed to provide efficient and continuous service. 
However, to get the best results over the longest period of time, certain maintenance 
procedures must be followed. This chapter includes troubleshooting information, 
recommended preventive maintenance procedures, and routine maintenance procedures. 

Troubleshooting

Most operational problems are caused by the following:

• Leaks (commonly around the sample tube O-ring at the analysis port)
• Sample weighing errors
• Use of too much analysis bath fluid in the Dewar at the start of an analysis
• Entry of incorrect system volume for analysis

Always check these first when expected analysis results are not obtained. Some common 
operational problems, which are not indicated on the computer screen, and their respective 
causes and solutions are provided in the following table. 

                 

What Happened Why What To Do

Analysis Dewar cannot 
be raised (or lowered).

Elevator that moves Dewar 
stuck in up position, down 
position, or somewhere in 
between.

Check for possible obstruction 
to elevator movement.

Vacuum pump system 
makes loud noise 
continuously.

Sample tube connector nut is 
loose.

Turn the connector nut 
clockwise to tighten. 
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What Happened Why What To Do

Vacuum pump system 
makes loud noise 
continuously.
(continued)

Sample tube fitting is loose. Tighten the fitting securely with 
a wrench. 

Sample tube O-ring is worn or 
cracked. 

Replace the sample tube O-ring. 
Refer to “Replacing a Sample 
Tube O-ring” on page 9-8.

No sample tube is loaded on a 
selected port. 

Make sure the port valve is 
closed. Install a plug or empty 
sample tube on the port.

A gas inlet valve is open while 
the vacuum valve is open.

Enable manual control, then use 
the instrument schematic to 
close the gas inlet valve. Refer 
to “Enable Manual Control” 
on page 6-24.

Vacuum gauge shows 
reading above 20 
µmHg, even after 
extended pumping 
through unrestricted 
valve with analysis or 
degas ports closed.

Vacuum pump oil is low, 
causing ineffective evacuation.

Add or change vacuum pump 
oil. Be sure to add oil to proper 
level according to indicator 
window on the pump. Refer to 
“Inspecting and Changing 
Vacuum Pump Fluid” on 
page 9-9.

No power to the vacuum pump. Check the pump power plug, 
power switch, and line circuit 
breaker.

Filter in the port being used is 
dirty.

Replace the port filter. Refer to 
“Replacing the Port Filters” 
on page 9-5.

Alumina in the oil vapor trap is 
holding moisture because it was 
not sufficiently dried before 
being added to the alumina trap.

Replace or dry the alumina. 
Refer to “Replacing the 
Alumina in the Oil Vapor 
Traps” on page 9-15.
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What Happened Why What To Do

Analysis valves cannot 
be operated.

Circuit was opened by the circuit 
breaker.

Push in the breaker button, 
located on the side of the 
instrument near the power 
entrance. If it will not stay in, 
contact appropriate service 
personnel.

Cable from the computer to the 
analyzer is loose.

Make sure the cable is connected 
properly to the computer and the 
analyzer.

 
Breaker button
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Preventive Maintenance

The table below lists the preventive maintenance procedures you should complete to keep 
your analyzer operating at peak performance. Instructions for each procedure follow the table. 
Micromeritics also recommends that you have preventive maintenance procedures and 
calibration performed by one of our service representatives every 12 months.

Maintenance Required Frequency

Check and clean analysis port Dewars, page 9-5 Weekly

Replace port filters, page 9-5 Every 30 days

Clean the outside of the analyzer, page 9-8 As required 

Replace sample tube O-ring, page 9-8 As required or every 3 months

Inspect and change vacuum pump fluid, page 9-9 As required or every 3 months

Replace alumina in oil vapor traps, page 9-15 As required or every 3 months

Clean cold trap glass tube, page -21 As required or every 3 months

Lubricate elevator screw, page 9-24 As required or every 6 months

Check outgassing rate and test for leaks, Appendix D As required or every 6 months

Replace vacuum pump exhaust filter, page 9-25 As required or every 12 
months

Zero transducer pressure gauge, page 9-27 As required or every 12 
months

Calibrate transducer pressure scale, page 9-28 As required; should be 
performed by qualified service 
personnel

Calibrate manifold temperature sensor, page 9-29 As required; should be 
performed by qualified service 
personnel

Calibrate system volume, page 6-19 As required; should be 
performed by qualified service 
personnel
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Checking and Cleaning the Analysis Port Dewars

Ice and suspended frost particles may accumulate in the bottom of an analysis port Dewar. 
Particles or deposits exceeding 1/4 in. (0.64 cm) in depth may jam between the bottom of the 
sample tube and the bottom of the Dewar, causing the Dewar not to raise fully. Accumulations 
of fine particles impede liquid nitrogen circulation around the bottom of the sample tube. This 
causes the sample temperature to be slightly higher which, in turn, can cause pore volume 
measurement errors in those samples exhibiting high isotherm slope above 0.97 relative 
pressure. 

To ensure problems do not develop due to ice accumulation, check the Dewar after each use. 
Clean Dewars on a weekly basis as follows:

1. Remove the Dewar and pour the liquid nitrogen from the Dewar into an appropriate 
cryogenic container.

2. Rinse the Dewar with warm water to melt any ice accumulation which may remain in the 
Dewar, then dry thoroughly.

Replacing the Port Filters

A porous metal filter is located in each analysis and degas port. If a degas port is not plugged 
with either a sample tube or a port plug then the filter will absorb atmospheric gases, resulting 
in extended degassing time for samples on that port. 

Using a contaminated filter on an analysis port may extend the time required to achieve a 
vacuum at that port. More importantly, the contaminant may adsorb or desorb during analysis, 
affecting the analysis results. A contaminated filter on an analysis port may cause a leak test to 
fail (if the contaminant outgasses) or cause a free-space reading to be much lower than normal.

When handling Dewars, be sure to observe the Dewar precautions described on 
page 3-24.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes 
to burst.
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Analysis Ports

1. Using a wrench, remove the analysis port fitting from the analyzer.

2.  Remove the filter and O-ring.

3. Using latex gloves, replace with a new filter and O-ring. 

Before removing and installing a port filter, ensure that the port valve is closed. 
Observe the analysis system schematic to verify valve status.

Analysis port
fitting

   O-ring

     Filter

To avoid analysis problems, the new filter and O-ring must be clean. Do not 
touch them with bare hands.
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4. Reinstall the analysis port fitting; securely tighten with a wrench to prevent leaks during 
evacuation.

Degas Ports

1. Using a wrench, remove the degas port fitting.

2.  Remove the O-ring and filter. 

3. Replace the filter and the O-ring. 

4. Reinstall the degas port fitting; securely tighten with a wrench to prevent leaks during 
evacuation.

Before removing and installing a port filter, ensure that the port valve is closed. 
Observe the degas system schematic to verify valve status.

Degas port fitting

O-ring

Filter

To avoid analysis problems, the new filter and O-ring must be clean. Do not 
touch them with bare hands.
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Cleaning the Analyzer

The ASAP 2050 should be cleaned as required. 

Clean the outside casing of the analyzer (including the shields) with a clean cloth dampened 
with isopropyl alcohol (IPA), a mild detergent in water, or a 3% hydrogen peroxide solution. It 
is not necessary to remove any switches or screws to clean the outside casing.
 

Replacing a Sample Tube O-ring

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an 
O-ring becomes worn or cracked, it does not provide a good seal and will need to be replaced. 

1. Remove the O-ring from the top of the sample tube. 

2. Slide a new O-ring over the sample tube. 

Use a mild detergent in water or isopropyl alcohol to clean the shields. Avoid using 
acetone because it will damage the surface of the shields.

O-ring 
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Inspecting and Changing Vacuum Pump Fluid

The fluid in the vacuum pump should be changed every three months or when the efficiency of 
the vacuum pump declines (requiring increased time to reach vacuum levels). The fluid can 
first be inspected to determine if a change is necessary.

Use oil supplied by Micromeritics, or refer to the vacuum pump manual for other acceptable 
oils.

Inspecting Fluid

1. Choose one of the following to view the vacuum pump sight window.

a.  Remove the four screws located along the sides of the vacuum pump panel, then 
remove the panel.

b.  Remove (or fold over to the right) the protective rubber mat on the lower front panel, 
then lift off the metal cover; this exposes the vacuum pump sight window.

2. View the vacuum pump fluid through the sight window. Fluid in good condition is clean, 
clear or light in color, and transparent. If the color of the fluid is darkened, the fluid should 
be changed. 

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with 
an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent) 
pump fluid. Failure to use the proper vacuum system could result in hazardous 
conditions including fire and personal injury.

Make sure the pump is running when inspecting fluid.
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If the fluid is just above the lower level indicator mark, fluid should be added.

Adding Fluid

1. If the front panel has not been removed, remove the four screws located along the sides of 
the vacuum pump panel, then remove the panel.

2. Remove the oil-fill plug from the vacuum pump.

Oil-level window

Level indicator mark

Oil-fill port

Adding fluid above the midway position on the fluid level mark may cause fluid to 
splash into the vacuum hoses and leak from the vacuum pump.
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3. Add fresh fluid to the oil-fill port until the level is midway between the indicator marks in 
the pump sight window.

4. Check the washer or O-ring used at the oil-fill port; replace if necessary. 

5. Replace the oil-fill plug.

Changing Fluid

1. Place the analyzer ON/OFF switch in the OFF position.

2. If the vacuum pump panel is not already removed, remove the four screws located along 
the sides of the panel, then remove the panel. 

3. Disconnect the vacuum pump from the power source.

        

    

  Level indicator marks

Always drain the vacuum pump while the pump is warm and disconnected from 
the power source.
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4. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open 
and remove the trap from the hose.

5. Grasp the handle on top of the vacuum pump and lift it out of the analyzer; place the 
vacuum pump on a work table.

Disconnect hose

Clamp wing-nut

Oil-vapor trap
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6. Drain the used oil: 

a. Place a waste container under the drain spout.

b. Remove the plug from the drain spout.

c. Allow the oil to drain into the waste container.

d. Replace the drain plug.

7. Remove the oil-fill plug.

8. Add fresh fluid to the oil-fill port until the level until the level is midway between the two 
indicator marks in the pump sight window.

9. Check the washer or O-ring used at the oil-fill port; replace if necessary. 

10. Replace the oil-fill plug.

        

    

  

Drain plug

Oil-fill port

Adding fluid above the midway position on the fluid level indicator marks may cause 
fluid to splash into the vacuum hoses and leak from the vacuum pump.
Jul 07                                               9-13 



Preventive Maintenance ASAP 2050 Operator’s Manual
11. If the fluid was badly contaminated (dark brown color), flush the pump with fresh fluid as 
follows:

a.  Cover the top of the oil vapor trap.

b.  Plug the pump power cord into a power source and run for about 2 minutes.

c.  Unplug the power cord.

d.  Remove the plug from the drain spout.

e.  Allow the oil to drain into the waste container.

f.  Reinstall the drain plug.

g.  Add fresh fluid to the oil-fill port until the level is midway between the two indicator 
marks.

h.  Reinstall the oil-fill plug.

i.  Repeat steps a through h if necessary.

12. Check the alumina in the oil vapor trap and replace if necessary (refer to “Replacing the 
Alumina in the Oil Vapor Traps” on page 9-15).

13. Place the vacuum pump back onto the drip tray in the analyzer.

14. Reconnect the vacuum pump hose.

15. Reconnect the power cord to the power source.

16. Reinstall the front analyzer panel.

17. The pump must run a few hours (or overnight) to eliminate air and moisture from the fresh 
fluid and to produce efficient vacuum operations.
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Replacing the Alumina in the Oil Vapor Traps

The activated alumina in the oil vapor traps becomes saturated during use. The alumina should 
be replaced if either of the following conditions exist:

• The alumina has been used for a three-month period.
• Most of the alumina pellets are no longer white.

1. Prepare fresh alumina as follows:

a. Heat an oven between 250 °C and 350 °C.

b. Pour about 180 grams of alumina into a glass or metal container for each trap 
(approximately 250 mL if a graduated beaker is used). Place the container in an oven. 

c. Bake the alumina for two hours; turn off the oven.

d. Allow the alumina to cool in the oven before pouring it into the traps.

Alumina

Oil vapor trap 

Do not perform the following procedure on used alumina. The resultant oil 
vapors may cause a fire or an explosion.
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2. Select Unit [n] > Enable Manual Control. If the analysis schematic is not displayed, 
select Unit [n] Show Instrument Schematic to display the schematic in manual mode.

3. Open the analysis vacuum valve: Valve 1. Make sure all other valves are closed.

4. Select Unit [n] > Degas > Enable Manual Control. If the degas schematic is not 
displayed, select Unit [n] > Degas > Show Instrument Schematic to display the 
schematic in manual mode.

5. Open the degas vacuum valve: D5.

6. When the pressure stabilizes around atmospheric pressure, close all valves. 

7. If the vacuum pump panel is not already removed, remove the four screws located along 
the sides of the panel, then remove the panel. 

8. Unplug the pump power cord. 
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9. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open 
and remove the trap from the hose.

10. Remove the pump from the analyzer for easier access, if you wish.

11. Loosen the wing nut on the clamp at the bottom of the oil vapor trap. Swing the clamp 
open and remove it. 

12. Remove one end fitting from the trap body.

13. Remove the used alumina from the trap body and dispose of it in an appropriate manner.

Disconnect hose

Clamp wing-nut

Oil-vapor trap

Oil vapor trap 

     End fitting

    Wing nut
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14. If the trap body interior appears oily or dirty, wash it with isopropyl alcohol or ethyl 
alcohol and dry it thoroughly.

15. Pour the new activated alumina pellets into the trap until they are level with the top of the 
trap body.

16. Insert the O-ring into the end fitting, screw the end fitting back onto the trap, then tighten 
securely by hand.

17. Make sure the centering ring is in place on the intake port.

Exposure of the trap body to oil vapor may cause small cracks on the inside surface 
of the trap body. Under normal circumstances, these cracks will not cause problems 
or leaks.

Ensure adequate ventilation when using solvents for cleaning purposes.

Centering ring

O-ring

    End fitting
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18. Place the trap on the centering ring.

19. Open the clamp and place it around the flange of the intake port and the flange of the trap. 
Swing the clamp fastening screw toward the intake port until it fits into the slot in the 
other half of the clamp. Tighten the wing nut securely by hand.

20. If you removed the pump from the analyzer, place it onto the drip tray in the analyzer.

   Oil vapor trap

      Centering ring

  Intake port
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21. Reconnect the hose from the analyzer to the oil vapor trap using the clamp and wing nut.

22. Plug the pump power cord into the power source.

23. Reinstall the front panel on the analyzer.

Tighten clamp to attach
trap to hose
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Cleaning the Cold Trap Tubes

Oil vapor from the vacuum pumps accumulates in the cold traps. The tubes on the cold trap 
ports should be cleaned as follows:

1. Remove the vacuum pump panel.

2. Disconnect both vacuum pump power cords from their power sources.

3. Select Unit [n] > Instrument Schematic; then select Unit [n] > Enable Manual 
Control.

4. Open analysis valves in the following order: P1, PS, 5, 7, and 1. Allow the pressure to 
stabilize until around atmospheric. Then, close the valves in the same order as they were 
opened. This step fills the analysis vacuum section before disconnecting.

5. Select Unit [n] > Degas > Degas Schematic; then select Unit [n] > Degas > Enable 
Manual Control.

6. Open degas valves in the following order: D5 and D7. Allow the pressure to stabilize until 
around atmospheric. Then, close valve D7 and D5. This step fills the degas vacuum 
section before disconnecting.
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7. While holding the tube, remove the connector nut from the degas cold trap port.

8. Carefully slide the glass tube down over the metal tube and remove the glass tube.

9. Remove the connector nut from the other cold trap port and remove the metal tube. 

10. Inspect the O-rings. If an O-ring is cracked or worn, it should be replaced.

11. Rinse the tubes with acetone; then dry them. 

The connector nuts must be reinstalled on the port from which they were removed. 
They are not interchangeable.
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12. Slide the O-rings over the top of the tubes.

13. Reinstall the cold trap tubes and tighten the connector nuts. Make sure you use the correct 
connector nut on each port.

14. Reconnect the vacuum pump power cords.

15. Replace the vacuum pump access panel.

O-ring

Connector nut

  O-ring

       Connector nut
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Lubricating the Elevator Screw

1. Remove the analyzer’s back panel by loosening, then removing the retaining screws.

2. Apply a light coat of lithium grease to the elevator screw.

3. Replace the back panel.                                    

Checking Outgassing Rate and Testing the Analyzer for Leaks

Refer to Appendix D TESTING THE ANALYZER FOR LEAKS for instructions on 
checking ASAP 2050 outgassing rates and testing for leaks.

Elevator screw 
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Replacing the Vacuum Pump Exhaust Filter

The gases used by the ASAP 2050 are exhausted by vacuum pumps. An exhaust filter is 
installed on the exhaust port of each vacuum pump. The filter minimizes the release of oil 
vapor and should be replaced when it becomes so saturated with oil that it is ineffective. 

1. Remove the four screws located along the sides of the vacuum pump panel, then remove 
the panel. 

2. If you wish to remove the vacuum pump from the analyzer, refer to steps 1 through 5 
under “Adding Fluid” on page 9-10.

Exhaust filters are used on the vacuum pump to minimize the release of oil vapors. 
The gases used are diluted substantially upon being released from the vacuum 
pumps. However, it may be desirable in some locations to provide a fume hood for 
added protection from hazardous gases and vapors released into the work area.

 

Vacuum pump 
exhaust filter
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3. Loosen the wing nut of the clamp at the vacuum pump exhaust port. Swing the clamp 
away from the exhaust port and remove it.

4. Discard the oil filter.

5. Retain the centering ring, clamp, and wing nut.

6. Remove the dust cover from the new filter.

7. Make sure the centering ring is on the exhaust port.

8. Place the new filter on the centering ring.

9. Open the clamp and place it around the flange of the exhaust port and the flange of the 
exhaust filter. Swing the clamp fastening screw toward the exhaust port until it fits into the 
slot in the other half of the clamp. Tighten the wing nut securely by hand.

10. If you removed the vacuum pump from the analyzer, place it back onto the drip tray in the 
analyzer, reconnect the hose, then reinstall the vacuum pump panel.

 Clamp

Exhaust Port

 Wing Nut

Filter
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Calibrating the Pressure Gauge

When operating the system in manual mode Calibration, pressure gauge enables you to 
evacuate the manifold and zero the transducer. 

The system automatically zeros the transducer before an analysis begins. Therefore, you do 
not need to use this feature unless you are operating the system in manual mode.
Perform the following steps to calibrate the pressure gauge:

1. Select Unit > Calibration > Pressure gauge; the Calibrate Pressure Offset dialog is 
displayed.

.
2. Click Start to evacuate the manifold and zero the pressure gauge(s). 

3. When the calibration is complete, click OK to close the dialog.

You may cancel a calibration at any time by selecting Cancel. If you cancel a 
calibration, no new calibration data are saved.
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Calibrating the Pressure Scale

Calibration, Pressure scale allows the software to adjust the gain of the selected transducer to 
match a reference standard.

1. Attach a reference pressure gauge to the sample port of the analyzer.

2. With manual control enabled:

a. Dose the manifold with helium or nitrogen to 5200 to 7500 mmHg.

b. Open the sample port to expose the reference pressure gauge to the same pressure as 
the analyzer’s transducer.

3. Select Unit > Calibration > Pressure scale; the Calibrate Pressure Scale dialog is 
displayed.

4. Select Match to entered pressure.

5. Enter the pressure reported by the reference pressure gauge, then click OK.

6. Close the sample port and evacuate the manifold.

7. Remove the reference pressure gauge.
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Calibrating the Manifold Temperature Sensor

You should calibrate the manifold temperature on an annual basis. This allows you to correct 
for any changes in the manifold temperature sensor that occur with time. 

You will need a small diameter probe, such as a 1/16-in. (1.5-mm) thermocouple to calibrate 
the manifold temperature sensor.

1. Insert the thermocouple probe into the opening located to the left of the analysis port.

2. Move the thermocouple back and forth until you locate the small opening on the underside 
of the manifold. Push the thermocouple into the opening until the thermocouple stops.

3. Allow the temperature gauge reading to stabilize.

4. Select Unit > Calibration > Temperature; the Calibrate Manifold Temperature dialog is 
displayed. 

5. Enter the manifold temperature indicated on the reference temperature gauge. Click OK to 
store the new value.

6. Remove the thermocouple probe.

 Manifold Probe Hole (to the left of the analysis port)

Analysis port
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Routine Maintenance

The procedures in this section are performed as needed.

Changing Gases

Guidelines for Connecting Gases to the Analyzer

Use these guidelines when installing regulators and gas lines:

• Ensure that all gases needed are available and near the instrument. If the gas bottles are not 
located near the instrument, you will have to use gas line extenders, which may degrade 
gas quality and reduce pressure.

• Use a retaining strap (or other appropriate tether) to secure the gas bottle.

• Carefully route the gas lines from the bottle to the analyzer, avoiding overlapping or 
entangling gas lines. This will ensure the correct gas pressure and make maintenance 
easier.

• Label both ends of the gas lines before connecting for ease in identification and 
maintenance.

• Ensure that all gas bottles are closed before connecting them to the analyzer.

Retaining strap
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The instructions below describe a typical installation. Some configurations require additional 
components, such as regulator expansion kits, when one gas source will be used for several 
operations or when the gas bottle cannot be located close to the analyzer.

Connecting a Gas Regulator to the Gas Supply

1. Disconnect the gas bottle you are replacing:

a. Turn the gas bottle Shut-Off valve clockwise to close.

In order to use oxygen with the ASAP 2050, your 2050 analyzer must be equipped with 
an oxygen-compatible vacuum pump that uses Fomblin® (or a suitable equivalent) 
pump fluid. Failure to use the proper vacuum system could result in hazardous 
conditions including fire and personal injury.

Dual-stage regulators must be used for all gas supplies.

These instructions apply to connecting inert gases only. When connecting hazardous 
gases, follow the safety procedures used by your lab.
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b. Disconnect the gas line from the regulator and allow the regulator line to purge. You 
will hear gas vent.

It is not necessary to disconnect the gas line from the instrument.

2. Turn the regulator Shut-Off valve counterclockwise to open (more gas will vent).

3. Turn the Pressure Control knob clockwise to open and vent any remaining gas; both 
gauges should then read approximately zero.
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4. Close the Pressure Control knob.

5. Use an appropriate wrench to loosen the nut at the regulator connection, then remove the 
regulator from the gas bottle.

6. Replace the protective cap, disconnect the retaining strap, and move the gas bottle to an 
appropriate location.

                                                

      Depleted Bottle

Use caution when transporting gas bottles.
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7. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas 
bottle.

Place the protective cap in a secure location. You will need it to recap the gas bottle when 
it is depleted and replaced.

8. Attach the gas regulator to the connector on the gas bottle. Hand-tighten the nut. Use an 
appropriate wrench to tighten it an additional 3/4 turn.

    New Bottle

Do not overtighten the fittings. Doing so could cause a leak.
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9. Check for leaks in the high-pressure side of the regulator and in the connector.

a.  Turn the regulator control knob fully counterclockwise.

b.  Slowly open the gas bottle valve, then quickly close it.

c.  Observe the pressure on the high-pressure gauge for approximately one minute.

If the pressure decreases, tighten the regulator connector nut until it becomes stable.

If the pressure does not remain stable, remove the regulator and clean all contacts at the 
regulator connection. Then reinstall the regulator.

10. Perform the following steps to purge air from the lines:

a.  Open the gas bottle valve to pressurize the regulator, then close the valve.

b.  Adjust the Pressure Control knob to approximately 5 psi (34 kPa).

b

a
c

a

b
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c.  Turn the regulator shut-off valve counterclockwise to open.

d.  Allow gas to flow until both gauges read approximately zero.

e.  Close the regulator shut-off valve to stop gas flow.

11. Reconnect the gas line to the regulator.

12. Use two 7/16-in (11-mm) wrenches to tighten the gas line connection; one to hold the 
fitting steady and one to tighten the connector nut.

c

d

e
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13. Set the instrument pressure:

a. Turn the regulator control knob clockwise until the low-pressure gauge indicates 150 
psig (1034 kPag)

b. Open the regulator shut-off valve.

c. Open the gas bottle valve and flow gas for 10 to 30 seconds.

d. Close the regulator shut-off valve.

e. Close the gas bottle valve.

14. If you disconnected the gas line from the instrument, proceed to Connecting the Gas 
Delivery Tubing to the Analyzer in the next section.

15. If you changed to a different type of gas, you must specify the change in the analysis 
program; refer to Specifying Gas Ports.  

Low-Pressure gauge
a

c

d

eb
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Connecting the Gas Delivery Tubing to the Analyzer 

The gas inlet ports are located on the right side panel of the analyzer. The ports are labeled 
Physi 1 through 6, Degas Backfill and Freespace Helium.

To change the gas attached to one of the ports:

1. Make sure the port valve is closed (refer to “Enable Manual Control” on page 6-24).

2. Detach the gas line from the desired port.

3. Attach the new gas line to the port.

4. Make sure any unused gas inlet ports are plugged.

5. Record the gas installed in the port in the analysis program as described in the following 
section.

Specifying Gas Ports

When you change the gas attached to a port on the analyzer, you must enter the change in the 
analysis program as follows.

1. Select Unit 1 > Unit Configuration from the main menu. The Unit Configuration dialog 
is displayed.

2. Click Gas. The Gas Configuration dialog is displayed.

Gas inlet ports

Vapor gas port

Freespace Helium port

Not used

Degas backfill port
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3. Click on the down-arrow at the port to which you attached a gas line and choose the 
appropriate gas.

4. Click OK to close the dialog, and then click OK again to close the Unit Configuration 
dialog.

Performing a Reference Material Analysis

When you have doubts about the integrity of analysis data or when you would just like to 
ensure the highest quality data, perform a reference analysis. Reference Material Kits are 
available from Micromeritics (refer to Chapter 10, ORDERING INFORMATION). Each kit 
contains reference material and an instruction booklet. Follow the instructions in the booklet to 
perform the analysis and review the results.
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10.  ORDERING INFORMATION

The ASAP 2050 system components and accessories can be ordered using one of the 
following methods: 

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided in this chapter to place your order:

Analysis System Components and Accessories

Part Number Item and Description

Peripheral Accessories

060-00030-00 FlowPrep 060, degasses up to six samples at up to 400 ºC with 
flowing gas.

061-00030-00 VacPrep 061, degasses up to six samples at up to 400 ºC with either 
flowing gas or by evacuation (evacuation requires a vacuum pump).

021-00000-00 Model 021 LN2 transfer system, for easy filling of sample Dewars; 
includes 47-L Dewar, mobile platform, and pump with 100-cm 
discharge line.

202-33050-00 Water vapor option; allows water vapor adsorption studies.

System Components

202-25849-00 Dewar, 3 liter, cold trap

202-25850-00 Dewar, 3 liter, analysis

200-25928-00 Dewar, 1 liter, analysis (wide mouth)

202-33053-00 Stainless Steel Dewar Kit, 4 liter, wide mouth, includes analysis 
Dewar, cold trap Dewar, and elevator adapter

240-25901-00 Dewar depth gauge

202-31708-00 Dewar cover, cold trap

202-31707-00 Dewar cover, analysis

200-25929-00 Dewar stopper, sample port, 1-liter Dewar

004-25103-00 Ferrule, front, Teflon 1/4 in.
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Part Number Item and Description

004-25104-00 Ferrule, rear, Nylon 1/4 in.

290-25846-00 Copper tube, for gas inlet, 1/8-in. diameter, 6 ft (1.8 m) long.

290-25846-01 Same as 290-25846-00, but uses 16-ft. (5m) tubing

004-25549-00 Reducer, 1/8-in. tube x 1/4-in. tube, accepts 1/8-in. tube, connects to 
1/4-in. swage fittings

004-62230-35 Gas pressure regulator, CGA 350 fitting (CO, H2), 30 psig

004-62230-54 Gas pressure regulator, CGA 540 fitting (O2), 30 psig

004-62230-326 Gas pressure regulator, CGA 326 fitting (N2O), 30 psig

004-62230-705 Gas pressure regulator, CGA 705 fitting (NH3), 30 psig

004-62230-58 Gas pressure regulator, CGA 580 fitting (He, N2, Ar), 30 psig

004-62230-32 Gas pressure regulator, CGA 320 fitting (CO2), 30 psig

004-62250-320 Gas pressure regulator, CGA 320 fitting (CO2), 250 psig

004-62250-350 Gas pressure regulator, CGA 350 fitting (CO, H2), 250 psig

004-62250-540 Gas pressure regulator, CGA 540 fitting (O2), 250 psig

004-62250-580 Gas pressure regulator, CGA 580 fitting (He, N2, Ar), 250 psig

004-33601-00 Expansion Kit; adds an additional outlet to the gas regulator, includes 
fittings and instructions

004-33602-00 Pressure Relief Kit, 35 psig, prevents excessive gas pressure in the event 
of regulator failure (not to be used with noxious gases or with 150 psig gas 
lines)

003-26046-00 Heating mantle with type K thermocouple, 450 ºC maximum, 24 V, with 
elastic hanger.

230-25808-00 Heating mantle clip

205-42801-00 Operator’s manual

004-25006-00 O-ring, size 006, Buna-N, for Po tube

004-16843-00 Reference material, 13x molecular sieve

004-16821-00 Reference material, Surface Area ~215 m2/g, PV ~0.6cc/g

004-54609-00 Sample tube brush

240-25853-00 Sample tube funnel

240-14855-00 Sample tube rack
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Part Number Item and Description

004-54618-00 Tool, for removing sample tube O-ring

200-25840-00 Saturation pressure tube, includes isothermal jacket

250-25608-00 Valve gasket, Kel-F, for analysis manifold

004-25459-00 Valve plunger, Kalrez seal, for analysis manifold

250-25602-00 Valve spring, for Kalrez plunger, for analysis manifold 

Vacuum System Components

062-00001-11 Vacuum pump, oil-sealed, with built-in anti-suckback valve, 110/120 
VAC; includes hose kit and alumina oil vapor trap

062-00001-23 Vacuum pump, oil-sealed, with built-in anti-suckback valve, 220/240 
VAC; includes hose kit and alumina oil vapor trap

004-16003-01 Vacuum pump oil, 1 liter (not for use with oxygen-compatible pump)

062-33002-00 Activated alumina oil vapor trap, for one vacuum pump

062-00002-11 Vacuum pump, Inert fluid for oxygen use, 110/120 VAC

062-00002-23 Vacuum pump, Inert fluid for oxygen use, 220/240 VAC

004-16009-00 Fomblin® YL-VAC 14/6 inert fluid for vacum pumps that are 
pre-conditioned for oxygen use

200-25879-00 Vacuum pump oil funnel

004-27040-00 Vacuum pump exhaust filter

004-16830-00 Activated alumina, 500 grams, for oil vapor trap

004-25652-00 O-ring, size 217, for oil vapor trap

Software

202-33025-00 Isotherm Cycling; allows you perform up to 500 adsorption/ 
desorption cycles over a user-defined range. Includes software and 
operating instructions.

205-33001-00 Software package, ASAP 2050; includes current version of software 
and operator’s manual.
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Sample Tubes and Components

      A
 

 C

 

  D

 E

F

B

Part Number Item and Description

Sample Tubes and Components

205-25802-01   A Seal Frit with built-in check valve for air-sensitive samples

004-25474-00   B O-ring, size 013, Kalrez for sample tube

205-25807-00   C Sample tube

300-25824-00   D Nut, sample tube

240-32000-00   E Stopper, for sample tube

205-25815-00   F Isothermal jacket, for sample tube
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Cold Trap Tubes and Components

AA

 B C

 D E

Part Number Item and Description

Cold Trap Tube and Components

004-25469-00 A O-ring, Buna-N, size 014, for glass or stainless-steel cold trap

004-25979-00 B Nut, for glass cold trap

205-25808-00      C Nut, for stainless-steel cold trap

004-61063-00 D Tube, 1/2-in. OD stem, cold trap, glass

205-25806-00      E Tube, 1/2-in. OD stem, cold trap, stainless-steel
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A.  ASAP SERIES SAMPLE DATA WORKSHEET

This form is provided to assist you in obtaining an accurate sample mass for report calculations. 
You may use the After Degas value (Step 5) or the After Analysis value (Step 7), provided they 
are close to the same. 

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step 
5). These two values should be close in range. If a significant difference is noted, analysis 
problems may exist or the sample may have been improperly degassed.

Sample tube:_____________________              Sample: _______________________________

Before Degas:

1. Mass of empty sample tube ________ (g)

2. Mass of sample tube plus sample ________ (g)

3. Mass of sample (Step 2) – (Step 1) ________ (g)

After Degas:

4. Mass of sample tube plus sample ________ (g)

5. Mass of sample (Step 4) – (Step 1) ________ (g)

After Analysis:

6. Mass of sample tube plus sample (g) ________ (g)

7. Mass of sample (Step 6) – (Step 1) ________ (g)
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B.  ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your 
service representative, record the error message and make backup copies of any files involved 
in the operation.

2200 and 2400 Series

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message).

2430- Error accessing file (file name), error code = (number). 

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: Start Report failed to execute the report subsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application 
(this will not affect any of your sample files). If the problem continues, 
contact a Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433-  New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) — Subset # (number) wrote wrong amount of data.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to a diskette, CD, or 
network directory, delete them from the hard disk, and then try the 
operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several ASAP 2050 files (sample information, analysis conditions, 
adsorptive properties, or report options) have been added to this direc-
tory by some function other than the ASAP 2050 program.

Action: Select Yes to update the directory information with data from each new 
file. This operation may take a minute.

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter. 

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the disk is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories: list to move to the correct directory.
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2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your DOS or Win-
dows manual and re-enter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message. 

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.
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2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460-  Fatal Communications error on (unit nn).

2461- No instruments are in operation. This application will unconditionally 
terminate.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be stopped.

Action: Wait a few minutes before attempting to exit the application again.

Cause: You attempted to exit the application while the analyzer was perform-
ing an operation.

Action: Rather than exiting the application you may choose to minimize it.

Cause: Repeated attempts to maintain communication with the analyzer have 
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the status light is 
not blinking. 

If these checks are okay, exit the analysis program and then restart the 
application. If this error persists, contact your service representative.

Cause: At least one analyzer must be active for the application to operate. The 
initialization of the analyzers configured with the Setup program has 
failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 
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2471-  Unit (number) - S/N; (number) has an invalid communications port specified. It 
cannot be initialized.

2474-  Unit (number) Communications port COM (port number) specified in the pro-
gram control files is already in use. Unit cannot initialize.

2475-  Unit (number) Communications port COM (port number) specified in the pro-
gram control files cannot be accessed. Unit cannot initialize.

2476-  Unit startup failed. Cannot initialize the communications port.

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the analyzer has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the analyzer, contact your ser-
vice representative.

Cause: The communications port specified for this analyzer during installation 
(or configuration) is invalid.

Action: Use the setup program to change the analyzer configuration.

Cause: The communications port assigned to the indicated unit is in use by 
another program.

Action: End the program using the busy port or use the Setup program to 
change the communications port assigned to this program.

Cause: The operating system has prevented the application from accessing the 
communications port.

Action: Review the hardware configuration of the computer, ensure that no 
other application is using the port. Contact your service representative 
if you continue to receive this error message.

Cause: The communications port specified during installation is invalid.

Action: Use the setup program to change the analyzer configuration. Contact 
your service representative if you continue to receive this error mes-
sage.
B-6                                                    Jul 07



Appendix B ASAP 2050 Operator’s Manual
2477- Unit (number); Serial (number) did not properly initialize.

2478-  Error copying sequential data segment.

2479-  Unit (number); Serial (number) The instrument is busy performing an operation 
of which this application is unaware. Do you want to cancel? (Yes, No)

2480- File (file name) cannot be analyzed. It is currently being edited.

Cause: The software was unable to initialize the analyzer.

Action A: Run the Setup program and ensure that a valid port is specified; if not, 
specify a valid one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact your Micromeritics service representative if you continue to 
get this message.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. Contact your 
service representative if you continue to receive this error message.

Cause: During initialization of the application, the status of the analyzer was 
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process, allowing the analyzer to 
reset and continue with initialization.

Click No to cancel the initialization process.

If you continue to get this message, verify that files in the application 
directory structure are not being changed or removed.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog box.
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2481- Error accessing the sample information file (file name).

2482- File cannot be opened for writing. It is already in use.

2483-  An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C:  A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You are attempting to open a file that is currently being used (either by 
this application or another).   

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: You attempted to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: You attempted an analysis using a sample file that contains unsaved 
changes.
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2485- The service test file has an invalid status and cannot be used for this analysis.

2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

Action: Select Yes to save the changes and continue with the analysis. 

Select No to abort the analysis and return to the sample file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace 
All to copy parameters from the file you originally selected.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator and have him grant you full rights.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The ASCII (.INI) file containing initialization and system options 
information cannot be found. The .INI file may have become cor-
rupted. The application cannot operate without this file.
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2491- Highlighted fields contain errors. Please correct the errors before closing dia-
log box.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

Action: Use the Setup CD to uninstall the ASAP 2050 application. When you 
uninstall the application, only the application files are deleted; data 
files remain intact.

After the uninstall operation is complete, reinstall the ASAP 2050 
application.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog box until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog box

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.
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2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.
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2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (sample name).

2505- Error Logger cannot be initialized!  Error code (number). Program will exit.

Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this error message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.
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2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog 
box. Install the device using the Control Panel, Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.
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2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been cancelled.

2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.
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2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, press Accept.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the ASAP 2050 analysis program.
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2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the ASAP 2050 connected to the 
computer, select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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4000 Series

4000- Memory Allocation Error.

4002- Thermal Transpiration correction had no effect.

4003- Error Converting Pressures.
4004- Error Computing Volume Adsorbed.

4005- Pressures were not smoothed. Not enough pressures below 0.10 P/Po.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The Thermal transpiration correction option was selected on the Report 
Options dialog box. However, the correction did not change any pres-
sure by more than one percent. 

Action: De-select this option to disable this message. This correction is only 
meaningful for very low pressures.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The Smooth pressures below 0.10 P/Po option was selected on the 
Report Options dialog. There must be at least 10 pressures within this 
range for smoothing to occur.

Action: Deselect this option to disable this message.
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4006- Report Type Not Found.
4007- Error Processing Report.

4008- Report requested on sample file with no data points.

4009- Error, No Reports Selected.

4010- Summary Report was not included in the Selected Reports.

4011- Analysis gas in sample file does not match analysis gas in unit.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You selected a file for reporting which contains no collected data.

Action: Select another file which contains collected data and restart the report.

Cause: You attempted to generate reports for a sample that has no reports 
selected in its report options.

Action: Select the desired reports in the sample’s report options and save the 
sample file.

Cause: You did not select a plot or a table for any of the Selected Reports in 
the Report Options dialog; you selected the reports only to generate an 
entry in the summary. However, the Summary was not included in the 
Selected Reports.

Action: Select a plot or table in one or more of the Selected Reports, and/or add 
the Summary to the Selected Reports. 

Cause: You attempted to start an analysis using a sample information file in 
which the analysis gas specified does not match the analysis gas 
entered in the unit configuration.
B-18                                                    Jul 07



Appendix B ASAP 2050 Operator’s Manual
4012- Psat gas in sample file does not match Psat gas in unit.

4015- Error creating export file for sample <sample file name>.

4016- Sample (file name) has no data for export.

4017- Damage to the instrument will result if the sample has not been manually evac-
uated. Have you evacuated the sample?

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration dialog box. 

Cause: You attempted to start an analysis using a sample information file in 
which the Psat gas does not match the Psat gas entered in the unit con-
figuration.

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration dialog box. 

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory 
exists. Ensure that the target diskette is not full or write protected. The 
target disk drive may be damaged or inoperative. Verify that other files 
may be created on the same drive. Contact your service representative 
if you continue to receive this error message.

Cause: The file selected for export has a status of No Analysis. No export file 
will be created.

Action: Select a file which contains analysis data.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog box. The sample tube is normally at atmo-
spheric pressure when an analysis is started, and it must be backfilled 
before the analysis begins to prevent sample material from being 
drawn into the manifold.
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4020- Disabling this option may damage the instrument. Are you sure that the sample 
should not be backfilled?

4021- The entered Po value (Po and Temperature Options of the Analysis Conditions) 
is outside the range of the pressures listed in the Psat vs. Temperature Table (Adsorp-
tive Properties). 

4022- The entered bath temperature value (Po and Temperature Options of the Anal-
ysis Conditions) is outside the range of the temperatures listed in the Psat vs. 
Temperature Table (Adsorptive Properties). 

Action: If you have manually evacuated the sample tube, select Yes. If you 
have not, select No and then either perform a manual evacuation or go 
to the Sample Backfill Options dialog box and select Backfill sample 
at start of analysis.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog. The sample tube is normally at atmospheric 
pressure when an analysis is started; it must be backfilled before the 
analysis begins to prevent sample material from being drawn into the 
manifold.

Action: If you want to manually evacuate the sample prior to the start of the 
analysis, select Yes. Otherwise, select No, go to the Sample Backfill 
Options dialog, and select Backfill sample at start of analysis.

Cause: The temperature that corresponds to the entered Po cannot be found 
because the entered Po is outside of the range of values in the Psat vs. T 
table.

Action A: Enter a Po that is within the range of the table.

Action B: Use a different Psat vs. T table.

Cause: The Po that corresponds to the entered temperature cannot be found 
because the entered temperature is outside of the range of values in the 
Psat vs. T table.

Action A: Enter a temperature that is within the range of the table.

Action B: Use a different Psat vs. T table.
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4023- The file (sample file) cannot be prepared for analysis. It is open for editing and 
contains errors.

4024- Backfill gas in sample file does not match any gas in unit.

4025- There is no Helium attached to the unit. 

4026-  Cannot calculate Dubinin-Astkahov: bad least squares data.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

Cause: You attempted an analysis using a sample file that is being edited and 
has invalid values in one or more of its fields.

Action: Enter valid values into the fields that have errors, save the changes, and 
close the dialog box.

Cause: You selected a backfill gas that is not included in the gas configuration.

Action: Make sure that gas selections match the gases that are attached to the 
instrument. Choose one of the gases as the backfill gas, or edit the sam-
ple file and choose one of the existing gases as the backfill gas.

Cause: A measured free space has been requested but Helium does not appear 
to be available.

Action: Make sure the helium cylinder is attached to the unit at its designated 
port.

Cause: Less than two selected data points are within the fitted pressure range.

Action: Edit the calculation assignments on the Collected Data dialog, or 
change the fitted pressure range on the Dubinin report options dialog.

Cause: Less than two of the sample files you selected for heat of adsorption 
reports contain appropriate data.

Action: Edit the Quantity Adsorbed table, or select other sample files.
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4028- Dubinin calculations cannot be performed because the affinity coefficient of 
the analysis gas is zero.

4029- At least two fitted data points are needed for Alpha-S calculations.

4030- Preparations failed in primary data.

4031- Not enough points with a relative pressure in the range (n,n)

4033- Not enough points to generate Dubinin Tabular Report.

Cause:  Dubinin values could not be calculated because the affinity coefficient 
of the analysis gas is zero.

Action:  Access the Dubinin Report Adsorptive options in the sample file and 
enter an appropriate value for the analysis gas.

Cause: Fewer than two data points fall within the selected Alpha-s range.

Action: Edit the calculation assignments or the fitted Alpha-s range, or use a 
different reference curve.

Cause: Appropriate data were not available to generate the report.

Action: This message was preceded by a different error message; refer to the 
cause/action of the preceding message.

Cause: Fewer than two data points selected for the Dubinin report falls within 
the selected relative pressure range.

Action: Edit the calculation assignments or the fitted relative pressure range.

Cause: There are fewer than two valid data points available for the Dubinin 
tabular reports.

Action: Examine the calculation assignments in the Collected Data dialog of 
the sample file. You must have at least two micropore pressures 
selected for inclusion in the Dubinin report.
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4034- Fewer than 2 points available for Dubinin calculations.

4035- Cannot calculate optimized Astakhov exponent: Not enough points with a rel-
ative pressure in the range [(pressure), (pressure)].

4036- Fewer than 2 points available for Horvath-Kawazoe calculations.

4037- Computations failed while processing the primary data set. No reports will be 
produced.

Cause: There are fewer than two valid data points available for Dubinin 
reports in one of the sample files selected for overlaying.

Action: Examine the calculation assignments in the Collected Data dialog of 
the sample file. You must have at least two micropore pressures 
selected for inclusion in the Dubinin report.

Cause: There are fewer than two valid data points in the relative pressure 
range specified. Astakhov reports will not be produced.

Action: Examine the calculation assignments in the Collected Data dialog for 
the sample file. You must have at least two pressures in the given range 
selected for inclusion in the Dubinin report.

Cause: You must select at least two data points for inclusion in the Horvath-
Kawazoe analysis on the Collected Data dialog. No report will be pro-
duced.

Action: From the Collected Data dialog, select the data points to be analyzed.

Cause: The preparation of data for reporting could not be successfully com-
pleted. No Horvath-Kawazoe reports will be produced. This message 
will always be preceded with another one containing additional infor-
mation.

Action: Refer to the number of the error message which preceded this one for 
an explanation.
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4038- Fewer than 2 points available for the Langmuir Qm computation. Cheng/Yang 
correction will not be applied.

4039- The isotherm does not meet the constraints of the Cheng/Yang assumption. 
Cheng/Yang correction will not be applied.

4040- The value of Qm computed from the Langmuir equation is too low. The pore 
size will not be computed for all data points.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The isotherm must include at least two points above 0.02 rel-
ative pressure for the Langmuir equation to be applied.

Action: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options dialog to prevent this message from appearing on 
future reports.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The isotherm does not correlate to the Langmuir assumption 
with a coefficient of 0.98 or more. The correction is not applicable to 
this isotherm or to the range of the data points selected.

Action A: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options dialog to prevent this message from appearing on 
future reports.

Action B: Generate the Langmuir report for the same data points selected for the 
Horvath-Kawazoe report. If the Langmuir correlation coefficient can 
be brought above 0.98 by removing some points at high relative pres-
sure, remove them and reproduce the Horvath-Kawazoe reports.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation requires 
the value of the monolayer volume as calculated from the Langmuir 
equation. The computed value is less than the volume adsorbed at the 
largest relative pressure included in the analysis. The correction is not 
applicable to this isotherm or to the range of the data points selected.
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4041- Cheng/Yang correction is inappropriate for some P/Po.

4042- 0.0 cannot be a starting or ending pressure for a geometric progression from 
low pressure.

4043-  1.0 cannot be a starting or ending pressure for a geometric progression toward 
saturation.

4044- Points in the Langmuir report pressure table lie outside the collected data.

Action: The analysis will be performed and the Cheng/Yang correction will be 
applied to all points with a volume adsorbed less than the value of Vm. 
The pore size will not be calculated for data points with an invalid vol-
ume adsorbed. Deselect Apply Cheng/Yang correction on the Horvath-
Kawazoe Report Options dialog to clear this message.

Cause: The Cheng/Yang correction is usually inappropriate for any P/Po above 
the isotherm knee. In some instances, the computed pore sizes may 
decrease above the knee. While it is possible to include these relative 
pressures (usually above 0.1 P/Po) in the analysis, the computed pore 
sizes for these pressures are usually meaningless.

Action: Change the data points selected for the Horvath-Kawazoe report to 
include only relative pressures at or below the knee of the isotherm, or 
change the Horvath-Kawazoe report options so that the Cheng/Yang 
correction is not applied.

Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.

Action: Change the 0.0 entered value.

Cause: You selected to generate a pressure table from a geometrically pro-
gressing range.

Action: Change the 1.0 entered value.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data, and 
more than one is below.
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4045- Points in the report pressure table lie outside the collected data.

4046-  (file name) could not be opened for reading.

4047- Warning: An error occurred while reading (file name).

4048- Warning: An error occurred while restoring the heat of adsorption report editor.

Action: Change the report pressure table to be more consistent with the col-
lected data.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data, and 
more than one is below.

Action: Change the report pressure table to be more consistent with the col-
lected data.

Cause: A thickness curve file could not be opened.

Action: If the problem persists, restart your computer and optionally perform a 
media integrity check (using ScanDisk).

Cause: An error happened during a read operation of a thickness curve file.

Action: If the problem persists, restart your computer and optionally perform a 
media integrity check (using ScanDisk).

Cause:  The state of the heat of adsorption report editor could not be restored. 
Default settings will be used.

Action:  No action.
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4049- The sample (file name) does not have enough data. A minimum of two adsorp-
tion points is required.

4050-  None of the requested quantities adsorbed is within the range of the collected 
data of more than one sample file.

4051- The sample (file name) does not have any data in the range of the requested 
quantities adsorbed.

4052- Fewer than two points are selected for this report.

4053-  At least two data points must be selected for t-Plot calculations.

Cause: A sample file has been included in the Heat of Adsorption report that 
does not have enough data.

Action: Remove the file from the selected file list.

Cause:  The Heat of Adsorption report failed because the specified quantities 
are not within the range of the collected data.

Action A:  Edit the quantities adsorbed so that they are within the range of the col-
lected data, or select other sample files. 

Cause:  The sample’s data cannot be interpolated to any of the quantities 
adsorbed.

Action:  Edit the quantities adsorbed so that they are within the range of the col-
lected data. 

Cause:  At least two points are required for the BET calculations.

Action:  Edit the calculation assignments for the BET report.

Cause:  At least two points are required for the t-Plot calculations.

Action:  Edit the calculation assignments for the t-Plot report.
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4054- Fewer than two data points are inside the fitted thickness range.

4055- The BET surface area could not be calculated.

4056- The Langmuir surface area could not be calculated.

4057- At least two data points are needed for Freundlich calculations.

Cause:  At least two points must be within the fitted thickness range for the t-
Plot calculations.

Action A: Edit the calculation assignments for the t-Plot report.

Action B: Edit the fitted thickness range in the t-Plot report editor.

Cause: Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

Cause:  Fewer than two points were assigned to the requested surface area cal-
culation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

Cause: Less than two data points have been selected for the Freundlich report; 
at least two are required.

Action: Select Freundlich points on the Collected Data dialog. If calculation 
assignments are not being used, edit the Freundlich Report options, 
Absolute pressure range in the sample file.
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4058- At least two data points are needed for Temkin calculations.

4059- Fewer than 2 points available for MP-Method calculations.

4060- Sample (file name) contains no data points.

4061- The t-curve must contain at least 2 points.

4062- Error during report generation.

Cause: Less than two data points have been selected for the Temkin report; at 
least two are required.

Action: Select Temkin points on the Collected Data dialog. If calculation 
assignments are not being used, edit the Temkin Report options, 
Absolute pressure range in the sample file.

Cause: You have selected at least one point with a negative pressure value to 
include in the Temkin report.

Action: Negative pressure points void Temkin calculations. Open the sample 
file and click the Collected Data tab. Locate the negative value(s) in 
the Temkin column and deselect it (them).

Cause: At least two points are required for the MP-Method calculations.

Action: Edit the calculation assignments for the MP-Method report.

Action: An attempt was made to save a sample without collected data as a t-
curve or alpha-S curve.

Cause:  Repeat the save as t-curve or save as alpha-S operation after opening a 
sample that has collected data.

Cause:  At least two points are required in a thickness curve definition.

Action:  Edit the thickness curve.

Cause:  An internal processing error has occurred.

Action:  Contact your Micromeritics service representative.
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4063- The data requested on this report are not available.

4067- No data points are within the range of pressures in the reference isotherm.

4068- No points were selected for the f-Ratio report.

4069- Dosing method choice is invalid. The Analysis Conditions choice of Absolute 
pressure dosing requires that the Adsorptive Properties (Dosing Method) is set to 
Normal.

4070- Unable to load deconvolution model (name).

Cause:  There is no information in the sample log to report.

Action:  You selected a sample file for which no instrument operations have 
been used. Select a sample file with a status of Prepared, Preparing, 
Analyzing, or Complete to obtain a valid sample log report.

Cause:  There are no collected data points within the range of pressures in the 
reference isotherm.

Action:  Select data points that are in the range of the reference isotherm, or 
select a more appropriate reference isotherm.

Cause:  The collected data column for the f-Ratio report does not have any 
points selected.

Action:  Edit the collected data dialog and select points for the f-Ratio report.

Cause:  There is an incompatibility between the analysis conditions choice of 
Absolute pressure dosing and the adsorptive properties dosing 
method.

Action:  Edit one of the choices.

Cause:  For some reason, the list of available models was corrupted, therefore, 
the model selected could not be loaded for the deconvolution.

Action:  Exit the program and reinstall the software, then try again.
B-30                                                    Jul 07



Appendix B ASAP 2050 Operator’s Manual
4071- The selected pressures points do not form a valid set for deconvolution.

4072- The range of pressures selected is too small to deconvolute using this model.

4073- The analysis gas (name) does not match the model gas (name).

4076- Invalid sample file - Adsorptive Properties “Non-condensing adsorptive” can-
not be used unless Analysis Conditions “Absolute pressure dosing” is selected.

Cause:  The data points selected for analysis do not contain enough informa-
tion to allow a DFT data reduction.

Action A:  Edit data points in the table of the Collected Data dialog, or select 
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT Plus data reduc-
tion.

Action B:  Edit the pressure range on the DFT report options dialog.

Cause:  A null result was found using the selected model.

Action:  Edit data points in the table of the Collected Data dialog, or select 
another sample file. At least two points with strictly increasing pres-
sures and volumes adsorbed are required for a DFT data reduction.

Cause:  The model assumes a specific gas and the sample file uses a different 
one.

Action:  Select a model that assumes the same gas.

Cause:  You selected a sample file that has Non-condensing adsorptive 
selected in the Adsorptive Properties but does not have Absolute pres-
sure dosing selected in Analysis Conditions.

Action A:  If you plan to use a non-condensing adsorptive, select Absolute pres-
sure dosing on the Analysis Conditions dialog.

Action B:  If you are not using a non-condensing adsorptive, deselect the Non-
condensing adsorptive option on the Adsorptive Properties dialog, or 
choose an adsorptive that you are sure in not non-condensing.
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4077- Cannot get surface area for: (file name)

4078- Slope and Y-Intercept cannot be determined from the selected points.

4079- Points found with negative pressure values will not appear on the graph.

4080-  The compressibility factor table has (number) pressure entries.  Only (number) 
are allowed.

Cause:  The Isotherm report for the named overlay file has Per gram selected 
for the Volume Adsorbed, and the Isotherm report for the primary file 
has a surface area option selected for the Volume Adsorbed.

Action A:  Edit the Isotherm report for the named overlay file and select a surface 
area option for Volume Adsorbed.

Action B:  Click Overlays on the Report options dialog of the primary file and 
remove the named overlay file from the list.

Cause:  The Langmuir report cannot be generated from the selected points.

Action:  Edit the calculation assignments in the Langmuir column on the 
Collected Data dialog.

Cause:  Collected data contains negative pressure values.

Action:  Negative pressure points are automatically removed from isotherm 
graphs. If you wish to have negative pressure values appear on the 
graph: Open the sample file and click the Collected Data tab. 
Deselect Use calculation assignments and then select the points with 
negative pressures as Outliers.

Cause:  The compressibility factor table in the adsorptive properties has too 
many pressure values for analysis.

Action:  Edit the table to remove unneeded pressure entries.
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4081-  In the compressibility factor table, the 4 temperatures below (temperature) and 7 
temperatures above must span at least 10 K.

4082-  Compressibility factors must be greater than zero for temperatures near ambi-
ent and pressures up to the maximum manifold pressure.

4083-  All rows of (file name) do not have the same number of entries.  Some rows will 
be filled or truncated.

4084-  The temperatures of (file name) are not strictly ascending.

4085-  The pressures of (file name) are not strictly ascending.

Cause:  The compressibility factor table in the adsorptive properties has too 
many entries for temperatures near ambient.

Action:  Edit the table to remove unneeded temperature entries.

Cause:  The compressibility factor table in the adsorptive properties contains 
zeros or negative values for the temperatures and pressures expected 
during analysis.

Action:  Edit the table to add missing compressibility factors.

Cause:  This is a warning that all rows in the compressibility factor table do not 
have the same number of enties.

Action:  Edit the table to make all rows the same length.

Cause:  The temperature values in the compressibility factor table are not in 
ascending order.

Action:  Edit the table to put the temperature columns in ascending order.

Cause:  The pressure values in the compressibility factor table are not in 
ascending order.

Action:  Edit the table to put the pressure rows in ascending order.
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4086-  Error reading (file name)

4087-  Error writing (file name)

4088-  Can not open (file name) for reading

4089-  Can not open (file name) for writing

Cause A:  An error ocurred while reading the compressibility factor table.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.

Cause: An error ocurred while writing the compressibility factor table. 

Action: The hard disk does not have enough space left to perform the opera-
tion. Copy files not used regularly from the hard disk to a diskette, CD, 
or network directory, delete them from the hard disk, and then try the 
operation again.

Cause A:  The specified compressibility factor table could not be read.

 Action A: Check the performance of your computer devices or network.

 Cause B: A software error occurred when the file was accessed.

 Action B: Contact your service representative.

Cause:  The specified compressibility factor table could not be written. 

Action: The hard disk does not have enough space left to perform the opera-
tion. Copy files not used regularly from the hard disk to a diskette, CD, 
or network directory, delete them from the hard disk, and then try the 
operation again.
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4090-  The compressibility factor table is empty.

6200 Series

6201- ‘GetOpenFile()’ reports error code (number). File selection cannot be made.

6202- Invalid communications port (port name) specified in the application’s config-
uration settings. Unit cannot initialize.

6203- No serial number available. Unit cannot initialize.

Cause:  The compressibility factor table in the adsorptive properties does not 
have any data. 

Action:  Load an appropriate compressibility factor table.

Cause: You specified a file name which does not exist.

Action: Confirm that the file name used is valid and that the file exists.

Cause A:  The communications port assigned to the ASAP 2050 cannot be made 
available for proper communications.

Action A: Run the ASAP 2050 Setup program, select Change analyzer setup, and 
enter the correct port information. If the message continues, contact 
your service representative.

Cause B: The ASAP 2050 control file was manually modified and an invalid 
communications port was specified.

Action B: Use the ASAP 2050 Setup program to change the communications port 
assigned to the ASAP 2050.

Cause: The ASAP 2050 control file does not contain a serial number for the 
unit.

Action: Run the ASAP 2050 Setup program, select Change analyzer setup, and 
define the serial number for the instrument.
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6204- The disk does not have enough room for the ROA data. The space required is 
(number) megabytes.

6209- Analysis startup failed. (Secondary message number and text.)

6212- Calibrating. This action must be completed before the application exits.

6216- Instrument could not initialize. Reason: (reason).

6235- (Unit [number]) Analysis canceled: Time limit exceeded while dosing Psat tube 
to 925 mmHg.

Cause: The computer’s disk is almost out of disk space.

Action: Delete unwanted files.

Cause: The ASAP 2050 Program was unable to start an analysis with the indi-
cated unit.

Action: Refer to the specified error number and text for instructions.

Cause: The unit is calibrating.

Action: Do not exit the application until the calibration is complete.

Cause: An internal processing and/or hardware error has occurred.  

Action: The specific reason given may identify a possible corrective action. 
Contact your service representative if you continue to receive this error 
message.

Cause A: A pressure of 925 mmHg was not attained within the allowed time. The 
Psat gas regulator may be set too low or turned off.

Action A: Set the Psat gas regulator to 10 psig (0.7 bar). Then restart the analysis.

Cause B: The Psat gas bottle is empty.
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6237- Unit (number) Analysis canceled: Time limit exceeded while evacuating Psat 
tube. 

6240- Leak test failed.

6241- Unit (number) Analysis canceled: Maximum time exceeded before the elevator 
reached the UP (or DOWN) position.

Action B: Connect a new Psat gas bottle. Then restart the analysis.

Cause C: The Psat tube fitting is loose.

Action C: Check the Psat tube fittings and ensure that the tube is attached 
securely to the port. Then restart the analysis.

Cause: The maximum time for evacuating the Psat tube was exceeded before 
the vacuum set point was achieved.  

Action: Check the Psat tube fittings. Tighten the connector nut if necessary; 
then restart the analysis.

Cause: With the sample port valve closed, the sample pressure increased by 
0.15 mmHg before the leak test duration was completed.

Action: Check sample tube fitting and ensure that it is securely attached to the 
port. Then restart the analysis.

Cause A: The maximum time for the analysis was exceeded before the elevator 
reached the UP (or DOWN) position. Ice may be present in the bottom 
or the neck of the Dewar.

Action A: Check the Dewar and remove ice if necessary. Refer to Checking the 
Analysis Port Dewar in Chapter 8. Then restart the analysis.

Cause B: The Psat tube is interfering with elevator movement.

Action B: Make sure the Psat tube is close to the sample tube and the Dewar 
cover is over both the sample and Psat tubes. Then restart the analysis.
Jul 07                                                      B-37 



ASAP 2050  Operator’s Manual Appendix B
6500 Series

6500-  Failed to evacuate manifold to VAC SET in (number of) seconds. Calibration 
canceled.

6501- The Master transducer offset exceeds recommended limits: (number)

6504- Unable to write the calibration file (name).

Cause A: The vacuum set point is set too low.

Action A: Ensure that the vacuum set point is at 5.0 mmHg. If the set point is 
already at 5.0 mmHg or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.

Action B: Locate the leak and repair it. Refer to Chapter 9, Troubleshooting and 
Maintenance. Restart calibration.

Cause C: Valve failure.

Action C: Identify the leaking valve. Contact your service representative.

Cause: The Pressure Gauge Calibration operation showed the transducer offset 
exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message 
occurs again contact a Micromeritics service representative.

Cause: A Save to File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.
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6505- Unable to read the calibration file (name).

6506- Calibration file for (file name) is invalid.

6509-  The sample has an invalid status and cannot be used for degassing.

6510-  Error evacuating.

6511- Error dosing.

Cause: A Load from File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.

Cause: A Load From File operation failed due to invalid information in the 
file.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.

Cause: A file selected for degassing has a status other then No Analysis or Pre-
pared.

Action: Select a different file.

Cause: An evacuation error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: A dosing error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.
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6512- Error calibrating the servo.

6513- Error waiting for pressure to drop.

6514-  Problem encountered dosing to target [PR2] [PR-U], last pressure = [PR4] [PR-
U], elapsed time = [0]:[0].

6516- Unit (number) Analysis canceled: Sample pressure greater than (pressure) 
mmHg is not allowed.

6517- Unit (number) Analysis canceled: Total volume dosed greater than (volume) 
cm3 is not allowed.

Cause: An error occurred while calibrating the servo valve.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: A pressure error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: Dosing during an analysis did not come within the allowed range of the 
target.

Action: Check that the outlet stage of the gas regulator is within specification. 
If the problem occurs frequently contact a Micromeritics service rep-
resentative.

Cause: An absolute pressure greater than (pressure) mmHg was attained dur-
ing Low pressure dosing (either fixed dose mode or incremental dose 
mode).

Action: The analysis was canceled. All previously collected data were stored.

Cause A: More than (volume) cm3 has been dosed onto the sample, possibly due 
to leaks in the system.

Action A: Perform leak checks on the system. Refer to Appendix E, Testing for 
Leaks.
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6518- Unit (number) Analysis canceled: Pressure of (pressure point) mmHg exceeds 
the maximum manifold pressure of (pressure point) mmHg.

6519- Unit (number) Analysis canceled: Psat gas is not condensing.

Cause B: The value for the Po may be too low, causing the instrument to mistake 
condensation for actual adsorption.

Action B: Change the analysis variables to directly measure the value of Po dur-
ing the experiment.

Cause C: The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report 
by the sample weight. If the result exceeds (volume) cm3, the amount 
of sample is too large.

Action C: Reduce the amount of sample.

Cause: An absolute pressure greater than (pressure) mmHg was attained that 
exceeded the specified maximum manifold pressure. 

Action: The analysis was canceled. All previously collected data were stored. 
Change the maximum manifold pressure value in the Adsorptive Prop-
erties file.

Cause A: The working Dewar does not contain enough bath liquid.

Action A: Retry the operation after filling the Dewar.

Cause B: The Psat gas is contaminated.

Action B: Replace the Psat gas supply.

Cause C: The Psat tubing from the regulator to the instrument is contaminated.

Action C: Pump out the tubing.
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6520- Power failure detected.

6522- Unit (number) Analysis canceled: Time limit exceeded while evacuating 
manifold. 

Cause A: Main power failed but UPS (if attached) is working.

Action A: Restore power to the analyzer.

Cause B: The value for the Po may be too low, causing the instrument to mistake 
condensation for actual adsorption.

Action B: Change the analysis variables to directly measure the value of Po dur-
ing the experiment.

Cause C: The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report 
by the sample weight. If the result exceeds (volume) cm3, the amount 
of sample is too large.

Action C: Reduce the amount of sample.

Cause A: Maximum manifold evacuation time was exceeded before the vacuum 
set point was achieved. Vacuum pump may be turned off.

Action A: Turn on vacuum pump switch. Then restart the analysis.

Cause B: The vacuum pump oil level is low. 

Action B: Check the vacuum pump oil level and add more oil if necessary. Then 
restart the analysis.

Cause C: The manifold is contaminated or leaking.

Action C: Correct the problem. Refer to Appendix D, Testing for Leaks. Then 
restart the analysis.
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6523- Unit (number) Analysis canceled: Time limit exceeded while evacuating sample 
(unrestricted). 

6524- Unit (number) Analysis canceled: Time limit exceeded while evacuating sample 
(restricted).

6525- Power failure lasted too long.

6526- Time limit exceeded while backfilling manifold to [PR4] [PR-U] with [G].

Cause: The maximum time for evacuating the sample through the unrestricted 
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting or a crack in the sample tube. 

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Then restart the analysis.

Cause: The maximum time for evacuating the sample through the restricted 
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting, a crack in the sample tube, or a poorly degassed sample.

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Verify that the sample is properly 
degassed; then restart the analysis

Cause: A power failure on an analyzer which has an Uninteruptible Power 
Supply attached has lasted for an hour or more; therefore, the analysis 
has been canceled.

Action: Determine the cause of the power failure and correct it.

Cause A:  The maximum time was exceeded before the target pressure point was 
reached. The gas regulator may be set too low or turned off.

Action A:  Set the gas regulator to 150 psig. Then resume the analysis.

Cause B: The gas bottle is empty.

Action B: Connect a new gas bottle. Then resume the analysis.
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6527 - Unit (number) Analysis suspended: Time limit exceeded while dosing manifold 
to (target pressure point) mmHg with (gas name).

6529- Master pressure gauge offset is too high - [PR1] [PR-U].

6530- Volume calibration canceled due to failure (code [0]).

Cause A: The maximum time was exceeded before the target pressure point was 
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 150 psig. Then resume the analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle. Then resume the analysis.

Cause: A check of the Master gauge’s offset during an automatic operation 
indicated it was too high.

Action: If this message occurs repeatedly, contact a Micromeritics service rep-
resentative

Cause:  A problem occurred during volume calibration.

Action: Contact a Micromeritics service representative.
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6531- The gas configuration file for (unit number) is invalid.

6532- The instrument is currently running the Physi software. Do you want to reset 
it?

6534- Instrument (unit number) is not calibrated.

6535- Problem encountered evacuating.

Cause: The contents of the gas configuration file are not valid.

Action A: Exit the application, navigate to the application hardware directory, 
and delete the <S/N>.SST file. Then restart the application and reas-
sign gasses.

Action B: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists, contact a Micromeritics service representative.

Cause: The analyzer is under the control of the 2050 Physisorption software.

Action: Selecting Yes will reset the analyzer and download the 2050 Chemi-
sorption control software.

Cause: Calibration information for various analyzer components are missing.

Action: Run the application setup program and reinstall calibration information 
for the specified unit.

Cause: Evacuation during the manifold dosing operation did not come within 
the allowed range of the target.

Action: Check that the outlet stage of the gas regulator is within specification. 
If the problem occurs frequently, contact a Micromeritics service rep-
resentative.
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6536- There is no Nitrogen attached to the unit. 

6537- Error reading SmartVac ADC. 

6538- Power failure detected. The sample is in an unknown condition. A run termina-
tion will be performed for safety.

6539- Error overheating Current = (no.), Target = (no.), Limit = (no.)

Cause: A volume calibration has been requested but N2 is not one of the gases 
selected in the unit/gas configuration.

Action: Make sure the nitrogen cylinder is attached to the unit and edit unit 
configuration to match the gases that are present.

Cause: There was a problem reading one of the signals on the SmartVac board.

Action: Exit the application, turn off the power switch on the analyzer, then 
turn the power back on. Restart the application and the degas opera-
tion. If the problem persists, contact your service representative.

Cause: A total power failure occurred (a UPS was not connected) while an 
analysis was in progress.

Action: Allow the analysis to terminate.

Cause A: The heating mantle is reporting a higher temperature than expected.

Action A: Ensure that the heating mantle and thermocouple cables are plugged in 
fully on the port(s).

Cause B: An internal failure of the degas system may have occurred.

Action B: Unplug the heating mantle power connector; do not unplug the ther-
mocouple. Allow the heating mantle to cool down (approximately 15-
30 minutes). Then exit the analysis program and turn off the analyzer. 
Wait a couple of minutes, then turn the instrument on and restart the 
program. If the problem recurs, contact your Micromeritics service 
representative.
B-46                                                    Jul 07



ASAP 2050  Operator’s Manual Appendix C
C. CALCULATIONS

Saturation Pressure (Po)

Po method is selected by the user on the Po and Temperature Options dialog box. It may be 
entered, measured, or calculated from temperature.

If entered, Po = user entered value

If measured, Po = equilibrated pressure reading after saturating Po tube

If calculated from temperature, interpolate Po from the Psat vs Temperature table on the Po 
and Temperature Options dialog box, given the analysis bath temperature

Relative Pressure

If Po was measured:

For points taken before the previous Po measurement,

For points taken after the previous Po, use the previous Po:

PoI = Po1

If Po was entered, use the entered Po:

PoI = PoE

If Po was calculated, use the calculated Po:

PoI = PoC

Calculate relative pressure for the Ith data point:

PoI Po1
Po2 Po1–( ) TI To1–( )×

To2 To1–( )
------------------------------------------------------------+=

Prel1

P1

PoI
--------=
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where

PoI = saturation pressure for the Ith data point (mmHg)
Po1 = most previous measured saturation pressure before Ith data 

point (mmHg)
Po2 = first measured saturation pressure after the Ith data point (mmHg)
PoC = calculated Po
PoE = entered saturation pressure (mmHg)
TI = time when the Ith data point was taken (minutes)
To1 = time when Po1 was measured (minutes)
To2 = time when Po2 was measured (minutes)
PrelI

= relative pressure for the Ith data point (mmHg)
PI = absolute pressure for the Ith data point, taken at equilibrium (mmHg)

Free Space

Free-space volumes are calculated using the following equations:

where:\

P1 = system manifold pressure before dosing helium onto sample (mmHg)
P2 = system manifold pressure after dosing helium onto sample (mmHg)
P3 = sample pressure after raising Dewar and equilibrating with helium (mmHg)
TSTD = standard temperature (273.13 K)
TRM = approximate room temperature (298 K)
T1 = system manifold temperature before dosing helium onto sample (K)
T2 = system manifold temperature after raising Dewar and equilibrating with 

helium (K)
VLOW = lower manifold volume (cm3)
VFC = volume of free space, cold (cm3 at standard temperature)

VFW
VLOW

T1
------------ P1

P2
----- 1–× TSTD×=

VFC
VLOW

T2
------------ P1

P3
----- 1–× TSTD×=

VABT
VFC VFW–

1 TABT

TRM
----------–

------------------------=
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VFW = volume of free space, warm (cm3 at standard temperature)
VABT = portion of cold free space at analysis bath temperature: (cm3 at standard 

temperature)
TABT = analysis bath temperature (K), from the Po and Temperature Options dialog 

box

Volume Adsorbed

For the Ith dose:

where:

NgasI = total amount of gas dosed into sample tube after Ith dose (cm3 STP)
NadsI = amount of gas adsorbed after equilibrating Ith dose (cm3 STP)
PSTD = standard pressure (760 mmHg)
Psys1I = system manifold pressure before Ith dose of gas onto sample (mmHg)
Psys2I = system manifold pressure after Ith dose of gas onto sample (mmHg)
PsamI = sample pressure after equilibrating Ith dose of gas onto sample (mmHg)
Tsys1I = system manifold temperature before Ith dose of gas onto sample (K)
Tsys2I = system manifold temperature after Ith dose of gas onto sample (K)
Wsam = weight of sample (g) 
VI = amount of gas adsorbed per gram of sample (cm3/g STP) 
ZFC = compressibility factor for the analysis gas at PsamI and the analysis 

temperature
ZFA = compressibility factor for the analysis gas at PsamI and the ambient 

temperature
VFA = volume of the sample tube at ambient temperature    

NgasI NgasI 1– VLOW
Psys1I

Tsys1I
---------------- Psys2I

Tsys2I
----------------–×

TSTD

PSTD
-----------×+=

NadsI NgasI
PsamI

PSTD
--------------- VABT

ZFC
-----------⎝
⎛–

VFA

ZFA
--------⎠

⎞+=

VI
NadsI

Wsam
---------------=

VFC VABT–
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Equilibration

Equilibration is reached when the pressure change per equilibration time interval (first 
derivative) is less than 0.01% of the average pressure during the interval. Both the first 
derivative and average pressure are calculated using the Savitzky-Golay1 convolution method 
for polynomial functions. The equations below are those used to compute weighted average 
and first derivative, respectively, for the 6th point of an 11-point window.

where the numerical constants are from the Savitzky-Golay convolution arrays, and

PAVG = average pressure (mmHg)
PCHG = change in pressure (mmHg)
PI = Ith pressure reading taken at equilibrium intervals (mmHg)

After equilibration has been reached, if the user-entered minimum equilibration time from the 
Low Pressure Options dialog box has not elapsed, the equilibration continues until the entered 
time has elapsed.

If the user entered a non-zero maximum equilibration time from the Low Pressure Options 
dialog box, and this time period has elapsed before equilibration has been reached, the 
equilibration ends as if equilibration had been reached, and the point is collected.  

PAVG
36 P11 P1+( )– 9 P10 P2+( ) 44 P9 P3+( ) 69 P8 P4+( ) 84 P7 P5+( ) 89 P6( )+ + + + +

429
--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

PCHG
5 P11 P1–( ) 4 P10 P2–( ) 3 P9 P3–( ) 2 P8 P4–( ) P7 P5–( )+ + + +

110
-----------------------------------------------------------------------------------------------------------------------------------------------------------=

If a non-zero value that is too small is entered for the maximum equilibration time, 
the points are collected before equilibration is reached. 

 If PAVG is greater than 0.995 times the current Po, equilibration will not take place 
until the Minimum equilibration delay for P/Po 0.995  has expired, in addition to the 
standard equilibration criteria.
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Thermal Transpiration Correction 

During data reduction, thermal transpiration correction is applied to the data if the user 
selected Thermal transpiration correction from the Report Options dialog box. Starting 
with the first collected pressure, the following calculations are performed until the pressure 
ratio (PC/P) is greater than or equal to 0.99.

where:

P = equilibrated collected pressure measured by gauge at temp 
TRM (mmHg)

SD = inside diameter of sample tube (mm), from the Report Options
dialog box

MD = thermal transpiration hard sphere diameter of gas (Å), from 
the Adsorptive Properties dialog box

T = average temperature [TABT + TRM] / 2 (K)
α = Weber’s coefficient, 0.033
β = Weber’s coefficient, 0.245
G = Weber’s coefficient, 2.5
H = Weber’s coefficient, 2 
TABT = analysis bath temperature (K), from the Po and Temperature Options dialog 

box
TRM = room temperature (298 K) 
PC = corrected equilibrated pressure at temperature TABT (mmHg)
F,Y,µ = intermediate values for subsequent calculations

Y P SD MD2××
2.33 T×

----------------------------------- 103×=

µ 1 G Y×+
1 H Y×+
-----------------------=

F 1
α Y2×( ) β Y×( ) µ+ +

------------------------------------------------------=

PC 1 F F
TABT

TRM
----------⎝ ⎠
⎛ ⎞

0.5

⎝ ⎠
⎛ ⎞––

⎩ ⎭
⎨ ⎬
⎧ ⎫

P×=
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BET Surface Area

For each point designated for surface area calculations, the BET2 transformation is calculated 
as follows:

where BI is in units of g/cm3 STP.

A least-squares fit is performed on the (PrelI ,BI) designated pairs where PrelI  is the 
independent variable and BI is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (YINT g/cm3 STP)

c. Error of the slope (SERR g/cm3 STP)

d. Error of the y-intercept (YIERR g/cm3 STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

BET Surface Area (m2/g):

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties dialog box

BET C value:

Volume of the Monolayer (cm3/g STP):

B1
Prel1

1.0 Prel1
–( ) Nads1

×
----------------------------------------------=

SABET
CSA 6.023 1023×( )×

22414 cm3 STP( ) 1018 nm2/m2( ) S YINT+( )××
---------------------------------------------------------------------------------------------------------------------=

C S YINT+
YINT

-------------------=

VM
1

C YINT×
-------------------- 1

S YINT+
-------------------= =
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Error of the BET Surface Area (m2/g):

 

Langmuir Surface Area

For each point designated for surface area calculations, the Langmuir3 transformation is cal-
culated as follows:

where LI is in units of g/cm3 STP

A least-squares fit is performed on the (PrelI  ,LI) designated pairs where PrelI  is the inde-
pendent variable and LI is the dependent variable. The following are calculated:

a. Slope (S g/cm3 STP)

b. Y-intercept (YINT g/cm3 STP)

c. Error of the slope (SERR g/cm3 STP)

d. Error of the y-intercept (YIERR g/cm3 STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

Langmuir Surface Area (m2/g):

  

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties dialog box  

BETERR
SABET SERR 2 YIERR 2+( )

0.5
×

YINT S+
---------------------------------------------------------------------=

LI
PrelI

NadsI

-----------=

SALAN
CSA 6.023 1023×( )×

22414 cm3 STP( ) 1018 nm2/m2( ) S××
-----------------------------------------------------------------------------------------------=
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Volume of the Monolayer (cm3/g STP):

 

Langmuir b Value:

 

Error of the Langmuir Surface Area (m2/g):

VM
1
S
---=

b YINT( )  VM( )=

LANERR
SALAN SERR×

S
-------------------------------=
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t-Plot

For each point designated for t-Plot4 calculations, the following calculations are done:

Thickness for the Ith point (Å):

 (Halsey5)     

or

(Harkins and Jura6)

where:

tI = thickness for Ith point 
HP1 = Halsey parameter #1
HP2 = Halsey parameter #2
HP3 = Halsey parameter #3
HJP1 = Harkins and Jura parameter #1
HJP2 = Harkins and Jura parameter #2
HJP3 = Harkins and Jura parameter #3
PrelI = relative pressure for the Ith point (mmHg)

A least-squares analysis fit is performed on the (tI, NadsI) data pairs where tI is the indepen-
dent variable and NadsI is the dependent variable. Only the values of tI between tMIN and 
tMAX, the minimum and maximum thickness, are used. The following are calculated: 

a. Slope (S cm3/g-Å STP)

b. Y-intercept (YINT cm3/g STP)

c. Error of the slope (SERR cm3/g-Å STP)

d. Error of the Y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

Using the results of the above calculations, the following can be calculated: 

External Surface Area (m2/g):

tI HP1 HP2
PrelI
( )ln

--------------------×
HP3

=

tI
HJP1

HJP2 PrelI
( )log–

-------------------------------------------
HJP3

=

SAEXT
S cm3/g A STP–( ) 1010 A/m( ) D(  cm3 liquid/cm3 STP )××

F 106 cm3/m3( )×
--------------------------------------------------------------------------------------------------------------------------------------------------------=
Jul 07                                                   C-9 



Appendix C ASAP 2050  Operator’s Manual
where

F = surface area correction factor, user-entered on the t-Plot Report Options dialog 
box

D = density conversion factor, user-entered on the Adsorptive Properties dialog 
box

Micropore Surface Area (m2/g):

where SATOT is the BET surface area if the user enabled the BET report exclusively, or Lang-
muir surface area if the user enabled the Langmuir report exclusively. If neither report has 
been selected, SATOT is the BET surface area value calculated using a set of default 
parameters.

Micropore Volume (cm3 liquid/g):

SAµP SATOT SAEXT+=

VµP YINT cm3/g STP( ) D cm3 liquid/cm3 STP( )×=
C-10                                                    Jul 07
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BJH Pore Volume and Area Distribution

For adsorption data, the relative pressure and volume adsorbed data point pairs collected dur-
ing an analysis must be arranged in reverse order from which the points were collected during 
analysis. All calculations are performed based on a desorption model, regardless of whether 
adsorption or desorption data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value. 
Points which do not meet this criterion are omitted. The remaining data set is composed of 
relative pressure (Pr), volume adsorbed (Va) pairs from (Pr1, Va1) to (PrN, VaN) where (PrN = 
0, VaN = 0) is assumed as a final point. Each data pair represents an interval boundary (or des-
orption step boundary) for intervals i=1 to i=N-1 where N = total number of (Pr, Va) pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost 
in a desorption step to the average size of pores emptied in the step. A pore loses its con-
densed liquid adsorbate, known as the core of the pore, at a particular relative pressure related 
to the core radius by the Kelvin7 equation. After the core has evaporated, a layer of adsorbate 
remains on the wall of the pore. The thickness of this layer is calculated for a particular rel-
ative pressure from the thickness equation. This layer becomes thinner with successive 
decreases in pressure, so that the measured quantity of gas desorbed in a step is composed of 
a quantity equivalent to the liquid cores evaporated in that step plus the quantity desorbed 
from the pore walls of pores whose cores have been evaporated in that and previous steps. 
Barrett, Joyner, and Halenda8 developed the method (known as the BJH method) which incor-
porates these ideas. The algorithm used on the ASAP 2020 is an implementation of the BJH 
method.

Explanation of Terms

A pore filled with condensed liquid nitrogen has three zones:

a. The core - evaporates all at once when the critical pressure for that radius is reached; 
the relationship between the core radius and the critical pressure is defined by the 
Kelvin equation.

b. The adsorbed layer - composed of adsorbed gas that is stripped off a bit at a time 
with each pressure step; the relationship between the thickness of the layer and the 
relative pressure is defined by the thickness equation.
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c. The walls of the cylindrical pore - the diameter of the empty pore is required to 
determine the pore volume and pore area. End area is neglected.

Calculations

The volumes adsorbed (Va) are converted to the liquid equivalent volumes (V1, cm3/g):

where D is the Density Conversion Factor from the Adsorptive Properties dialog box.

The relative pressure (Pr1) is assumed to be close to unity so that substantially all the pores in 
the sample are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be 
included:

where

A = adsorbate property factor (the BJH Adsorptive Options dialog box)
F = fraction of pores open at both ends (from the BJH Adsorption Report Options 

dialog box or the BJH Desorption Report Options dialog box); assumed to be 
zero for desorption

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calcu-
lation steps.

a
d
s
o
r
b
e
d

l
a
y
e
r

wall
c
o
r
e

Insignificant 
compared to 
core length

pore

VII VaI( ) D( )=

RcI
A–

1 F+( ) PrI( )ln[ ]
-----------------------------------------=
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The thickness of the remaining adsorbed layer at this relative pressure is calculated:

where

HP1, HP2, and HP3 are Halsey Parameters 1, 2, and 3 (respectively) from the Halsey Thick-
ness Equation dialog box.

These calculations illustrate the use of the Halsey thickness equation. If the Harkins/Jura 
equation was selected, substitute the following wherever the thickness equation appears:

where

HJ1, HJ2, and HJ3 are Harkins-Jura Parameters 1, 2, and 3 (respectively) from the Harkins-
Jura Thickness Equation dialog box.

The following calculations (a-c) are made for each relative pressure interval based on the 
increment of volume desorbed during that interval. The variable I refers to the interval num-
ber, that is I=1 for the first interval from Pr1 to Pr2, and so on. J refers to each previous 
interval during which new pores were found. K refers to the total number of intervals in 
which new pores have been found. K is also the number of lines reported on the BJH table for 
collected data.

a. The thickness of the adsorbed layer at the end of the interval is calculated as follows:

(For the last pressure interval from the lowest PrI to zero relative pressure, TwI+1 = 0.)

For the first pressure interval, there are no previously opened pores so the volume 
desorbed from walls of previously opened pores is zero (Vd1 = 0), and the remainder 
of Step a is skipped.

The change in thickness of the wall layer due to desorption from preivously opened 
pores is calculated:

Tw1 HP1 HP2
Pr1( )ln

------------------
HP3

=

Tw1
HJ1

HJ2 Pr1( )log–
--------------------------------------

HJ3
=

TwI 1+ HP1 HP2
PrI 1+( )ln

------------------------
HP3

=

∆Tw Tw1 TwI 1+–=
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The annular cross-sectional area of the wall layer desorbed is calculated for all pre-
viously opened pores:

The total volume of gas desorbed from walls of previously opened pores is 
calculated:

 for all previously opened pores

where LPJ = length of previously opened pores as calculated in Step b(2).

b. The physical processes occurring for this pressure interval are determined as follows:

(1) If VdI is greater than the current increment of volume desorbed (VlI - VlI+1), 
desorption from walls only is occurring. Total surface of walls exposed thus far 
(cm2/g) is calculated as follows:

   for all previously opened pores

where

DavgJ  =  weighted average pore diameter calculated below in Step b(2).

A new layer thickness (∆Tw) that will not overcompensate for the actual volume 
desorbed in this interval is calculated:

Since no cores are evaporated in this pressure interval, no new pores are revealed. 
Thus no ending Kelvin radius and average pore diameter are calculated for this 
interval. Note that this means the report may have fewer tabulated intervals on 
the collected data report than experimental pressure intervals.

(2) If VdI is less than the volume increment desorbed during this interval 
, the remaining volume is due to new pores with core evaporation 

taking place in this interval. K, the number of intervals with new pores exposed, 
is increased by 1. (For the interval from the lowest Pr1 to zero relative pressure, 
no new pore volume is calculated and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as 
follows:

CSAJ π Rcj ∆Tw+( )2 Rcj 
2–[ ] 10 16–  cm2/A2( )=

VdI LpJ( ) CSAaJ( )∑=

SAW π LPJ( ) DavgJ
( ) 10 8–  cm/A( )∑=

∆Tw V1I V1I 1+–( ) 108 A/cm( )
SAwI

--------------------------------------------------------------=

Vl1 Vll 1+–( )
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The Kelvin radius for the end of the interval is calculated as follows:

All new pores opened in this interval are represented by one pore having a 
length-weighted average pore diameter and a corresponding length sufficient to 
account for the required volume of adsorbate. The weighted average pore diam-
eter is calculated as follows:

DavgK is the diameter of a pore which would have a surface area that is the aver-
age of the areas for pores radius RcK and RcK+1, if its length was the mean of the 
lengths at those radii. 

The relative pressure corresponding to  is calculated as follows:

The thickness of the adsorbed layer at this pressure is calculated as follows:

The decrease in thickness of the wall layer by desorption from the walls of new 
pores during the lower portion of the pressure interval is calculated as follows:

The cross-sectional area of the newly opened pores is calculated as follows:

VcI VII VII 1+–( ) VdI–=

RcK 1+
A–

1 F+( ) PrI 1+( )ln[ ]
-----------------------------------------------=

DavgK

2( ) RcK RcK 1++( ) RcK( ) RcK 1+( )

RcK 2 RcK 1+  2+
-------------------------------------------------------------------------------=

PavgK
 1– 2A–

1 F+( ) DavgK
( )

-----------------------------------ln=

TwavgK
HP1 HP2

PavgK
( )ln

----------------------
HP3

=

∆Td TwavgK
TWI 1+–=

CSAcK
DavgK

2
---------------- ∆Td+

2
10 16–  cm2/A2( )=
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The length of the newly opened pores is calculated as follows:

c. Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall 
layer during this interval. If new pores were opened during this interval, the average 
diameter is adjusted by the change in layer thickness during the second portion of the 
desorption interval as follows:

The layer thickness change during the whole interval is added to diameters of previ-
ously opened pores as follows:

(not including DavgK)

The layer thickness change desorbed during this interval also is added to the radii 
corresponding to the ends of the pressure intervals as follows:

for all except RcK+1.

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the 
ends of the intervals are calculated as follows:

for all RcJ including RcK+1.

The remaining calculations are based on DP(I), Davg(I), and LP(I). These calculations 
are only done for Davg(I) values that fall between the Minimum BJH diameter and the 
Maximum BJH diameter specified by the operator on the BJH Adsorption Report 
Options dialog box or the BJH Desorption Report Options dialog box.

1) Incremental Pore Volume  (VpI, cm3/g):

LPK
VcI

CSAcK
-----------------=

DavgKnew
DavgKold

2 ∆Td( )+=

DavgJnew
DavgJold

2 ∆( Tw )+=

RcJnew RcJold ∆Tw+=

DpJ 2 rcJ( )=

VpI π LpI( )
DavgI

2
-----------

2

1016 cm2/A2=
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2) Cumulative Pore Volume (VpCUM(1), cm3/g):

3) Incremental Surface Area (SAI, m2/g):

4) Cumulative Surface Area (SACUM(I), m2/g):

5) dV/dD pore volume (dV/dDI, cm3/g-A):

6) dV/dlog(D) pore volume (dV/dlog(D)I, cm3g):

7) dA/dD pore area (dA/dDI, m2/g-A):

8) dA/dlog(D) pore area [dA/dlog(D)I, m2/g]:

For fixed pore size tables (if selected), the following calculations are performed:

1) Average Fixed Pore Size (DFavgJ, A):

calculated for all intervals in the fixed pore size table.

VPCUM 1( )
VpJ for J 1≤( )∑=

SAI π LPI( ) 10 2–  m/cm( ) DavgI
( ) 10 10–  m/A( )=

SACUM10
SAJ for J 1≤∑=

dV/dDI
VPI

DpI DpI 1+–
------------------------------=

dDv/d D( )I VPI/
DpI

DpI 1+
---------------⎝ ⎠
⎛ ⎞log=log

dA/dDI
SAI

DpI DpI 1+–
------------------------------=

dA/d D( )Ilog SAI/
DpI

DpI 1+
---------------⎝ ⎠
⎛ ⎞log=

DFavgJ

DpFJ
DpFJ 1+

+
2

---------------------------------=
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For the intervals with  between the Minimum BJH diameter and the Maximum 
BJH diameter.

2) Cumulative Pore volume (VpFCUMI, cm3/g):

where INTERP(x) is the value interpolated from the function X = DpJ+1 and Y = 
VPCUMJ, using an AKIMA semi-spline interpolation.

3) Incremental Pore Volume (VpFI, cm3/g):

where VpFCUM0 = 0.

4) Cumulative Surface Area (SAFCUMI, m2/g):

where INTERP(x) is the value interpolated from the function X = DpJ+1 and Y = 
SACUMJ.

5) Incremental Surface Area (SAFI, m2/g):

where SAFCUM0 = 0.

6) dV/dD pore volume (dV/dDpFI, cm3/g-A)):

where INTERP(x) is the value interpolated from the function X = DavgJ and Y = 
dV/dDJ.

7) dV/dlog(D) pore volume [dV/dlog(DpF)I, cm3/g]:

where INTERP(x) is the value interpolated from the function X = DavgJ  and Y = 
dV/dlog(D)J.

VpFCUMI
INTERP DpFI 1+( )=

VpFI VpFCUMI
VpFCUMI 1–

–=

SAFCUMI
INTERP DpFI 1+( )=

SAFI SAFCUMI
SAFCUMI 1–

–=

dV/dDpFI INTERP DpFI 1+( )=

dV/d D( pFI )log INTERP DpFI 1+( )=
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8) dA/dD pore area (dA/dDpFI, m2/g-A):

where INTERP(x) is the value interpolated from the function X = DavgJ  and Y = 
dA/dDJ.

9) dA/dlog(D) pore area [dA/dlog(DpFI), m2/g]:

where INTERP(x) is the value interpolated from the function X = DavgJ  and Y = 
dA/dlog(D)J.

Compendium of Variables

Va = quantity adsorbed expressed as a volume (cm3/g STP)
Vl = liquid equivalent volume of volume adsorbed (cm3/g)
D = density conversion factor from the Adsorptive Properties dialog box

(cm3/cm3 STP)
Pr = relative pressure
Dp = pore (or core) diameter (A)
Rc = Kelvin radius (A) of core
A = adsorbate property factor; from the BJH Adsorptive Options dialog box
F = fraction of pores open at both ends; from the BJH Adsorption Report 

Options dialog box or the BJH Desorption Report Options dialog box
∆Tw = thickness of adsorbed layer desorbed during interval (A)
Tw = thickness of remaining adsorbed wall (A)

HP1, HP2, and HP3 are Halsey Parameters from the Halsey Thickness Equation dialog box.

HJ1, HJ2, and HJ3 are Harkins and Jura Parameters from the Harkins/Jura Thickness Equa-
tion dialog box.

Vd = volume of gas desorbed from walls of previously opened pores (cm3/g)
Davg = average pore diameter (A)
CSAa = annular cross-sectional area of the desorbed layer (cm2)
CSAc = cross-sectional area of opening of newly opened pores (cm2)
SAw = total surface area of walls exposed (cm2/g)
∆Td = thickness of layer desorbed from walls of newly opened pores (A)
Vc = volume desorbed from cores of newly opened pores (cm3/g)
Lp = length of pore (cm/g)

dA/dDpFI INTERP DpFI 1+( )=

dA/d D( pFI )log INTERP DpFI 1+( )=
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Horvath-Kawazoe

A relative pressure lower limit is determined such that L-d0 never equals zero. All pressure 
points less than this limit are discarded. For each collected relative pressure point, values of L 
are chosen in an iterative manner, and the relative pressure (P/Po) determined by solving one 
of the following equations:

• Slit Pore Geometry (original Horvath-Kawazoe)
• Cylinder Pore Geometry (Saito/Foley)
• Sphere Pore Geometry (Cheng/Yang) 

Slit Pore Geometry (original HK)

When you use the original Horvath-Kawazoe9 method, the following equation is solved for 
each value of P. The value of L is determined when the solved-for relative pressure is within 
0.1% of the collected absolute pressure.

where

K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated 

value on the Po and Temperature Options dialog box

σ = gas solid nuclear separation at zero interaction energy (Å), 

where:

ZS = sample equilibrium diameter at zero interaction energy (Å) from the 
Horvath-Kawazoe Physical Properties dialog box 

ZA = zero interaction energy diameter from the Horvath-Kawazoe Physical 
Properties dialog box 

d0 =

where:

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical
Properties dialog box 

DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 
dialog box 

P
Po
-------ln K

RT
------- IP 1032 JA4/J cm4×

σ4 L 2 d0×–( )×
--------------------------------------------------× σ4

3 L d0–( )3×
------------------------------ σ10

9 L d0–( )9×
------------------------------– σ4

3 d0 
3×

---------------– σ10

9 d0
 9×

---------------+×=

ZS ZA+
2

-----------------

DA DS A( ) +
2

------------------------------
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L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
IP = interaction parameter (10-43 ergs-cm4) from the Horvath-Kawazoe 

Report Options dialog box

Cylinder Pore Geometry (Saito/Foley)

When you use the Saito-Foley10 method, the following equation is solved for each value of P. 
The value of L is determined when the solved-for relative pressure is within 0.1% of the 
collected absolute pressure.

where

K = Avogadro’s number (6.023 x 1023)
R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated 

value on the Po and Temperature Options dialog box
L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
IP = interaction parameter (10-43 ergs-cm4) from the Horvath-Kawazoe Report 

Options dialog box

d0 =

where:
DA = molecular diameter (Å) from the Horvath-Kawazoe Physical

Properties dialog box 
DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical

dialog box 

αk =

βk =

rp = radius of the cylindrical pore, 

P
Po
-------⎝ ⎠
⎛ ⎞ln 3

4
---πK

RT
------- IP 1032 JA4/J cm4×

d0 4
--------------------------------------------------× 1

k 1+
------------ 1 d0

rp
-----–⎝ ⎠

⎛ ⎞ 2k 21
32
------αk

d0

rp
-----⎝ ⎠
⎛ ⎞

10
βk

d0

rp
-----⎝ ⎠
⎛ ⎞

4
–

⎩ ⎭
⎨ ⎬
⎧ ⎫

×
k 0=

∞

∑×=

DA DS A( )+
2

----------------------------

4.5– k–
k

--------------------⎝ ⎠
⎛ ⎞

2
 αk 1– ,α0 1.0=

1.5– k–
k

--------------------⎝ ⎠
⎛ ⎞

2
 βk 1– ,β0 1.0=

L
2
---
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Sphere Pore Geometry (Cheng/Yang)

When you use the Cheng/Yang11 method, the following equation is solved for each value of 
P. The value of L is determined when the solved-for relative pressure is within 0.1% of the 
collected absolute pressure.

where

R = gas constant (8.31441 x 107 ergs/mole K)
T = analysis bath temperature (K), from an entered or calculated value on the Po 

and Temperature Options dialog 

d0 =

where:
DA = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties 

dialog  
DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 

dialog  
L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure (mmHg)
Po = saturation pressure (mmHg)
N1 = 4π L2 NS, where NS = number of sample atoms/cm2 at monolayer
N2 = 4π (L - d0)2 NA, where Ns = number of gas molecules/cm2 

e*12 = , where  

 ε*22 = , where  

T1 =

T2 =

T3 =

P
Po
-------⎝ ⎠
⎛ ⎞ln 6 N1ε

* 12 N2ε
* 22+( )L3 1032 J A4/J cm4×

RT L d0–( )3
----------------------------------------------------------------------------------------------------=

d0

L
-----⎝ ⎠
⎛ ⎞

6 1
12
------T1

1
8
---T2+⎝ ⎠

⎛ ⎞–
d0

L
-----⎝ ⎠
⎛ ⎞

12 1
90
------T3

1
80
------+ T4⎝ ⎠

⎛ ⎞+

DA DS A( )+
2

----------------------------

AS

4dS 6
------------ AS

6 MC2 αS αA×××
αS

χS
----- αA

χA
------+

---------------------------------------------=

AA

4DA 6
-------------- AA

3 MC2 αA χA×××
2

---------------------------------------------=

1
1 S–( )3

------------------- 1
1 S+( )3

-------------------–

1
1 S+( )2

------------------- 1
1 S–( )2

-------------------–

1
1 S–( )9

------------------- 1
1 S+( )9

-------------------–
C-22                                                    Jul 07



ASAP 2050  Operator’s Manual Appendix C
T4 =

where    

Cheng/Yang Correction

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the 
equations for the different geometrics:

where

G(L) = one of the Horvath-Kawazoe equations given above
θ = degree of void filling; θ is estimated by first computing the monolayer 

capacity (Vm) with the Langmuir equation over the range of data points from 
relative pressure 0.02 to 0.2 or the maximum relative pressure included in the 
Horvath-Kawazoe analysis. θ is computed as the volume adsorbed over Vm.

Interaction Parameter

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients -

where

MC2 = kinetic energy of electron (0.8183 x 10-6 erg)
αS = polarizability of sample atoms (cm3)
αA = polarizability of gas molecule (cm3)
χS = diamagnetic susceptability of sample atom (cm3)

1
1 S+( )8

------------------- 1
1 S–( )8

-------------------–

S L d0–
L

--------------=

P
Po
-------⎝ ⎠
⎛ ⎞ln G L( ) 1 1

θ
--- 1

1 θ–
------------⎝ ⎠
⎛ ⎞ln––=

AS
6 MC2 αS αA×××

αS

χS
----- αA

χA
------+

---------------------------------------------=

AA
3 MC2 αA χA×××

2
---------------------------------------------=
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χA = diamagnetic susceptability of gas molecule (cm3)

where:

NA = number of gas molecules/cm2 at monolayer from the Horvath-Kawazoe 
Physical Properties dialog 

NS = number of sample atoms/cm2 from the Horvath-Kawazoe Physical Properties 
dialog 

Refer to Interaction Parameter Components later in this Appendix for recommended 
values.

Additional Calculations

Based on the previous calculations, the following can be calculated:

Adjusted Pore Width (Å):
         (Shell to Shell)

Cumulative Pore Volume (cm3/g):

 

where 

D = density conversion factor (cm3 liquid/cm3 STP) on the Adsorptive Properties 
dialog box

dV/dD Pore Volume (cm3/g-Å): 

 

IP NA A× A( ) NS AS×( )+=

ALI LI DS–=

VCUMI
VI D×=

dV
dDI
---------

VCUMI
VCUMI 1–

–
ALI ALI 1––

--------------------------------------=
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Median Pore Width (Å):

 

where

VCUMN = total cumulative pore volume (VCUMI) for points designated for Horvath-
Kawazoe calculations

VHALF = 50% of total cumulative pore volume 
VL = cumulative pore volume (VCUMI) for first point less than VHALF
VG = cumulative pore volume (VCUMI) for first point greater than VHALF
DL = pore width (LI) that corresponds to VL 
DG = pore width (LI) that corresponds to VG

VHALF
VCUMN

2
--------------=

DMED 10 DL( )log VHALF( ) VL( )log–log[ ]
DG( ) DL( )log–log
VG( ) VL( )log–log

----------------------------------------------×+=
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Interaction Parameter Components

Table C-1. Interaction Parameters

The following values were used to calculate the values in Table C-1.

Gas

Bath 
Temperature

(K) Sample Type

Interaction 
Parameter 
Calculated 

Value*

Argon  87.3 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

2.61
5.89
3.19

Carbon 
Dioxide

298.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.20
9.20
5.08

273.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.34
9.35
5.22

194.65 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

4.72
9.72
5.60

Nitrogen  77.15 Carbon (Ross/Olivier value)
Carbon (Horvath/Kawazoe value)
Zeolite

2.84
6.53
3.49

*The interaction parameter is entered in the Horvath-Kawazoe Report Options dialog in the 
following field:

Interaction parameter: (calculated value) x 10-43 ergs-cm4

Carbon-Graphite Zeolite
DS = 3.40 DS = 3.04
NS = 3.845 x 1015 NS = 3.75 x 1015

χS = 1.05 x 10-29  (Ross/Olivier) χS = 1.94 x 10-29

13.5 x 10-29 (Horvath/Kawazoe, implicit) αS = 0.85 x 10-24

αS = 1.02 x 10-24

Nitrogen Argon
DA = 3.00 DA = 2.95
ΝA = 6.71 x 1014 ΝA = 7.608 x 1014

χA = 3.6 x 10-29 χA = 3.22 x 10-29

αA = 1.76 x 10-24 αA = 1.63 x 10-24
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DA values are from van der Waal’s constant.
NA values are from liquid densities.
χ and α values are derived from data found in Ross and Olivier12.

The physical parameters referenced in Saito/Foley are as follows:

Carbon Dioxide
DA = 3.23
NA = 4.567 x 1014 (25 ºC)

5.45 x 1014 (0 ºC)
7.697 x 1014 (-78 ºC)

χA = 5.0 x 10-29

αA = 2.7 x 10-24

Aluminophosphate Aluminosilicate
DS = 2.60 DS = 2.76
NS = 1.48 x 1015 Ns = 1.31 x 1015

χS = 1.3 x 10-29 χS = 1.3 x 10-29

αS = 2.5 x 10-24 αS = 2.5 x 10-24
Jul 07                                                   C-27 



Appendix C ASAP 2050  Operator’s Manual
Dubinin-Radushkevich

The Dubinin-Radushkevich13 equation is as follows:

 

where:

V = volume adsorbed at equilibrium pressure (cm3/g STP)
Vo = the micropore capacity (cm3/g STP)
Po = saturation vapor pressure of gas at temperature T (mmHg) 
P = equilibrium pressure (mmHg)
B = a constant
β = the affinity coefficient of analysis gas relative to Po gas 

(for this application β is taken to be 1)
T = analysis bath temperature (K), from the Po and Temperature 

Options dialog box 

For each point designated for Dubinin-Radushkevich calculations, the following calculations 
are done:

LV = log (V)

The intercept, log(Vo) can be found by performing a least-squares fit on the (LP,LV) desig-
nated pairs where LP is the independent variable and LV is the dependent variable. Assuming 
the adsorption of gas is restricted to a monolayer, Vo is the monolayer capacity. Based on this 
assumption, the following are calculated:    

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (SERR cm3/g STP)

d. Error of the y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

V( )log Vo( ) B T2×
 β

--------------- Po
P

-------log×
2

–log=

LP Po
P

-------⎝ ⎠
⎛ ⎞

2
log=
C-28                                                    Jul 07



ASAP 2050  Operator’s Manual Appendix C
Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Vo = 10YI

Error of Monolayer Capacity (cm3/g STP):

VoERR = Vo x (10YIERR - 1.0)

Micropore surface area (m2/g):

where

σ = molecular cross sectional area of gas (nm2)from the Adsorptive Properties 
dialog box 

SDP σ Vo 6.023 1023×( )××
22414 cm3 1018 nm2/m2( )×
--------------------------------------------------------------------=
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Dubinin-Astakhov

The Dubinin-Astakhov equation is a follows:

 

where

V = volume adsorbed at equilibrium pressure (cm3/g STP)
Vo = the micropore capacity (cm3/g STP)
Po = saturation vapor pressure of gas at temperature T (mmHg) 
P = equilibrium pressure (mmHg)
T = analysis bath temperature (K) 
R = the gas constant (0.0083144 kJ/mol)
E0 = characteristic energy (kJ/mole)
N = Astakhov exponent, may be optimized or user entered from the Dubinin 

Report Options dialog box
β = the affinity coefficient of the analysis gas relative to the Po gas, from the 

Dubinin Adsorptive Options dialog box

For each point designated for Dubinin-Astakhov calculations, the following calculations are 
done:

LV = log(V)

A least-squares fit is performed on the (LP,LV) designated pairs where LP is the independent 
variable and LV is the dependent variable. If the user selected yes for the Optimize Astakhov 
Exponent prompt, a systematic search for the optimum value of N is conducted by recalcu-
lating the linear regression and selecting the value of N that gives the smallest standard error 
of the y-intercept. The exponent N is optimized to within 10-4. If the optimum value for N is 
not found in this range, an exponent of 2 is used. The following are calculated:     

a. Slope (S cm3/g STP)

b. Y-intercept (YI cm3/g STP)

c. Error of the slope (SERR cm3/g STP)

d. Error of the y-intercept (YIERR cm3/g STP)

e. Correlation coefficient (Cc)

f. Optimized Astakhov exponent (N)

V( )log Vo( ) RT
βE0
---------

N Po
P

-------log×
N

–log=

LP Po
P

-------log
N

=
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Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

V0 = 10YI

Micropore Volume (cm3/g):

WI = (VI x D)

where

D = density conversion factor (cm3 liquid/cm3 STP) from the Adsorptive 
Properties dialog box

Limiting Micropore Volume (cm3/g):

W0 = (V0 x D)

where 

D = density conversion factor (cm3 liquid/cm3 STP) from the Adsorptive 
Properties dialog box

Error of Limiting Micropore Volume (cm3/g):

W0ERR = W0 x (10YIERR - 1.0)

Characteristic Energy (KJ/mole):

Modal Equivalent Pore Width (nm):

where 

k = the interaction constant for benzene, 8.969 kJ•nm3/mol

E 2.303 R T××
β 2.303 S×( )1/N
-------------------------------------=

wmode 2 3N
3N 1+
----------------

1/N k
E0
-----×

⎩ ⎭
⎨ ⎬
⎧ ⎫

1/3

×=
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Maximum Differential Pore Volume (cm3/g-nm):

This value is also known as frequency of the mode

Mean Equivalent Pore Width (nm):

Micropore surface area (m2/g):

Γ is calculated by a polynomial approximation over the domain 0 ≤ x ≤ 1 as follows:

Γ(x+1) = 1+b1x + b2x2 + b3x3 + b4x4 + b5x5 + b6x6 + b7x7 + b8x8 + ε(x) | ε(x) |  ≤ 3 x 10-7

where

b1 = -0.57719 1652
b2 =   0.98820 5891
b3 = -0.89705 6937
b4 =   0.91820 6857
b5 = -0.75670 4078
b6 =   0.48219 9394
b7 = -0.19352 7818
b8 =   0.03586 8343

and where

dV
dwmode
----------------Max 0.5 3N 1+( )× Wo× 3N 1+

3N
----------------

1/3N
×

E0

k
-----×

1/3 3N 1+
3N

----------------–⎝ ⎠
⎛ ⎞exp×=

wmean 2

k
E0
-----

1/3

Γ 3N 1+
3N

----------------⎝ ⎠
⎛ ⎞

--------------------------×=

SDA 1000 2.0 W0××
E0

k
-----

1/3

× Γ 3N 1+
3N

----------------⎝ ⎠
⎛ ⎞×=

x 1+ 3N 1+
3N

----------------⎝ ⎠
⎛ ⎞=
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Equivalent Pore Width (nm):

dV/dw Pore Volume (cm3/g-nm):

MP-Method

For each point designated for MP-method14 calculations, the following calculations are done:

Thickness for the Ith point (Å):

(Halsey6)     

or

(Harkins and Jura7)

where:

tI = thickness for Ith point 
HP1 = Halsey parameter #1
HP2 = Halsey parameter #2
HP3 = Halsey parameter #3
HJP1 = Harkins and Jura parameter #1
HJP2 = Harkins and Jura parameter #2
HJP3 = Harkins and Jura parameter #3
PrelI = relative pressure for the Ith point (mmHg)

wi 2

k
E0
-----⎝ ⎠
⎛ ⎞ N

–

W( i ) W0( )ln–ln
-----------------------------------------×

1/3N

=

dV
dwi
-------- 0.5 W0 3N k

E0
-----

N
×××

wi

2
-----⎝ ⎠
⎛ ⎞

3N 1+( )–

× k
E0
-----⎠
⎞ N

⎝
⎛ wi

2
-----⎝ ⎠
⎛ ⎞

3N–

×–exp×=

tI HP1 HP2
PrelI
( )ln

--------------------×
HP3

=

tI
HJP1

HJP2 PrelI
( )log–

-------------------------------------------
HJP3

=
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With the (tI,VI) data pairs, the Akima semi-spline interpolation method is used to interpolate 
volume adsorbed values based on thickness values that are evenly spaced 0.2 Angstrom apart 
starting at the first outlier point. Outliers are defined as those points have the maximum 
instantaneous slope within an iteratively shrinking subset of all points. The remaining pore 
surface area calculation result is the slope of the line defined by two consecutive interpolated 
points. The slopes of each pair of consecutive points from the origin to the last point must be 
monotonically decreasing and non-negative. With the interpolated points set the following 
can be calculated:

Average pore hydraulic radius (Å):

 

Remaining pore surface area for the Ith point (m2/g):

 

where 

D = density conversion factor (cm3 liquid/cm3 STP) on the Adsorptive Properties 
dialog box

Incremental pore surface area occluded for the Ith point (m2/g):

 

Cumulative pore surface area occluded for the Ith point (m2/g):

  

dA/dR pore surface area for the Ith point (m2/g-Å):

 

Incremental pore volume occluded for the Ith point (cm3/g):

 

RI
tI tI 1–+

2
------------------=

SI
VI VI 1––( ) D 10 6–  m3/cm3×( )×

tI tI 1––( ) 10 10– m/A×
-------------------------------------------------------------------------------=

SINCI
SI 1– SI–=

SCUMI
SINCI

SINCI 1–
… SINC1

+ + +=

dA
dRI
--------

SINCI

tI tI 1––
------------------=

VINCI
SINCI

104 cm2/m2×( ) RI 10 8–  cm/Å×( )×=
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Cumulative pore volume occluded for the Ith point (cm3/g):

 

dV/dR pore volume for the Ith point (cm3/g-Å):

 

Freundlich Isotherm

The Freundlich isotherm has the form:

where 

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
C = temperature-dependent constant
m = temperature-dependent constant

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Taking the log of both sides yields:

VCUMI
VINCI

VINCI 1–
… VINC1

+ + +=

dV
dRI
--------

VINCI

tI tI 1––
------------------=

Q
QS
------ CP1/m=

Q QSCP1/m=

Qlog  QS C 1
m
----  Plog+log=
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Temkin Isotherm

The Temkin isotherm has the form,

where

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
q0 = the differential heat of adsorption at zero surface coverage
A0 = a0 exp {-q0/RT}, where α0 and a0 are adjustable constants

In terms of quantity adsorbed,

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight 
line with slope RTQS/q0 and intercept (ln A0) RTQS/q0α.

Q
QS
------ RT

q0α
--------- A0P( )ln=

Q
RTQS

q0α
-------------- A0  P

Po
-------⎝ ⎠
⎛ ⎞ln+ln=
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DFT (Density Functional Theory)

The adsorption isotherm is known to convey a great deal of information about the energetic 
heterogeneity and geometric topology of the sample under study. The data of physical adsorp-
tion have been used for many years as the basis for methods to characterize the surface area 
and porosity of adsorbents. Real solid surfaces rarely approach ideal uniformity of structure. 
It is accepted that in general, the surface of even a nonporous material presents areas of 
greater or lesser attraction for adsorbed molecules. 

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the 
result that simple theories such as the Langmuir and BET formulas can, at best, give only 
approximate estimates of surface area. Porous solids virtually are never characterized by a 
single pore dimension, but instead exhibit a more or less wide distribution of sizes. The 
observed adsorption isotherm for a typical material is therefore the convolution of an adsorp-
tion process with the distribution of one or more properties which affect that process. This 
was first stated mathematically by Ross and Olivier12 for the case of surface energy distribu-
tion and has become known as the integral equation of adsorption.

The Integral Equation of Adsorption

In a general form for a single component adsorptive, the integral equation of adsorption can 
be written as

(1)

where

Q(p) = the total quantity adsorbed per unit weight at pressure p,
a,b,c,... = a set of distributed properties,
f(a,b,c,...) = the distribution function of the properties, and
q(p,a,b,c,...) = the kernel function describing the adsorption isotherm on unit 

surface of material with fixed properties a,b,c,...

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known 
as ill-posed, in that there are an infinite number of functional combinations inside the integral 
that will provide solutions. Even when the kernel function is known, experimental error in the 
data can make solving for even a single distribution function a difficult task. Solving for mul-
tiple distribution functions requires more data than provided by a single adsorption isotherm.

Q p( ) a d b d c…q p a b c…, , ,( ) f a b c…, ,( )d∫=
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Application to Surface Energy Distribution

Under certain conditions, an energetically heterogeneous surface may be characterized by a 
distribution of adsorptive energies. The conditions are that the sample is not microporous, i.e., 
that adsorption is taking place on essentially a free surface with no pore filling processes at 
least to about 0.2 relative pressure. Secondly, that each energetically distinct patch contributes 
independently to the total adsorption isotherm in proportion to the fraction of the total surface 
that it represents. This condition is satisfied if the patches are relatively large compared to an 
adsorptive molecule, or if the energy gradient along the surface is not steep. In mathematical 
terms, this concept is expressed by the integral equation of adsorption in the following form.

(2)

where

Q(p) = the experimental quantity adsorbed per gram at pressure p,
q(p,e) = the quantity adsorbed per unit area at the same pressure, p, on 

an ideal free surface of energy e, and 
f(e) = the total area of surface of energy e in the sample.

The exact form of the energy-dependent term depends on the form of the model isotherms 
expressed in the kernel function and is provided in the model description (refer to Appendix 
G for model descriptions).

Application to Pore Size Distribution

Similarly, a sample of porous material may be characterized by its distribution of pore sizes. 
It is assumed in this case that each pore acts independently. Each pore size present then con-
tributes to the total adsorption isotherm in proportion to the fraction of the total area of the 
sample that it represents. Mathematically, this relation is expressed by 

(3)

where 

Q(p) = the experimental quantity adsorbed at pressure p,
q(p,H) = the quantity adsorbed per unit area at the same pressure, p,  in 

an ideal pore of size H, and 
f(H) = the total area of pores of size H in the sample.

Numerical values for the kernel functions in the form of model isotherms can be derived from 
modern statistical mechanics such as density functional theory or molecular simulations, or 
can be calculated from one of various classical theories based on the Kelvin equation. Several 
types are found in the models library.

Q p ) ε q p ε,( ) f ε( )d∫=(

Q p( ) H q p H,( ) f H( )d∫=
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Performing the Deconvolution

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes 
in the model. The functions q(p,e) and q(p,H), which we call the kernel functions, are con-
tained in numeric form as model isotherms. Because, in general, there is no analytic solution 
for equation (1), the problem is best solved in a discrete form; the integral equation for any 
distributed property Z becomes a summation:

(4)

Given a set of model isotherms, q(p,Z), from a model chosen from the models library and an 
experimental isotherm, Q(p), contained in a sample information file, the software determines 
the set of positive values f(Z) that most nearly, in a least squares sense, solves equation (4). 
The distributed property, surface energy or pore size, is then displayed on the Report Options 
dialog box as a selection of tables or graphs. 

Regularization

DFT allows a selectable regularization (also referred to as smoothing) constraint to be applied 
during the deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting 
models. The method used is based on co-minimization of the second derivative of the distri-
bution. The relative weight given to this term is determined by the value of the regularization 
parameter, which is set on the DFT Pore Size or Surface Energy dialog box and also is shown 
in the header of reports. The value of the regularization parameter varies from zero (for no 
second derivative constraint) to ten (indicating a weight equal to minimizing the residuals), or 
even larger. When the distribution and residuals obtained change little with the value of the 
regularization parameter, it indicates that the chosen model provides a good representation of 
the data. Conversely, a large sensitivity to the regularization parameter might indicate inade-
quate data or a poor choice of model to represent the data.

Q p( ) q p Zi,( ) f Zi( )
i
∑=
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Summary Report

The following calculations and the results of previous calculations (as noted) are used to gen-
erate the summary report:

a. BET Surface Area

See BET Surface Area Calculations

b. Langmuir Surface Area

See Langmuir Surface Area Calculations 

c. Single Point Surface Area (m2/g)

where 

Pr = pressure closest to 0.3 of the relative pressure points designated for surface area 
calculations. 

Va = volume corresponding to Pr

d. Micropore Area

See t-Plot calculations.

e. Micropore Volume

See t-Plot calculations.

f. Horvath-Kawazoe Maximum Pore Volume

See Horvath-Kawazoe Calculations

g. Horvath-Kawazoe Median Pore Diameter

See Horvath-Kawazoe Calculations

h. Dubinin-Radushkevich Micropore Surface Area

See Dubinin-Radushkevich Calculations

i. Dubinin-Radushkevich Monolayer Capacity

See Dubinin-Radushkevich Calculations

S1PT
Va 1 Pr–( )×[ ] CSA 6.023 1023×( )××

22414 cm3 STP 1018 nm2/m2×
-------------------------------------------------------------------------------------------------=
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j. Dubinin-Astakhov Micropore Surface Area

See Dubinin-Astakhov Calculations

k. Dubinin-Astakhov Micropore Volume

See Dubinin-Astakhov Calculations

 l. MP-Method Cumulative Surface Area of Pores

MPSTOT = SCUMI, (see MP-method Calculations) for the last collected data point used 
in the MP-method Calculations, and the range of hydraulic pore radii over which the 
cumulative surface area was computed. 

m. MP-Method Cumulative Pore Volume of Pores

MPVTOT = VCUMI, (see MP-method Calculations) for the last collected data point 
used in the MP-method Calculations, and the range of hydraulic pore radii over 
which the cumulative pore volume was computed. 

n. Average Pore Hydraulic Radius (A)

  

MPDAVER
MPVTOT

MPSTOT
-------------------- 10 6–× m3/cm 1010 Å/m×=
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SPC Report Variables

Regressions Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares methd. 
(Refer to BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE 
Publications/McGraw Hill, p. 16.) If there is only a single point or all N points have the same 
x-value, there can be no line of best fit in the standard form.

The coefficient of Correlation for this line is also calculated in the usual way. (Refer to Math-
ematical Handbook for Scientists and Engineers, by Granino A. Korn and Theresa M. Korn, 
Copyright 1961, 1968 McGraw Hill, Sec. 18.4.)

XAve Σ xi

N
---------=

YAve Σ yi

N
---------=

Slope Σ xi XAve–( ) yi YAve–( )

Σ xi XAve–( )2
--------------------------------------------------------------=

σx
Σ xi XAve–( )2

N
------------------------------------=

σy
Σ yi YAve–( )2

N
------------------------------------=

Cov x y,( )
Σ xi XAve–( ) yi YAve–( )

N
--------------------------------------------------------------=

Correlation Coefficient Cov x y,( )
σxσy

-----------------------=
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Control Chart Variables

  

Mean Σ yi

N
---------=

StdDev Σ y Mean–( )2

N 1–
------------------------------------=

CoefVar StdDev
Mean

-------------------=

PlusNSig Mean n StdDev⋅+=

MinusNSig Mean n StdDev⋅–=
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D.  TESTING FOR LEAKS

This appendix contains general instructions for testing the ASAP 2050 for leaks. If the ana-
lyzer successfully performs a blank tube analysis using nitrogen, you do not need to test for 
leaks. 

These procedures may be performed individually or sequentially. Record pressure readings on 
the Valve Test Data Sheet included at the end of this appendix. After you finish testing for 
leaks, replace any leaking valves.

You will need the following items to perform tests:

• Stopwatch
• Valve Test Data Sheet (included in this appendix)

Testing Individual Valves

Analysis Valves

This procedure removes differential pressure from all valves in the analysis system and estab-
lishes that there are no leaks in the analysis system. It should be performed before testing for 
individual valves.

1. Ensure that the analyzer is idle.

2. Close the regulator outlet valve for each gas supply line to the analyzer.

3. Attach the Po tube to the Po port.

4. Insert a plug (or attach a clean, empty sample tube) into the analysis port.

5. Insert a plug into the vapor inlet (if the vapor option is not installed).
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6. Select Show Instrument Schematic, then Enable Manual Control from the Unit menu. 
Table D-1 lists descriptions of the analysis valves.

Table D-1. Analysis Valve Descriptions

7. Open valves 1, 2, 4, 5, and 7; close all other manifold valves.

8. Open valve PS.

9. Open valve 3 and allow the pressure to drop below 1000 µmHg (1 mmHg).

10. Repeat Step 9 for valves P1 through P6.

11. Open valve 9. 

Valve Description

1 Unrestricted vacuum
2 Restricted vacuum
3 Helium inlet port valve
4 Highly restricted analysis gas
5 Partially restricted analysis gas
7 Lower manifold isolation
8 Vapor inlet port
9 Sample port
10 Restricted Psat tube port
11 Unrestricted Psat tube port

P1 through P6 Gas inlet port valves
PS Supply valve for physisorption gases
PV Vacuum valve for physisorption gases
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12. Open valves 10 and 11.

13. Open valve 8.

14. Open valve PV.

15. Allow the system to evacuate for a minimum of one hour; a four-hour or overnight 
evacuation is preferred.

16. Obtain the manifold outgassing rate using a vacuum gauge:

a. Close valves 3, 4, 5, 8, 9, 10, 11, and P1 through P6.

b. Evacuate manifold for another 30 minutes.

c. Take a pressure reading; record it as P1 for the manifold.

d. Close valves 1 and 2.

e. Wait 10 minutes and take another pressure reading; record it as P2 for the manifold.

f. Subtract P1 from P2 and divide the difference by 10 to obtain the outgassing rate per 
minute; 

Outgassing rate = 

Record this value as the outgassing rate for the manifold. This value should be less 
than 0.5 µmHg/min. for the lower manifold alone and less than 0.7 µmHg/min. for 
the upper and lower manifolds combined.

17. Obtain the gas inlet valve outgassing rate:

a. Open valves PS and 5; valve 7 should still be open.

b. Take a pressure reading; record it as P1 for the gas inlet valve.

c. Wait 10 minutes and take another pressure reading; record it as P2 for the gas inlet 
valve.

d. Subtract P1 from P2 and divide the difference by 10; record this value as the outgas-
sing rate for the gas inlet valve. This value should be less than 0.7 µmHg/min.

P2 P1–
10

--------------------
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Valves 3 and P1 through P6

1. Open the regulator outlet valve for the gas connected to port 3.

2. Take a pressure reading; record it as P1 for valve 3.

3. Wait 10 minutes and take another pressure reading; record it as P2 for valve 3.

4. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for Valve 3. This value should be less than 0.7 µmHg/min.

5. Repeat Steps 1 through 4 for valves P1 through P6 to which a gas is attached. Record the 
values on the Valve Test Data Worksheet in the spaces provided.

Valves PS, 5, and 7

1. Close valve PS.

2. Open valve P1 for 60 seconds, then close it.

3. Take a pressure reading; store it as P1 for valve PS.

4. Wait 10 minutes and take another pressure reading; record it as P2 for valve PS.

5. Subtract P1 from P2 and divide the difference by 10; record the value as the outgassing 
rate for Valve PS. This value should be less than 0.7 µmHg/min.

6. Close valve 5 (close Valve 4 if open).

7. Open valve PS. 

8. Open valve P1 for 30 seconds, then close it. 

9. Take a pressure reading; record it as P1 for valve 5.

10. Wait 10 minutes and take another pressure reading; record it as P2 for valve 5.

11. Subtract P1 from P2 and divide the difference by 10.; record this value as the outgassing 
rate for Valve 5. This value should be less than 0.7 µmHg/min.

12. Close valve 7; open valve 5.

13. Open valve P1 for 30 seconds, then close it.

14. Take a pressure reading; record it as P1 for valve 7.

15. Wait 10 minutes and take another pressure reading; record it as P2 for valve 7.

16. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for Valve 7. This value should be less than 0.5 µmHg/min.
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Valves 1, 2, 8, 9, 10, 11, and PV

Valves 10 and 11

1. Open valve PV; wait 5 minutes (Valves PS and 5 should be open.).

2. Open valve 7; allow the system to evacuate to below vacuum setpoint (should be 10 
µmHg or less).

3. Close valves PV, PS, and 5.

4. Open valves 1 and 2; allow the system to evacuate for 30 minutes. 

Valves 1, 2, and 7 should be the only valves open at this time.

5. Remove the Po tube. 

6. Take a pressure reading; record it as P1 for valves 10 and 11.

7. Wait 10 minutes and take another pressure reading; record it as P2 for valves 10 and 11.

8. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for Valves 10 and 11. This value should be less than 0.7 µmHg/min.

Valve 9

9. Remove the sample tube from the analysis port.

10. Take a pressure reading; record it as P1 for valve 9.

11. Wait 10 minutes and take another pressure reading; record it as P2 for valve 9.

12. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve 9. This should be less than 0.7 µmHg/min.

Valve 8

13. With valve 8 closed, remove the plug from the vapor inlet port on the side of the analyzer.

If the vapor accessory is installed, disconnect it from the analyzer.

14. Take a pressure reading; record it as P1 for valve 8.

15. Wait 10 minutes and take another pressure reading; record it as P2 for valve 8.

16. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve 8. This value should be less than 0.7 µmHg/min.

17. Before proceeding, reinstall the sample tube, the Po tube, and the plug from the vapor inlet 
(or the vapor accessory).
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Valves 1, 2, and PV

18. Open valves 1 and 2.

19. Open valves 4, 5, and PS.

20. Allow the system to evacuate for 15 minutes.

21. Close valves 1 and 2. Valve PV should be closed; if not, close it.

22. Take a pressure reading; record it as P1 for valves 1, 2, and PV.

23. Wait 10 minutes and take another pressure reading; record it as P2 for valves 1, 2, and PV.

24. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valves 1, 2, and PV. This value should be less than 0.7 µmHg/min.

25. Fill the manifold to 800 mmHg with N2, then close the nitrogen port valve.

26. Close valve 4.

27. Take a pressure reading; record it as P1 for valve PV.

28. Wait 10 minutes and take another pressure reading; record it as P2 for valve PV.

29. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve PV. This value should be less than 50 µmHg/min.

If the pressure drops more than 50 µmHg, close valve 5, the PV valve may be leaking.

30. Take another pressure reading; record it as P1 for valves 1 and 2.

31. Wait 10 minutes and take another pressure reading; record it as P2 for valves 1 and 2.

32. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valves 1 and 2. This value should be less than 50 µmHg/min. 

If the pressure drops more than 0.05 mmHg, close valve 7, valves 1 or 2 may be leaking.

33. Take another pressure reading; record it as P1 for valve 1.

34. Wait 10 minutes and take another pressure reading; record it as P2 for valve 1.

35. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve 1. This value should be less than 50 µmHg/min. 

If the pressure drops more than 50 µmHg, valve 1 may be leaking.
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Degas Valves

Perform the following steps before testing the individual degassing valves.

1. Ensure that the analyzer is idle.

2. Close the regulator outlet valve for the backfill gas.

3. Insert a plug into (or attach a clean, empty sample tube) each degas port.

4. Select Degas, Show Degas Schematic, then Degas, Enable Manual Control from the 
Unit menu. Table D-2 lists descriptions of the degas valves.

Table D-2.  Degas Valve Descriptions

5. Open Valves D5, D1, D2, and then D7.

6. Open Valve D6.

7. Allow the degas system to evacuate to the vacuum setpoint, then evacuate for 60 minutes.

8. Close Valves D1, D2, D5, D6, and D7.

9. Take a pressure reading and record it as P1 for the preliminary test.

10. Wait 10 minutes and take another reading; record it as P2 for the preliminary test.

11. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for the preliminary test. This value should be less than 10 µmHg/min.

Valve Description

D1 and D2 Degas port valves
D5 Vacuum valve
D6 Servo isolation valve
D7 Gas inlet port valve
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What To Do If You Detect a Leaking Valve

If you determine that a specific valve is leaking, remove differential pressure from the valve 
and continue testing the remaining valves for leaks.

Removing Differential Pressure from a Leaking Valve

1. Select either of the following actions:

• Close the regulator outlet valve for the gas supply line to the valve.
• Reinstall the plug that was removed to test the valve.

2. Open the leaking valve. 

3. Evacuate the analyzer until you obtain an outgas rate of less than 0.7 µmHg per minute. 
Refer to Testing Individual Valves on page D-1 for detailed instructions on determining 
the outgas rate for specific valves.

Repairing or Replacing a Leaking Valve

Whether you repair or replace a valve depends on the type of valve that is leaking. 

• Valves on the Analysis manifold should be repaired
• Valves on the Degas and inlet manifold should be replaced. 

Repairing Valves on the Analysis Manifold 

1. Backfill the manifold with nitrogen to approximately 800 mmHg.

• Close off the helium gas supply if you are repairing the helium inlet valve.
• Turn off the vacuum pump system if you are repairing a vacuum valve.

2. Remove and replace the plunger and gasket for the leaking valve.

As an alternative, you may repair or replace the leaking valve after removing the 
differential pressure on the valve. However, opening the analysis system to 
replace or repair a valve exposes the analyzer manifold to atmospheric gases and 
moisture. These gases and moisture greatly increase the time required to 
evacuate the analyzer and prepare it for further testing or operation.
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3. Closely inspect the valve seat area for any debris which may cause another leak.

4. Reassemble the valve.

• Reopen the helium supply if you are repairing the helium inlet valve.
• Turn on the vacuum pump system if you are repairing a vacuum valve.

5. Open and close the repaired valve approximately 20 to 30 times; this allows the valve to 
seat properly.

6. Evacuate the analyzer until the outgas rate is less than 0.7 µmHg per minute. Refer to 
Testing Individual Valves on page D-1 for detailed instructions.

                 Plunger

 Gasket
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Replacing Valves on the Degas and Gas Inlet Manifold

1. Backfill the manifold with nitrogen to approximately 800 mmHg.

2. Turn off the gas supply for the gas inlet valves.

3. Turn off the degas vacuum system for access to degas valves 5 or 6.

4. Disconnect the wiring from the valve.

5. Unscrew and remove the valve from the manifold.

6. Install the new valve, then reconnect the wiring.

7. Turn on the gas supply and vacuum pump system.

8. Evacuate the analyzer until the outgas rate is less than 0.7 µmHg/min. for inlet valves or 
10 µmHg/min. for degas valves. Refer to  Testing Individual Valves on page D-1 for 
detailed instructions.

   Inlet Valve                                     Degas Valve
D-10                                                    May 2010



Appendix D ASAP 2050 Operator’s Manual
Valve Data Test Sheet

Make a copy of this form to record pressure readings and outgassing rates when leak-testing 
system valves. 

VALVE(s)
P1

(1st pressure reading)
P2

(2nd pressure reading) OUTGASSING RATE

Analysis Valves

Manifold

Gas inlet valve

3

P1

P2

P3

P4

P5

P6

PS

5

7

10 and 11

9

8

1, 2, and PV

1, 2, and PV

1 and 2

1

Degas Valves

Manifold
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E.  CALCULATING FREE-SPACE VALUES

Many microporous materials, such as zeolites and activated carbons, trap and hold helium in 
their complex pore structures for many hours after being exposed to helium. Helium trapped 
in micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at 
the lower end of the isotherm. For this reason, it is recommended that you enter the ambient 
and analysis free-space volumes when performing micropore analyses, therefore avoiding 
exposure of the sample to helium. Two techniques can be used for determining ambient and 
analysis free-space values.

The first method is to perform a short analysis on the sample after partial degassing (one pres-
sure point with no incremental dosing), but prior to final sample preparation. Measure the free 
space during this analysis. The measured free-space values will be printed on the report and 
may then be entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the 
sample analyses. The measured free-space data can be used thereafter on every analysis per-
formed using these sample tubes. This small initial investment of time will save considerable 
time later. Perform an empty tube analysis on each sample tube you intend to use for 
micropore analysis. Measure the free space of each sample tube, taking only one pressure 
point. Four important things to remember are: 1) be consistent in using seal frits; for example, 
use the same seal frits for the analysis as you did for the empty tube test; 2) since the analysis 
free space is dependent on bath temperature, perform a test for each bath temperature to be 
used; 3) the isothermal jacket must be in the same position for the sample analysis as it was 
for the empty tube test; and 4) correct the free-space volumes obtained for the volume dis-
placed by the sample when you use them.

To make the correction, subtract the amount of gas displaced by the sample. The calculations 
are simple and are given here with a brief explanation of their derivation. Remember to 
employ the appropriate free-space values for each bath temperature used, stating all temper-
atures in Kelvin.

To correct ambient free space:

 

where 

Vws = calculated ambient free space with sample present (in standard cm3)
Vwm = ambient free space measured for the empty tube (in standard cm3)
Ms = mass of sample to be analyzed (in grams)

rs = approximate sample true density (in grams/cm3)
Tamb = ambient temperature (in Kelvin)
Tstd = standard temperature (273.15 Kelvin) 

Vws Vwm
Ms
ρs
-------

Tstd
Tamb
------------× ⎠

⎞
⎝
⎛–=
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To correct analysis free space:

where
Vcs = calculated analysis free space with sample present (in standard cm3)
Vcm = analysis free space measured for the empty tube (in standard cm3)
Ms = mass of the sample to be analyzed (in grams)
rs = approximate sample true density (in grams/cm3)
Tbath = analysis bath temperature (in Kelvin)
Tstd = standard temperature (273.15 Kelvin)

When you later analyze a sample, select Enter Free Space, and use the values calculated 
above.

Example:
The sample is 0.2345 grams of activated carbon with a density of 2.0000 g/cm3. The room 
temperature is 22 ºC or 295.15 K. The analysis tube has been measured previously in an argon 
bath. The measured ambient and analysis free spaces are 29.1234 and 89.4567 cm3 STP atm-1, 
respectively. The analysis will be performed with argon at liquid argon temperature, 87.3 K. 

With this information, enter the corrected ambient free space as follows:

and enter the corrected analysis free space as follows:

Vws 29.1234 cm3 STP 0.2345 g

2.0000 g/cm3
---------------------------------- 273.2 K

295.2 K
-------------------× ⎠

⎞ 29.0149 cm3 STP atm 1–=⎝
⎛–=

Vcs 89.4567 cm3 STP 0.2345 g

2.0000 g/cm3
---------------------------------- 273.2 K

87.3 K
-------------------× ⎠

⎞ 89.0898 cm3 STP atm 1–=⎝
⎛–=
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F.  DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In 
the experimental physical sciences, theories are often expressed in terms of a model that can 
be visualized and described mathematically. Early models of physical adsorption were quite 
simple, both conceptually and mathematically, for very practical reasons — hand computa-
tions were required. Today we can explore complex models that describe adsorption systems 
on the atomic scale of size and sub-picosecond time frame. This is not because scientists are 
smarter, but because of available tools. The DFT models are created by classical approaches 
to adsorption as well as models based on modern statistical thermodynamics. 

Models Based on Statistical Thermodynamics

Included in this group are methods that model the adsorption system in terms of forces acting 
between individual molecules. 

Theoretical Background

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an 
isotherm equation containing a small number of parameters. At a minimum, these parameters 
include the extent of the surface, such as the monolayer capacity (Vm), and the molar inten-
sity of the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” 
constant. In some equations, additional parameters take into account the lateral interaction of 
adsorbed molecules with each other. Other theories, such as the Dubinin-Astakhov approach, 
also include parameters for the effect of adsorbent porosity. 

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based 
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the micro-
scopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, 
the pore size, the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed.

A clean sample of a solid material containing slit-shaped pores of a single width is placed in 
an evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is 
admitted into the space surrounding the sample. The pressure within the space is recorded 
over time. In this situation, the pressure falls rapidly from its initial value and gradually 
approaches a steady reading, called the equilibrium pressure. The amount adsorbed corre-
sponds to the quantity of gas effectively removed from the gas phase by the solid surface. A 
graph that plots amount adsorbed versus equilibrium pressure is called an adsorption 
isotherm.

Under such conditions, the argon atoms that randomly enter the pore space feel the presence 
of the solid surface as the action of an external attractive force (the dispersion forces or Van 
der Waal’s forces) and spend more time near the surface. As a result, the space near the sur-
face acquires a greater average density of argon atoms than regions farther removed. 
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If the equilibrium distribution of the gas atoms near the surface could be described as a func-
tion of pressure and the molecular properties of the components of the system, then a model 
could be constructed for the adsorption isotherm for the system. Modern physical chemistry 
provides several ways to calculate this distribution. All these methods are based on the fun-
damental thermodynamic law that such a system adopts a configuration of minimum free 
energy at equilibrium. Also needed is a description of the pairwise interaction energy between 
atoms, U(s), commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance. 

Molecular Simulation Methods

Two simulation techniques are commonly used to determine the distribution of gas molecules 
in a system in equilibrium: the molecular dynamics method and the Monte Carlo method. 
Both of these are used as reference methods because their results are considered exact.

Molecular Dynamics Method

In the molecular dynamics method, the position and velocity of individual gas particles are 
calculated over time at very short intervals. This method takes into account both the forces 
acting between the gas particles themselves and those acting between the gas particles and the 
atoms of the simulated surface. As the simulated particles collide with each other and with the 
surface, the average concentration of particles in the space near the surface is calculated; this 
calculation yields the amount of gas adsorbed. 

This method can be thought of as a way to determine the chronological record of the move-
ment of each particle in the system using time steps of 10-14 seconds. Although the 
mathematics are simple, the number of calculations required for a system of even a few hun-
dred particles is astronomical and challenges even the fastest computers.

Monte Carlo Method

In the Monte Carlo method, determination of the system equilibrium distribution begins with 
an assumption (which may be only approximate) about the initial configuration of particles in 
the system. The system is “equilibrated” through a process of randomly selecting one particle 
and conditionally moving it a random distance in a random direction. 

If the move results in a configuration of lower total energy, then the move is completed and 
another particle is randomly selected to be moved. 

U s( ) σ
s
---⎝ ⎠
⎛ ⎞ 12 σ

s
---⎝ ⎠
⎛ ⎞ 6

–=
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If the move results in a configuration of higher energy, a probability for that event is calcu-
lated, and a random number between zero and one is generated. If the generated number is 
smaller than the probability of the event, then the move is accepted; otherwise, another par-
ticle is selected and the process is repeated. This process continues until the average total 
energy of the system no longer decreases; at this point, average configuration data are accu-
mulated to yield the mean density distribution of particles in the system.

Monte Carlo simulations require considerable less computation time than molecular dynamic 
simulations and can yield the same results; however, neither method provides a really prac-
tical way to calculate complete isotherms.

Density Functional Formulation

Density functional theory offers a practical alternative to both molecular dynamic and Monte 
Carlo simulations. When compared to reference methods based on molecular simulation, this 
theory provides an accurate method of describing inhomogeneous systems yet requires fewer 
calculations. Because the density functional theory provides accuracy and a reduced number 
of calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls sepa-
rated by a distance H. The pore is open and immersed in a single component fluid 
(adsorptive) at a fixed temperature and pressure. Under such conditions, the fluid responds to 
the walls and reaches an equilibrium distribution. In this condition (by the definition of equi-
librium), the chemical potential at every point equals the chemical potential of the bulk fluid. 
The bulk fluid is a homogenous system of constant density; its chemical potential* is deter-
mined by the pressure of the system using well-known equations. The fluid near the walls is 
not of constant density; its chemical potential is composed of several position-dependent con-
tributions that must total at every point to the same value as the chemical potential of the bulk 
fluid.

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free 
energy, known thermodynamically as the grand potential energy (GPE). Density functional 
theory describes the thermodynamic grand potential as a functional of the single-particle den-
sity distribution; therefore, calculating the density profile that minimizes the GPE yields the 
equilibrium density profile. The calculation method requires the solution of a system of com-
plex integral equations that are implicit functions of the density vector. Since analytic 
solutions are not possible, the problem must be solved using iterative numerical methods. 
Although calculation using these methods still requires supercomputing speed, the calculation 
of many isotherm pressure points for a wide range of pore sizes is a feasible task. The com-
plete details of the theory and the mathematics can be found in the papers listed under 
References at the end of this appendix.

The following graphs and accompanying text illustrate the results of using density functional 
theory to predict the behavior of a model system. 

*Chemical potential may be thought of as the energy change felt by a probe particle when it is inserted 
into the system from a reference point outside the system. It can also be defined as the partial derivative 
of the grand potential energy with respect to density (or concentration).
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Figure F-1 shows the density profile for argon at a carbon surface as calculated by density 
functional theory for a temperature of 87.3 K and a relative pressure of about 0.5. 

Figure F-1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5   

This figure represents a cross-section of the region near the surface. Note the layerwise dis-
tribution of adsorbate; the first monolayer is sharply defined and a third layer can be 
distinguished. The area under the profile curve represents the amount adsorbed per unit area 
at this pressure. The positions of the maxima are separated by a distance determined by the 
size of the adsorptive atom.

Given the density profile, the amount adsorbed at the stated pressure can be easily calculated 
as the integral over the profile. Repeating this calculation over a range of pressures yields the 
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained cor-
responds to that of an external, or free, surface. If H is smaller, a range of pressures is reached 
where two minima exist for the grand potential, showing the presence of two metastable 
phases having different density distributions but the same chemical potential. The phase with 
the lower GPE is the stable one. As the pressure is increased, a point is reached where the 
other phase becomes the stable one. This phase transition reflects condensation of adsorbate 
in the pore; the pressure at which it occurs is called the critical pore-filling pressure. This 
pressure is analogous to the condensation pressure predicted by the Kelvin equation in the 
classical model of pore filling.
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Figure F-2 shows how the profiles change with pressure for a model pore with H = 40 Ang-
stroms. The insets show the density profiles for the corresponding points of the isotherm.

Figure F-2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half 
of the distribution is a mirror image of the profile shown. 

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position 
close to the surface.

• Inset a shows the profile corresponding to point a on the isotherm where the surface is 
about half covered. 

• At point b, the first layer is so full that it is more favorable for atoms to start a new layer. 

• At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling 
pressure. In inset c, the profile shows the density decreasing to near zero (actually the 
bulk gas density) at 4 or 5 molecular diameters from the surface. 

• Inset d shows the profile converging on a density similar to that of bulk liquid argon in 
the center of the pore, indicating a phase transition.
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Note that the adsorption isotherms for pores larger than the one shown in Figure 4-2 is iden-
tical up to point c. The lower branch of the isotherm simply continues to a higher pressure for 
larger pores. This trend is illustrated in Figure F-3, where isotherms for some larger size pores 
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical 
filling pressures that are in good agreement with those produced by the Kelvin equation. 

Figure F-3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K    
F-6                                                    Jul 07



Appendix F ASAP 2050 Operator’s Manual
Figure F-4 shows model isotherms for pores in the micropore size range. Note the logarithmic 
scale for pressure.

Figure F-4. Model Isotherms in the Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K            

Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 mil-
litorr. Pores below 15 Å fill before a monolayer is completed on the surface of the larger 
pores. In the micropore size range, the pore volume fills more gradually with pressure and the 
total shape of the isotherm is important in characterizing the pore size. 
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Models Included

Non-Local Density Functional Theory with Density Independent Weights

N2 - DFT Model
AR - DFT Model

Using the methods of non-local density functional theory, two sets of isotherms have been 
calculated to serve as kernel functions for the characterization of porous solids from adsorp-
tion data. The model isotherms are stored in binary format files. These models assume a slit-
like pore geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geo-
metric progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A 
model for the free or external surface is included to account for unfilled pores. Each of the 92 
model isotherms has been calculated at 181 pressure points from near 1x10-6 to near 1.00 rel-
ative pressure.

These models are identical to those supplied with the original DOS version of DFT software. 
Some slight difference from the DOS results may be noted when they are applied to the same 
data due to improvements in the deconvolution algorithm and better regularization of the cur-
rent software.

Modified Non-Local Density Functional Theory with Density-Dependent 
Weights 

N2 - Modified Density Functional

Using the modified Tarazona prescription described by Olivier (refer to references 3 and 4 on 
page F-15), model isotherms were calculated for a wide range of adsorptive energies to a rel-
ative pressure of 0.6. The model makes no provision for pore filling in the micropore region. 
If the sample solid contains small mesopores, the isotherm data should be truncated (using the 
Select Data Points dialog box) to a suitably low relative pressure to avoid trying to fit this 
region; mesopore filling reports as a large area of low energy in the calculated distribution of 
adsorptive potential. 

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, 
e, for the adsorptive/adsorbent pair divided by Boltzmann’s constant. The units are therefore 
degrees Kelvin.

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K
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N2 - Cylindrical Pores - Oxide Surface

Model isotherms were calculated using a combination of statistical mechanical calculations 
and experimental observations for macroporous silicas and MCM-41 mesoporous silicas as 
well as zeolites. The pore-filling pressures were determined as a function of the pore size 
from adsorption isotherms on MCM-41 materials characterized by X-ray and other tech-
niques. The variation of the pore fluid density with pressure and pore size has been accounted 
for by density functional theory calculations. This model reports pore sizes ranging from 3.8 
to 387 Angstroms.

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Model isotherms were calculated using a combination of statistical thermodynamic Non-
Local Density Functional Theory  (NLDFT) calculations and experimental isotherms for ref-
erence samples of montmorillionite. The construction method for the hybrid models was 
analogous to that described in the first reference below (Jaroniec et al,1999). The additional 
references add additional theoretical details as well as examples of the application of the 
model to pillared clay catalysts. This model reports pore widths from 3.8 to 387 Angstroms.

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77 K

Reference: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the 
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Mesoporous 
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77 K

References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New 
Method for the Characterization of Mesoporous Silicas,” Proceedings of 
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of 
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occell, “Surface Area and Microporosity of a 
Pillared Interlayered Clay (PILC) from a Hybrid Density Functional Theory 
(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3), 
623-629.
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C02 - DFT Model

Model isotherms were calculated, using the non-local prescription of Tarazona, employing 
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional

This model was produced in the same manner as the N2 Modified Density Functional model 
listed earlier, except applicable to argon adsorbed at 87.3 K.

References: M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface 
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded Clay 
Catalysts from Hybrid Density Functional Theory (DFT) and Adsorption 
Microcalorimetry Methods,” Langmuir 2002, 18, 9816-9823.

James P. Olivier, “The Importance of Surface Heterogeneity in Developing 
Characterization Methods.” 6th International Symposium on the Character-
ization Of Porous Solids, Studies in Surface Science and Catalysis 144, 
Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface area and microporosity of pil-
lared rectorite catalysts from a hybrid density functional theory method,” 
Microporous and Mesoporous Materials 2003, 57, 291-296.

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Geometry: Free Surface
Substrate: Any
Category: Surface energy
Method: Argon at 87 K
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N2 - Tarazona NLDFT, Esf = 30.0K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent 
weighting functions and a cylindrical pore geometry. The wall potential used is /k = 30 K, 
typical for a silica or alumina surface. 

This model file is particularly useful for sizing zeolites or zeolite containing materials that 
have substantial micropore volume. The reported pore size range is 3.8 to 387 Angstroms.

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77 K

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).
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Models Based on Classical Theories

Both surface energy distribution and pore size distribution may be evaluated using classical 
approaches to model kernel functions 

Surface Energy

The use of classical theories to extract adsorptive potential distribution is mostly of historical 
interest. At a minimum, the equation must contain a parameter dependent on adsorption 
energy and another dependent on monolayer capacity, or surface area. This is sufficient to 
permit the calculation of the set of model isotherms that is used to create a library model. The 
Langmuir equation has been used in the past, as have the Hill-deBoer equation and the 
Fowler-Guggenheim equation. All of these suffer from the fact that they only describe mono-
layer adsorption, whereas the data may include contributions from multilayer formation.

Pore Size

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate 
at pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When 
combined with a correlating function that relates pore size with a critical condensation pres-
sure, this knowledge can be used to characterize the mesopore size distribution of the 
adsorbent. The correlating function most commonly used is the Kelvin equation. Refinements 
make allowance for the reduction of the physical pore size by the thickness of the adsorbed 
film existing at the critical condensation pressure. Still further refinements adjust the film 
thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm 
data using Kelvin-based theories, such as the BJH method, were for the most part developed 
decades ago and were designed for hand computation using relatively few experimental 
points. In general, these methods visualize the incremental decomposition of an experimental 
isotherm, starting at the highest relative pressure or pore size. At each step, the quantity of 
adsorptive involved is divided between pore emptying and film thinning processes and 
exactly is accounted for. This computational algorithm frequently leads to inconsistencies 
when carried to small mesopore sizes. If the thickness curve used is too steep, it finally will 
predict a larger increment of adsorptive for a given pressure increment than is actually 
observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely, 
if the thickness curve used underestimates film thinning, accumulated error results in the cal-
culation of an overly large volume of (possibly nonexistent) small pores. 

The use of equation (1) represents an improvement over the traditional algorithm. Kernel 
functions corresponding to various classical Kelvin-based methods have been calculated for 
differing geometries and included in the list of models.
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Models Included

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948)

t 3.54 5.00–
P/Po( )ln

----------------------⎝ ⎠
⎛ ⎞ 1/3

=
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Kelvin Equation with Harkins and Jura Thickness Curve

N2 -  Harkins and Jura Thickness Curve

The kernel function is calculated using the Harkins and Jura equation with standard 
parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Harkins and Jura Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

The kernel function is calculated using the Broekhoff-de Boer equation with standard 
parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944)
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966)

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

t 13.99
0.034 P/Po( )log–
---------------------------------------------⎝ ⎠
⎛ ⎞ 1/2

=
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N2 - Broekhoff-de Boer Model

The calculation is similar to the above except that cylindrical geometry is assumed, and the 
film thickness depends on pore size (see reference).

References

The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of 
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, 
Micromeritics Instrument Corp; presented at the International Symposium on the Effects 
of Surface Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland 
(July 1992).

2. “Classification of Adsorption Behavior: Siimple Fluids in Pores of Slit-shaped 
Geometry,” Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, 
Elsevier Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density 
Functional Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms 
Calculated by Density Functional Theory,” J.P. Olivier; presented at the Fifth International 
Conference on the Fundamentals of Adsorption, Pacific Grove, CA (1995). 

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: Specifically, equations 20 and 21 in:  J.C.P. Broekhoff and J.H. de Boer, “The 
Surface Area in Intermediate Pores,” Proceedings of the International Sym-
posium on Surface Area Determination, D.H. Everett, R.H. Ottwill, eds., U.K. 
(1969)
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                     INDEX

Symbols
$ symbol, 3-3, 8-5, 8-8

A
A/D calibration, 6-15
Absolute pressure dosing, 3-11, 3-12, 5-16
Absolute pressure tolerance, 5-23
Adding an analyzer, 4-6
Adsorbate Molecular Weight, 5-34
Adsorption isotherm, F-1
Adsorptive Properties dialog, 5-25
Adsorptive properties file, 5-25

defining, 3-12
listing file statistics, 3-40, 5-85
printing contents, 3-39

Advanced format, 8-2
creating sample file, 3-6
establishing sample defaults, 3-4
sample information file, 5-4

Advanced Sample Defaults dialog, 3-4
Alpha-S curve, saving, 5-82
Alpha-S Method dialog, 5-46
Alpha-S report, 5-46
Alumina, replacing in oil vapor traps, 9-15
Ambient free space, 3-10, 5-10, 5-19, 5-80, 6-5, E-1
Analysis

canceling, 6-6
details, 6-12
Dewar, checking and cleaning, 9-5
performing, 3-37, 6-3
reference, 9-39
resuming, 6-6
skipping a step, 6-6
status, 6-12
suspending, 6-6
viewing options, 6-3

Analysis bath fluid, 1-14, 3-25
Analysis conditions

defining, 3-11
Analysis Conditions dialog, 5-13
Analysis conditions file, 5-13

creating, 3-11
identification, 5-13
listing file statistics, 3-40, 5-85
printing contents, 3-39

Analysis dialog, 3-37, 6-3
Analysis free space, 3-10, 5-10, 5-19, 5-80, 6-5

Analysis port, 2-3
replacing filter, 9-5

Analysis Preparation dialog, 5-17
Analysis program, 1-12, 2-7

error messages, B-1
exiting, 5-88
installing, 4-1
installing upgrade, 4-5
subsequent installation, 4-5
uninstalling, 4-12
version number, 6-16

Analyzer
adding another, 4-6
changing setup, 4-10
cleaning, 9-8
description, 1-11
front panel, 2-1
lower side panel, 2-5
maintaining, 9-4
moving to a different computer, 4-6
rear panel, 2-6
removing, 4-9
troubleshooting, 9-1
turning off, 2-6
turning on, 2-6
upper side panel, 2-4

AR DFT model, F-8
AR Modified Density Functional model, F-10
ASCII text, 3-41

saving reports, 7-19
Automatic Degas dialog, 6-7
Autoscale x- and y-axis, 5-38
Avogadro's number, C-20
Axis

coordinates, viewing, 7-25
editing, 7-24
properties, editing, 7-24

Axis Properties dialog, 7-24

B
Backfill, 3-12

gas, 5-25
options, 5-24
selecting options, 3-12

Basic format, 8-2, 8-3
creating sample file, 3-8
sample information file, 5-6
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specifying sample defaults, 3-2, 8-4
Basic Sample Information dialog, 3-2
Bath temperature, 6-5
BET Surface Area report, 5-35

calculations, C-6, C-7
BJH Adsorption Cumulative Pore Volume report, 7-28
BJH Adsorption/Desorption plot options dialog, 5-56
BJH Adsorption/Desorption report, 5-50

calculations, C-11
plot, 5-56
tabular, 5-54

BJH Adsorption/Desorption Report Options dialog, 5-50
BJH Adsorptive Options dialog, 5-52
BJH correction, 5-53
Board ID dialog, 6-16
Boltzmann’s constant, F-8
Bookmarks tab, 1-4
Breaker

See Circuit Breaker
Broekhoff-de Boer equation, 5-44

C
Calculated free space, 5-20
Calculation assignments, 5-17
Calibrate Manifold Temperature dialog, 9-29
Calibrate Pressure Offset dialog, 6-17
Calibrate Pressure Scale dialog, 6-18
Calibrate Servo Valve dialog, 6-26
Calibrate System Volume dialog, 6-19, 6-20
Calibration

analysis pressure scale, 6-18
degas pressure scale, 6-25
degas vacuum gauge, 6-26
details, 6-15
file, loading, 6-21
files, reinstalling, 4-11
Load from File, 6-21
pressure gauge, 6-17, 9-27
pressure scale, 9-28
servo valve, 6-26
settings, saving, 6-21
temperature, 6-18, 9-29
vacuum gauge, 6-17
volume, 6-19
zero pressure transducer, 6-25

Calibration command, 6-17
Calibration File dialog, 6-21
Calibration Manifold Temperature dialog, 6-18
Calibration Vacuum Gauge dialog, 6-17
Cancel push button, 2-10
Carbon Black STSA equation, 5-44
Cascade windows, 2-15
Cautions, 1-3

Check box, 2-9
Chemical potential, F-3
Cheng/Yang

calculations, C-23
Pore Geometry, C-22

Cheng/Yang correction, 5-58
Circuit boards, 6-16
Circuit breaker

heating mantle, 2-3
valve, 2-5

Cleaning
analyzer, 9-8
Dewars, 9-5

Close All command, 5-83
Close command, 5-83
Close push button, 2-10
Close Reports command, 7-4
CO2 DFT Model, F-10
Cold free space, E-2
Cold trap, 1-11

location, 2-3
tubes, cleaning, 9-21
when to use, 3-14

Collected Data dialog, 5-78
Columns, editing on onscreen reports, 7-21
Comments, 3-7, 5-5, 8-9
Compressibility factor, 5-27
Computer

requirements, 1-15
Control Chart command, 7-10
Control Chart Graph Options dialog, 7-11
Control Chart Options dialog, 7-10
Control Chart report, 7-10

defining the Y-axis, 7-11
recalculating archived results, 7-11

Control Chart Sample Selection dialog, 7-12
Controls, indicators, and connectors, 2-1

front panel, 2-1
rear panel, 2-6
side panel, 2-4

Conventions
operator’s manual, 1-3

Cross-hair, axis, 7-25
Cross-references, 1-7
Cryogen

See Analysis bath fluid
Curve Properties dialog, 7-23
Curves

editing, 7-23
showing and hiding, 7-22

D
Data
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isotherm, exporting, 5-86
selecting display options, 8-10
smoothing, 5-65
type, 5-5

Data entry field, 2-9
Date Range push button, 2-11
Dates push button, 5-3
Default Basic Sample Information dialog, 8-4
Default files, 3-2
Default Style dialog, 7-19
Defaults

entering sample, 8-4
Degas

Calibrate pressure zero, 6-25
Calibrate servo, 6-26
Calibrate vacuum gauge, 6-26
canceling, 6-25
dialog, 6-7
Enable manual control, 6-22
monitoring, 6-24
sample on analysis port, 3-31
sample on degas port, 3-20
Show instrument schematic, 6-23
Show status, 6-24
skipping a step, 6-24
starting, 6-7

Degas backfill port, 2-4
Degas command, 6-22
Degas Conditions dialog, 3-10
Degas conditions file, 5-11

creating, 3-10
listing file statistics, 3-40
printing contents, 3-39

Degas port
location, 2-3
preparing samples, 3-20
replacing filter, 9-7

Degas Schematic, 3-33
Density

entering, 3-3, 3-5, 8-6
sample, 5-5

Density conversion factor, 5-26
Density Functional theory, F-3
Destination, 5-84
Dewar

adding bath fluid, 3-25
analysis, 2-2, 3-29, 3-35
checking, 9-5
cleaning, 9-5
cover, 3-15, 3-30, 3-35
precautions, 3-24
raising and lowering, 6-9
safety shield, 1-11, 3-30, 3-36

DFT models, F-1

see also Models
DFT Pore Size Report Options dialog, 5-64
DFT report

pore size, 5-64
surface energy, 5-67

DFT Surface Energy Report Options dialog, 5-67
Dialog box, 2-9

closing, 2-10
Differential calculations, smoothing, 5-52, 5-58
Dipstick

for measuring analysis bath fluid level, 3-25
Directories list box, 2-12
Directory, 5-3
disposing, 9-5
Dosing method, 5-26
Dosing options, 3-11
Dosing Options dialog, 5-22
Drop-down list, 2-10
Dubinin report, 5-68

pore volume, 5-71
tabular, 5-70
transformed isotherm, 5-70

Dubinin Report Options dialog, 5-68
Dubinin Transformed Isotherm Plot Options dialog, 5-70
Dubinin-Astakhov

calculations, C-30, C-32, C-33
Dubinin-Radushkevich

calculations, C-28

E
Elevator, 2-2, 3-38, 6-9

lubricating screws, 9-24
raising and lowering, 6-8

Enable Manual Control command
analysis system, 6-8
degas system, 6-22

Equilibration, 5-24
calculations, C-4
entering interval and delay time, 3-12

Equilibration dialog, 5-24
Equipment

analyzer, 1-11
description, 1-11

Error messages, B-1
Evacuation, 5-17
Evacuation rate, 5-12
Evacuation time, 5-12, 5-17
Exit command, 5-88
Exiting the analysis program, 2-8, 5-88
Export command, 5-86
Export Sample Information dialog, 3-41
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F
File

displaying, 2-15
listing statistics, 2-8
name, including with file identification, 8-5, 8-8
opening, 2-8
printing to, 7-3
status, 2-12, 5-3

File menu, 5-1
Close All command, 5-83
Close command, 5-83
description, 5-1
Exit command, 5-88
Export command, 5-86
List command, 5-85
Open command, 5-2
Print command, 5-84
Save All command, 5-83
Save As command, 5-81
Save command, 5-81

File name default extensions, 2-13
File name field, 3-3, 3-6, 3-8
Filter

port, 9-5
vacuum pump exhaust, 9-25

Find command, 1-8
Folder, 3-1
f-Ratio Method dialog, 5-49
f-Ratio report, 5-49
Free space, 3-3, 3-5, 5-10, 5-19, 5-80, 6-5

ambient, 3-10
analysis, 3-10
calculated, 5-5, 5-20
calculating, E-1
calculations, C-2
selecting measurement method, 3-11, 5-18

Free Space dialog, 5-18, 5-80
Freespace helium port, 2-4
Freundlich report, 5-37

calculations, C-35
Freundlich Report Options dialog, 5-37
Front panel description, 2-1
Fume hood, 9-25
Function keys

See Shortcut keys

G
Gas

absolute pressure dosing, 5-16
adsorptive, 5-26
backfill, 5-25
changing, 9-30

connecting a regulator, 9-31
connecting to the analyzer, 9-38
connection ports, 2-4
dosing, 5-22
entering dosing method, 5-26
guidelines for connecting to analyzer, 9-30
inlet ports, 2-4
ports, 9-38
regulator pressure, 3-37
requirements, 1-12

Gas Configuration dialog, 6-16, 9-38
Graph

copying as metafile, 7-24
copying report data as text, 7-24
editing onscreen, 7-22
grid lines, 8-10
legend, editing, 7-24
shortcut menu, 7-22

Graph Grid Lines command, 8-10
Graph Grid Lines dialog, 8-10
Graph Overlay Samples, 5-30
Graph Overlay Samples dialog, 3-44
Graph overlays

See Overlays
Graphic

showing in report title, 5-30
Grid lines, 8-10

H
Halsey Thickness Equation, 5-43
Halsey Thickness Equation dialog, 5-73
Hardware code, 6-15
Harkins and Jura Thickness Equation, 5-43
Harkins and Jura Thickness Equation dialog, 5-73
Heat of Adsorption dialog, 7-13
Heat of Adsorption report, 7-13
Heater Settings dialog, 3-33
Heating mantle

attaching to sample tube, 3-22, 3-32
breaker, 2-3
connector, 2-3
cooling, 3-23, 3-34
power plug, 3-20, 3-32
thermocouple, 2-3

Heating mantle clip, 3-22, 3-32, 3-34
Help menu, 2-15
Histogram, 7-23
Horvath-Kawazoe calculations

Cylinder pore geometry (Saito/Foley), C-21
Slit pore geometry (original HK), C-20
Sphere pore geometry (Cheng/Yang), C-22

Horvath-Kawazoe Physical Properties dialog, 5-59
Horvath-Kawazoe Plot Options dialog, 5-62
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Horvath-Kawazoe report, 5-58
calculations, C-20
plot, 5-62
tabular, 5-61

Horvath-Kawazoe Report Options dialog, 5-58

I
Icons

arranging, 2-15
Index, online, 1-7
Indicators

See Controls, indicators, and connectors
Information bar, 2-9
Instrument log, 6-13

adding entries, 5-6, 6-13
Instrument schematic

analysis system, 6-11
degas system, 6-23

Interaction parameter, C-23
Isosteric heat of adsorption, 7-13
Isotherm, F-1
Isotherm data

exporting, 3-41, 5-86
Isotherm Linear Absolute Plot, 7-30
Isotherm Pressure Composition report, 7-29
Isotherm report, 5-32
Isotherm Report Options dialog, 5-32
Isothermal jacket, 1-11, 1-14, 3-16, 3-28, 3-34

K
Kernel function, F-12, F-13, F-14
Kruk-Jaroniec-Sayari Thickness Equation, 5-43

L
Langmuir Surface Area report, 5-35

calculations, C-7
Leak test

blank tube analysis (nitrogen), D-1
Data sheet for recording values, D-11
removing differential pressure, D-8
Valve 9, D-5
Valves 10 and 11, D-5
Valves P1 through P6, D-4
Valves PS, 5, and 7, D-4

Legend Properties dialog, 7-24
Lennard-Jones interaction parameter, F-8
Lennard-Jones potential, F-2
Links, 1-6
Liquid nitrogen, 9-5
List command, 5-85

Listing file statistics, 5-85
Live Graph command, 8-11
Load from File command, 6-21
Log

See Instrument log
Log Report Settings dialog, 6-14

M
Main Menu bar, 2-14
Maintenance

preventive, 9-4
routine, 9-30

Manifold temperature
calibrating, 6-18, 9-29
transducer, 1-14

Manual control, 6-8
enabling for analysis system, 6-8
enabling for degas system, 6-22

Mass
determining, 3-18, 3-19
entering, 3-5, 3-7, 3-8, 3-27, 5-5, 5-7, 8-6, 8-9

MCM-41 materials, F-9
Menu

shortcut, 2-7
structure, 2-14

Metafile, copying graph as, 7-24
Models, F-1

AR DFT model, F-8
AR Modified Density Functional model, F-10
based on classical theories, F-12
based on statistical thermodynamics, F-1
CO2 DFT model, F-10
N2 Broekhoff-de Boer model, F-14, F-15
N2 Cylindrical Pores - Oxide Surface, F-9
N2 Cylindrical Pores - Pillared Clay Surface, F-9
N2 DFT model, F-8
N2 Halsey Thickness Curve, F-13
N2 Harkins and Jura Thickness Curve, F-14
N2 Harkins and Jura Thickness Curve model, F-14
N2 Modified Density Functional model, F-8
N2 Tarazona NLDFT, Esf = 30.0K, F-11

Molecular cross-sectional area, 5-26
Molecular dynamics, F-2
Molecular simulation methods, F-2
Monolayer capacity, 5-37
Monte Carlo, F-2
Montmorillionite, F-9
MP-Method

Calculations, C-35
MP-Method Plot Options dialog, 5-75
MP-Method report, 5-72

plot, 5-75
tabular, 5-75
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MP-Method Report Options dialog, 5-72
MP-Method Tabular Report Column Options dialog,

5-75

N
N2 Broekhoff-de Boer model, F-14, F-15
N2 Cylindrical Pores - Oxide Surface model, F-9
N2 Cylindrical Pores - Pillared Clay Surface model, F-9
N2 DFT model, F-8
N2 Halsey Thickness Curve model, F-13
N2 Harkins and Jura Thickness Curve model, F-14
N2 Modified Density Functional model, F-8
N2 Tarazona NLDFT, Esf = 30.0K model, F-11
Non-condensity Adsorptive, 5-26
Notes, 1-3

O
Oil vapor traps

replacing alumina, 9-15
On/Off switch, 2-5
Online manual

cross references, 1-7
index, 1-7
printing options, 1-9
using, 1-4
See also Operator’s manual

Open Adsorptive Properties File dialog, 3-12
Open Analysis Conditions File dialog, 3-11
Open command, 5-2
Open Compressibility Factor Table dialog, 5-27
Open report command, 7-4
Open Report Options File dialog, 3-13
Open Sample Information File dialog, 3-6, 3-8
Operator, 8-9
Operator field

omitting, 3-5
Operator’s manual

conventions, 1-3
displaying online, 2-15
online, 1-4
organization, 1-1

Option Presentation command, 8-2
Options menu

Graph Grid Lines command, 8-10
Option Presentation command, 8-2
Parameter Files Directory, 8-11
Sample Defaults command, 8-4
Service Test Mode command, 8-12
Units command, 8-10

Options report, 5-77
Ordering information, 10-1
Outgassing rate, 6-24, 9-24

Overlays, 3-14, 5-30
for multiple samples, 3-42
generating, 3-42
multiple graph, 3-45

oxygen-compatible vacuum pump, 9-9, 9-31

P
Parameter files, 3-9

Adsorptive properties, 3-12, 5-25
Analysis conditions, 3-11, 5-13
Degas conditions, 3-10, 5-11
listing file statistics, 3-40, 5-85
printing contents, 3-39, 5-84
Report options, 3-13, 5-29
Sample tube, 3-9, 5-9
saving, 5-82

Parameter files directory, 8-11
Parts, ordering, 10-1
Password, for restricted format, 8-3
Plot Options dialog, 5-33
Plot Overlay Sample Selection dialog, 3-44
Po and T dialog, 5-80
Po and Temperature

selecting method of measuring, 3-11
Po and Temperature Options dialog, 5-20
Po port, 2-3
Pore filling pressure, F-4
Pore Geometry

cylinder (Saito-Foley), C-21
slit (original Horvath-Kawazoe), C-20
sphere (Cheng/Yang), C-22

Pore size, F-12
Port filter

replacing analysis, 9-6
replacing degas, 9-7

Ports
gas connecting, 9-38
gas connection, 2-4
specifying gas, 9-38
See also Analysis port
See also Degas port

Power
heating mantle, 3-20, 3-32
On/Off switch, 2-5

Power connector, 2-5
Power indicator light, 2-1
Preparing samples, 3-16
Pressure

entering predefined points, 5-16
hold, 5-12
maximum manifold, 5-26
measurement, 1-13
relative, calculations, C-1, C-2
Index-6                                                                                                                                                                                             May 2010



ASAP 2050 Operator’s Manual                                                                                                                Index
table, 5-14
Pressure gauge

calibrating, 6-17, 9-27
Pressure scale

calibrating, 9-28
calibrating analysis system, 6-18
calibrating degas system, 6-25

Pressure zero
calibrating, 6-25

Preventive maintenance schedule, 9-4
Print command, 5-84
Printing file contents, 3-39
Psat vs Temperature table, 3-12
Psat vs. Temperature Table dialog, 5-28
Push buttons, 2-10

R
Radio button, 2-9
Reference material, 9-39
Regression report, 7-6

recalculating SPC values, 7-7
selecting X- and Y-Axes variables, 7-7

Regression Report command, 7-6
Regression Report Options dialog, 7-6
Regression Report Sample Selection dialog, 7-7
Regularization, 5-65
Regulators

attaching to gas supply, 9-31
gas, 1-12

Relative pressure tolerance, 5-23
Removing an analyzer, 4-9
Replace All command, 3-7, 5-6, 5-8, 8-6, 8-9
Replace command, 3-9
Replace push button, 2-10, 5-13
Report

closing, 2-8, 7-4
Control Chart, 7-10
displaying company logo in title, 5-30
editing axis, 7-24
editing legend, 7-24
editing style, 7-19
editing title, 7-24
generating, 7-2
generating automatically after analysis, 3-38, 6-5
graphs, editing onscreen, 7-22
header, 7-16
Heat of Adsorption, 7-13
legend, editing, 7-24
onscreen tool bar, 7-17
onscreen, shortcut menus for, 7-21
printed, 7-16
printing, 7-18
Regression, 7-6

samples, 7-26
saving in other formats, 7-19
selecting, 7-4
starting, 2-8, 3-44
Statistical Process Control (SPC), 7-5
title, 5-30
viewing onscreen, 7-16
zoom feature, 7-25

Report button, 7-9
Report Options dialog, 3-13, 3-45, 3-46, 5-29
Report options file, 5-29

creating, 3-13
listing file statistics, 3-40, 5-85
printing contents, 3-39

Report Pressure Table dialog, 5-36
Report Relative Pressure Range dialog, 5-45, 5-53
Report system, 1-12
Report title

including graphic, 3-14
showing, 3-14

Reports menu, 7-1
Close Reports command, 7-4
Control Chart command, 7-10
description, 7-1
Heat of Adsorption command, 7-13
Open Report command, 7-4
Regression Report command, 7-6
SPC Report Options command, 7-5
Start Report command, 7-2

Reports to Generate dialog, 7-3
Restricted format, 3-8, 8-2, 8-3

creating sample file, 3-8
password, 8-3
sample information file, 5-8
specifying sample defaults, 8-4

RS232 port, 2-5

S
Safety shield, 3-36

attaching, 3-30
Saito-Foley

calculations, C-21
Pore Geometry, C-21

Sample
degassing, 6-7
degassing on analysis port, 3-31
degassing on degas port, 3-20
entering mass, 3-3
information, defining, 3-6
inserting in sample tube, 3-19
mass, determining, 3-18
preparing, 3-16

Sample Analysis command, 6-3
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Sample Backfill Options, 5-24
Sample Data Worksheet, A-1
Sample defaults, 8-4

establishing for Advanced format, 8-7
establishing for Basic format, 8-4

Sample field, 3-7
Sample identification, 8-5, 8-8
Sample information file

automatic numbering, 3-3
contents, 3-1
creating, 3-6
default values, 3-2
exporting isotherm data, 3-41
listing file statistics, 3-40, 5-85
printing contents, 3-39, 5-84
specifying defaults, 3-2

Sample Log report, 5-78
Sample tube

cleaning, 3-16
cooling, 3-23, 3-26, 3-34
displayed on schematic, 6-10
installed, 3-30
installing on sample port, 3-26
replacing O-ring, 9-8
seal frit, 3-17, 3-19, 3-26
stopper, 3-17, 3-19, 3-26
transferring from degas port to analysis port, 3-26

Sample Tube dialog, 3-9, 5-9
Sample tube file, 5-9

creating, 3-9
listing file statistics, 3-40
printing contents, 3-39

Saturation pressure
calculations, C-1
tube, 1-11, 3-34

Save All command, 5-83
Save As command, 5-81
Save as Default button, 7-12
Save command, 5-81
Save push button, 2-10
Save to File command, 6-21
Schematic

analysis system, 6-11
degas system, 6-22

Seal frit
See Sample tube

Select Dates dialog, 2-11, 5-3
Select Reports dialog, 3-45
Selected Reports list, 3-14, 3-46
Sequence field, 3-3, 3-4
Service Test command, 6-27
Service Test Mode, 8-12
Servo Value Settings dialog, 6-23
Servo valve, 6-23

calibrating, 6-26
Setup Program, 4-1
Setup program

adding an analyzer, 4-6
changing an analyzer setup, 4-10
moving an analyzer to a different computer, 4-6
reinstalling analysis program, 4-5
reinstalling calibration files, 4-11
removing an analyzer from the computer, 4-9
uninstalling the software, 4-12
using for other functions, 4-4

Shortcut keys, 2-7, 2-12
list of, 2-8

Shortcut menu, 2-7
for graphs, 7-22
for tabular reports, 7-21

Show Instrument Log command, 6-13
Show Instrument Schematic command

analysis system, 6-11
degas system, 6-23

Show Status command
analysis system, 6-12
degasser, 6-24

Software
See Analysis program

SPC Report Options command, 7-5
SPC Report Options dialog, 7-5
Specifications

ASAP 2050, 1-13
Degas system, 1-14

Spreadsheet format
saving reports in, 7-19

Start Analysis dialog, 3-37
Start Degas command, 6-7
Start Degas dialog, 3-23
Start Report command, 7-2
Start Report dialog, 3-44, 7-2
Status

analysis system, 6-12
degas system, 6-24

Status list, 2-12, 7-2
Stopper

See  Sample tube
STSA Thickness equation, 5-44
Submenu, 2-14
Submitter, 8-9

omitting, 3-5
Summary report, 5-77, 7-27

calculations, C-40
Summary Report Options dialog, 5-77
Surface Energy, F-12
Surface Energy report, 5-67
System volume

calibrating, 6-19
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T
Table of Contents, online, 1-6
Tabular report shortcut menu, 7-21
Tarazona, F-8
t-Curve

entered, 5-42
t-Curve, saving, 5-82
Temkim Report Options dialog, 5-39
Temkin report, 5-39

calculations, C-36
Temperature

analysis bath, 5-20
calibrating, 6-18, 9-29
calibration details, 6-15
displayed on schematic, 6-10
hold temperature and time, 5-12
ramp rate, 5-11, 5-12
saturation pressure, 5-20
target, 5-11

Text, copy graph data as, 7-24
Thermal transpiration

hard-sphere diameter, 5-26
Thermal transpiration correction, 3-14

calculations, C-5
choosing, 5-31

Thermocouple
plug, 3-20, 3-32

Thermodynamic law, F-2
Thickness curve, 5-53, 5-72

types, 5-51
Thumbnails tab, 1-9
Tile windows, 2-15
Title Properties dialog, 7-24
t-Plot report, 5-41

calculations, C-9
T-Plot Report Options dialog, 5-41
Transducer

adjusting scale, 6-18
calibration details, 6-15
displayed on schematic, 6-10

Transformed Isotherm report, 5-70
Troubleshooting, 9-1

U
Ultrasonic cleaning unit, 3-16
Unit Configuration command, 6-15
Unit menu, 6-1

Calibration command, 6-17
Degas command, 6-22
description, 6-1
Enable Manual Control command, 6-8
Live Graph command, 8-11

Sample Analysis command, 6-3
Service Test command, 6-27
Show Instrument Log command, 6-13
Show Instrument Schematic command, 6-11
Show Status command, 6-12
Start Degas command, 6-7
Unit configuration command, 6-15

Units of measurement, selecting, 8-10
Units Selections dialog, 8-10

V
Vacuum gauge

calibrating, 6-17
calibrating, degas system, 6-26
calibration details, 6-15
pressure, 6-10

Vacuum pump
changing fluid, 9-11
draining, 9-11
exhaust filter, replacing, 9-25
fluid for use with oxygen, 1-12, 9-9, 9-31
inspecting fluid, 9-9
oxygen-compatible, 1-12, 9-9, 9-31
panel, 2-1
placement, 2-6
replacing alumina in oil vapor trap, 9-15
viewing fluid level, 9-9

Vacuum seal, 3-10
Vacuum setpoint, 5-12, 5-17
Vacuum system, 1-13
Valves

degas system, 6-23
description, D-2
opening and closing, 6-8
system, 6-9
testing for leaks, D-1

Van der Waal force, F-1
Vapor gas port, 2-4
Viewing options, 6-3
Voltage

selecting, 2-5
Volume

calibrating, 6-19
calibration details, 6-15

Volume adsorbed, 5-34
calculations, C-3

W
Wall potential, F-11
Warnings, 1-3
Windows

Cascade, 2-15
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tile, 2-15
Windows menu, 2-15

X
X-axis, choose variable, 8-11

Z
Zoom feature, 7-25
Index-10                                                                                                                                                                                             May 2010


	ASAP 2050
	WARRANTY
	TABLE OF CONTENTS
	1. GENERAL INFORMATION
	Organization of the Manual
	Conventions
	Online Manual
	Using Bookmarks
	Using the Table of Contents, Index, and other Links
	Table of Contents
	Index
	Cross References

	Using the Find Command
	Printing

	Internet Access
	Equipment Description
	Gas Requirements
	Analysis Program
	Report System

	Specifications

	2. USER INTERFACE
	Controls, Indicators, and Connectors
	Front Panel
	Side Panel
	Upper
	Lower

	Rear Panel
	Turning On the System
	Turning Off the System

	Using the Software
	Shortcut Menus
	Shortcut Keys
	Dialog Boxes
	Selecting Files
	File Name Conventions

	Menu Structure
	Windows Menu
	Help Menu


	3. OPERATIONAL PROCEDURES
	Sample Information Files
	Specifying Sample File Defaults
	Basic Format
	Advanced Format

	Creating Sample Information Files
	Advanced Format
	Basic and Restricted Formats

	Defining Parameter Files
	Sample Tube
	Degas Conditions
	Analysis Conditions
	Adsorptive Properties
	Report Options

	Using the Cold Trap
	Preparing Samples
	Determining the Mass of the Sample
	Degassing Samples on Degas Ports

	Filling the Analysis Dewar
	Precautions
	Filling the Dewar

	Transferring a Degassed Sample to the Analysis Port
	Degassing a Sample on the Analysis Port
	Performing an Analysis
	Printing File Contents
	Listing File Statistics
	Exporting Isotherm Data
	Generating Graph Overlays
	Multiple Samples Overlay
	Multiple Graphs Overlay


	4. SOFTWARE AND SETUP MODIFICATIONS
	Installing the Analysis Program
	Initial Installation

	Using the Setup Program for Other Functions
	Installing Subsequent Software Versions
	Adding an Analyzer
	Moving an Analyzer from one PC to another PC
	Removing an Analyzer
	Changing an Analyzer Setup
	Reinstalling the Calibration Files
	Uninstalling the Analysis Program


	5. FILE MENU
	Description
	Open
	Sample Information
	Advanced Format
	Basic Format
	Restricted Format

	Sample Tube
	Degas Conditions
	Analysis Conditions
	Adsorptive Properties
	Report Options
	Isotherm Report Options
	BET/Langmuir Surface Area Report Options
	Freundlich Isotherm
	Temkin Isotherm
	t-Plot Report Options
	Alpha-S Plot
	f-Ratio Plot
	BJH Adsorption/Desorption Report Options
	Horvath-Kawazoe Report Options
	DFT Pore Size
	Surface Energy
	Dubinin Report Options
	MP-Method Report Options
	Options Report
	Summary Report
	Sample Log Report

	Collected/Entered Data

	Save
	Save As
	Sample and Parameter Files
	t-Curve and Alpha-S Files

	Save All
	Close
	Close All
	Print
	List
	Export
	Exit

	6. UNIT MENU
	Description
	Sample Analysis
	Start Degas
	Enable Manual Control
	Show Instrument Schematic
	Show Status
	Show Instrument Log
	Unit Configuration
	Calibration
	Vacuum Gauge
	Pressure Gauge
	Pressure Scale
	Temperature
	Volume
	Save to File
	Load from File

	Degas
	Enable Manual Control
	Show Instrument Schematic
	Show Status
	Calibrate Pressure Zero
	Calibrate Pressure Scale
	Calibrate Vacuum Gauge
	Calibrate Servo

	Service Test

	7. REPORTS MENU
	Description
	Start Report
	Close Reports
	Open Report
	SPC Report Options
	Regression Report
	Control Chart
	Heat of Adsorption
	Printed Reports
	Header
	Onscreen Reports
	Tool Bar
	Shortcut Menus

	Zoom Feature
	Axis Cross Hair

	Sample Reports
	Summary Report
	BJH Adsorption Cumulative Pore Volume
	Isotherm Pressure Composition
	Isotherm Linear Absolute Plot
	Isotherm Linear Absolute Plot

	8. OPTIONS MENU
	Description
	Option Presentation
	Advanced
	Basic
	Restricted

	Sample Defaults
	Basic Format
	Advanced Format

	Units
	Graph Grid Lines
	Live Graph
	Parameter Files Directory
	Service Test Mode

	9. TROUBLESHOOTING AND MAINTENANCE
	Troubleshooting
	Preventive Maintenance
	Checking and Cleaning the Analysis Port Dewars
	Replacing the Port Filters
	Analysis Ports
	Degas Ports

	Cleaning the Analyzer
	Replacing a Sample Tube O-ring
	Inspecting and Changing Vacuum Pump Fluid
	Inspecting Fluid
	Adding Fluid
	Changing Fluid

	Replacing the Alumina in the Oil Vapor Traps
	Cleaning the Cold Trap Tubes
	Lubricating the Elevator Screw
	Checking Outgassing Rate and Testing the Analyzer for Leaks
	Replacing the Vacuum Pump Exhaust Filter
	Calibrating the Pressure Gauge
	Calibrating the Pressure Scale
	Calibrating the Manifold Temperature Sensor

	Routine Maintenance
	Changing Gases
	Guidelines for Connecting Gases to the Analyzer
	Connecting a Gas Regulator to the Gas Supply
	Connecting the Gas Delivery Tubing to the Analyzer
	Specifying Gas Ports

	Performing a Reference Material Analysis


	10. ORDERING INFORMATION
	Analysis System Components and Accessories
	Sample Tubes and Components
	Cold Trap Tubes and Components

	A. ASAP SERIES SAMPLE DATA WORKSHEET
	B. ERROR MESSAGES
	2200 and 2400 Series
	2500 Series
	4000 Series
	6200 Series
	6500 Series

	C. CALCULATIONS
	Saturation Pressure (Po)
	Relative Pressure
	Free Space
	Volume Adsorbed
	Equilibration
	Thermal Transpiration Correction
	BET Surface Area
	Langmuir Surface Area
	t-Plot
	BJH Pore Volume and Area Distribution
	Explanation of Terms
	Calculations
	Compendium of Variables

	Horvath-Kawazoe
	Slit Pore Geometry (original HK)
	Cylinder Pore Geometry (Saito/Foley)
	Sphere Pore Geometry (Cheng/Yang)
	Cheng/Yang Correction
	Interaction Parameter
	Additional Calculations

	Interaction Parameter Components

	Dubinin-Radushkevich
	Dubinin-Astakhov
	MP-Method
	Freundlich Isotherm
	Temkin Isotherm
	DFT (Density Functional Theory)
	The Integral Equation of Adsorption
	Application to Surface Energy Distribution
	Application to Pore Size Distribution

	Performing the Deconvolution
	Regularization


	Summary Report
	SPC Report Variables
	Regressions Chart Variables
	Control Chart Variables

	References

	D. TESTING FOR LEAKS
	Testing Individual Valves
	Analysis Valves
	Valves 3 and P1 through P6
	Valves PS, 5, and 7
	Valves 1, 2, 8, 9, 10, 11, and PV

	Degas Valves

	What To Do If You Detect a Leaking Valve
	Removing Differential Pressure from a Leaking Valve
	Repairing or Replacing a Leaking Valve
	Repairing Valves on the Analysis Manifold
	Replacing Valves on the Degas and Gas Inlet Manifold


	Valve Data Test Sheet

	E. CALCULATING FREE-SPACE VALUES
	F. DFT MODELS
	Models Based on Statistical Thermodynamics
	Theoretical Background
	Molecular Simulation Methods
	Molecular Dynamics Method
	Monte Carlo Method

	Density Functional Formulation
	Models Included
	Non-Local Density Functional Theory with Density Independent Weights
	Modified Non-Local Density Functional Theory with Density-Dependent Weights


	Models Based on Classical Theories
	Surface Energy
	Pore Size
	Models Included
	Kelvin Equation with Halsey Thickness Curve
	Kelvin Equation with Harkins and Jura Thickness Curve
	Kelvin Equation with Broekhoff-de Boer Thickness Curve


	References

	INDEX
	Symbols
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	X
	Z


